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活動実績報告書：活動コンポーネント成果 4-1 

 

活動コンポーネントの概要及び主要な成果品 

GISデータ及び情報の構築・管理 

 

1. 背景及び概要 

本プロジェクトの成果 1が目指すのは「保護区ネットワークのための中央行政の機能強

化」であり、成果 2及び 3が目指すのは「保護区管理（及び設立）の機能強化」である。

成果 4は、成果 1～3の達成を側面支援するための「情報整備・広報・啓発の強化」を目

指すものであり、本コンポーネントは特に GISデータを活用した支援を行った。 

まず CEPA のデータ管理状況や、GIS担当者の技術力や業務の内容・役割などについて確

認するとともに、陸域・海域生態系に関するデータを収集、あるいは購入、作成し、プロ

ジェクト GISデータベースを構築した。整備したデータを用いて、成果 1～3の活動を支

援するための各種のテーマ図を作成した。また、作成したデータやマップが継続的に管

理・更新され、将来の保護区管理の適正化に役立つよう CEPAと協議するとともに技術移

転を行った。 

 

2. 目的 

モデル保護区の管理及び新規保護区の設立のためのデータや情報を収集、作成、及び管理

する。 

 

3. 活動内容 

(1) CEPAの GIS/RS 関連機材や人員、並びにそれらの稼働状況の確認 

(2) プロジェクト GISデータベースの構築・管理 

(3) 空間情報の整理、及び空間データの解析処理、各成果関連マップの作成 

(4) 空間データ・情報管理のための CEPAの能力開発 

 

4. 活動経緯と実績 

(1) CEPAの GIS/RS 関連機材や人員、並びにそれらの稼働状況の確認 

2015年 6月 CEPAの GIS/RS 関連機材や人員、並びにそれらの稼働状況を確認し

た。 

2015年 10月 プロジェクトの GIS/RS関連機材の利用方法や使用場所を決定し、必

要な機材の購入とセットアップを行った。 

 

(2) プロジェクト GISデータベースの構築・管理 

2015年 6月-10 CEPA所有の GIS/RS 関連データの内容や管理状況、職員の GIS/RS ス



月 キルや役割等を確認した。 

2015年 6月-

2016年 12月 

無料データを含む既存の生物多様性に係る GIS/RS情報やデータの収

集・処理を行った。 

2015年 6月-

2016年 4月 

高解像度衛星画像を購入し、解析処理を行った。 

2015年 10月-

2016年 4月 

プロジェクト GISデータベースの整備、強化、管理方法を決定した。 

2015年 10月-

2016年 12月 

添付資料 4.1.1 

プロジェクト GISデータベースを構築した。 

 

(3) 空間情報の整理、及び空間データの解析処理、各成果関連マップの作成 

2015年 9月-

2017年 4月 

添付資料 4.1.2 

空間情報の整理、及び空間データ処理を行い、プロジェクト対象地マ

ップや PNG の保護区マップ等、成果 1に係るマップを作成した。 

2015年 9月-

2018年 10月 

添付資料 4.1.2 

空間情報の整理、及び空間データの解析処理を行い、土地被覆・利用

マップや Varirata国立公園（VNP）施設マップ、VNP 管理ゾーニング

マップ等、成果 2に係るマップを作成した。 

2015年 10月-

2020年 1月 

添付資料 4.1.2 

空間情報の整理、及び空間データの解析処理を行い、マングローブマ

ップや海洋保護区マップ、Bootless Bay国立海洋保護区域（BBNMS）

ゾーニングマップ等、成果 3 に係るマップを作成した。 

 

(4) 空間データ・情報管理のための CEPAの能力開発 

2016年 4月、

2017年 1月- 

2020年 2月 

添付資料 4.1.3-

4.1.8 

CEPAの能力開発研修のため、データ管理に係るマニュアルやガイド

を作成した。 

2016年 4月、

2019年 6月-

2020年 2月 

データの持続的な利用を目的とし、GIS やデータベース、IT 管理者並

びに保護区管理担当者を対象に、データ管理に係る協議や研修を行っ

た。 

 

5. 評価 

(1) 成果到達度の評価 

評価指標 指標の到達度の自己

評価 

評価結果 



5種類以上の情

報発信媒体を

作成し、広

報・啓発戦略

に沿って、タ

ーゲットエリ

アの人口の

30%以上に宣伝

する。 

Achieved 各種情報発信媒体のコンテンツとして、本活動

で収集・作成した情報やマップを活用した。 

（本評価指標は活動実績報告 4-2 の評価指標と

重複するため、詳細は活動実績報告 4-2を参

照。） 

 

(2) 目標到達度の評価 

評価指標 指標の到達度 評価結果 

情報発信媒体 Achieved 10種類以上の情報発信媒体を作成した。 

 

6. 教訓 

(1) 陸域・海域生態系に関するデータの整備と継続性の確保 

関係機関との協力・連携により、対象の保護区及び周辺地域の陸域・海域生態系の関連デ

ータを整備することができたものの、CEPAの人的リソースが不足していたため、CEPA職

員にデータの構築に多く関わってもらうことは適わなかった。しかし、CEPAの GIS/RS デ

ータの管理状況や職員の技術能力を確認した上で、GIS データベースに関する資料やデー

タ管理に係るマニュアル等を準備し、またそれらを使って CEPA 職員との協議や研修を行

うことで、プロジェクト終了後もデータが継続的に利用される環境を整えることができ

た。 

 

7. 提言 

(1) プロジェクトデータベースの活用 

プロジェクト終了後は、CEPA の IT、DB、GIS担当職員と協議した結果に基づき、本プロ

ジェクトデータベースを CEPAの GISサーバに格納し、CEPA 職員が自分たちの PC 端末

からデータベースにアクセスできる環境を整えることを提案する。CEPAでは様々なプロ

ジェクトが行われているが、データの利用が適切に行われていないことが多い。本プロジ

ェクトで整備した GISデータベースや説明資料、関連マニュアル、データの内容を整理し

た「アトラス」は、一つのパッケージとして、データ・情報整備のプロトタイプとなり得

るものである。よって、CEPA 職員が今後、他ドナーとデータ・情報整備方法についてコ

ミュニケーションをとる際にはこれを活用することを提案する。 

 

8. 主要な成果品リスト: 



1) Project GIS database list （添付資料 4.1.1） 

2) Project map list （添付資料 4.1.2） 

3) Introduction of Satellite Imagery – WorldView-2 (Apr 2016) （添付資料 4.1.3） 

4) Updating facility database (Jul 2016) （添付資料 4.1.4） 

5) Update of VNP facility database (Oct 2018) （添付資料 4.1.5） 

6) Manual on Getting location information (Feb 2018) （添付資料 4.1.6） 

7) ENVI manual (Apr 2017) （添付資料 4.1.7） 

8) GIS Data Management (Feb 2020) （添付資料 4.1.8） 

 

以上 

 



 
 
 
 
 
 
 
 
 

添付資料 4.1.1 Project GIS database list 



CEPA‐JICA Project GIS Database

CEPA‐JICA Project GIS Database Folder Description
File type Folder name Description

01_Satellite
Satellite imagery (original/pre‐analysis
data)

: There is only trial data now.

02_DEM
Satellite imagery (DEM) (original/pre‐
analysis data)

: There is only data gotten from CEPA.

03_TopoMAP
Topographic Survey map (1:100,000)
produced by RASC

: There is only data gotten from CEPA, but data links to Map document created in the Project.

09_DroneData Drone imagery
11_TopoAnalyst Topological analysis data
12_SatelliteAnalyst Satellite imagery analysis data
21_Boundary Boundary data
22_Census Census data
23_ForestMap National Forest Base Map
24_Landuse Land use map
25_LandCon Land condition map
26_GeologicalMap Geological map
27_Fishery Fishery related data
28_Mining Mining related data
29_ProtectedArea Protected area data
30_Others Other data
31_VarirataNP Varirata NP related data
32_MarineNP Marine PA related data

41_PNGRIS
PNGRIS (PNG Resource Information
System)

42_Geobooks Geobook data produced by UPNG

51_Hansen
Global Forest Change data by Hansen et
al.

52_Openstreetmap Open street map
53_Google Google satellite imagery

54_ISCGM
International Steering Committee for
Global Mapping data

81_MapLayout Map layout (Map document file)
82_Maps Report file/Exported map
83_Logo Image for map (ex: PNG logo)

Other documents 91_Documents
Other documents (non‐spatial data)
such as manuals

Satellite &
airborne imagery
(original/pre‐
analysis data)

Map layout &
output images

Existing system &
data sets

Analysis data

Thematic data



CEPA‐JICA Project GIS Database List Last updated date: 13 Nov 2020
File type File name Description Extent Souce Prepared

LANDSAT (many)
Landsat imagery downloaded about every 5
years
Unprocessed

Project Area http://earthexplorer.usgs.gov/ 1

LANDSAT_CEPA S‐55‐051.img Landsat mosaic imagery PNG CEPA database
RapidEye_2010 geotif (many) RapidEye imagery PNG PNGFA 1
WorldView2 (many) WorldView‐2 imagery Project Area Procured by CEPA‐JICA Project 1

PALSAR PALSAR IMAGES (many)
ALOS/PALSAR imagery.
Stack images of HH, HV, and HHHV

PNG PNGFA 1

z_indexmap (many) Data for index map of satellite imagery ‐ Prepared by CEPA‐JICA Project 1
IndexMap_Satellite.mxd Index map of satellite imagery ‐ Prepared by CEPA‐JICA Project 1

ALOS_DEM (many) ALOS DEM Project Area
http://www.eorc.jaxa.jp/ALOS/aw3d30/inde
x_j.htm

1

ASTGTM2_S10E147_dem.tif
ASTER GDEM
Used for analysis of surface and watershed in the
Project.

Project Area
http://www.jspacesystems.or.jp/ersdac/GDE
M/J/

1

SRTM_30 SRTM30.tif SRTM DEM 30m PNG http://www2.jpl.nasa.gov/srtm/ 1
srtm_png.img SRTM DEM 90m (mosaic for entire PNG) PNG http://www2.jpl.nasa.gov/srtm/ 1
srtm_png_sub_rp0_u55s.img SRTM DEM 90m (mosaic for entire PNG) (UTM) PNG http://www2.jpl.nasa.gov/srtm/ 1
s10_e147_1arc_v3.tif SRTM (30mDEM) Project Area http://www2.jpl.nasa.gov/srtm/ 1

03_TopoMAP geo_image
8378_Gaire.tif/8379_PortMo
resby.tif

Topographic Survey map (1:100,000) produced
by RASC

PortMoresby around CEPA database

09_DroneData Drone imagery Project Area Acquired by CEPA‐JICA Project 1
topo aspect Aspect Project Area Processed by CEPA‐JICA Project 1

dem_utm Surface created by ASTGTM2_S10E147_dem.tif Project Area Processed by CEPA‐JICA Project 1
hillshade Hillshade Project Area Processed by CEPA‐JICA Project 1
hillshademsk Hillshade masked inside land Project Area Processed by CEPA‐JICA Project 1
hillshade_5m Hillshade (cell size: 5m) Project Area Processed by CEPA‐JICA Project 1
slope Slope Project Area Processed by CEPA‐JICA Project 1
contour_10.shp 10m interval contours Project Area Processed by CEPA‐JICA Project 1
contour_50.shp 50m interval contours Project Area Processed by CEPA‐JICA Project 1

watershed (many) Watershed created by ASTER GDEM Project Area Processed by CEPA‐JICA Project 1
PNG_Contours (many) Contour PNG CEPA database

DEM_SRTM30_z55.tif Surface created by SRTM30.tif PNG 1
hillshade_srtm30_z55.tif Hillshade PNG 1
contour100_srtm30_z55.shp 100m interval contours PNG 1
dem_srtm90 SRTM (90m) DEM PNG Processed by CEPA‐JICA Project 1
hillshade1 Hillshade created by dem_srtm90 PNG Processed by CEPA‐JICA Project 1
slope1 Slope created by dem_srtm90 PNG Processed by CEPA‐JICA Project 1
contour_100 100m interval contours created by dem_srtm90 PNG Processed by CEPA‐JICA Project 1
contour_50 50m interval contours created by dem_srtm90 PNG Processed by CEPA‐JICA Project 1

CEN (many) SRTM analysis data set in Central province Central province Processed by CEPA‐JICA Project 1
NTH (many) SRTM analysis data set in Northern province Northern province Processed by CEPA‐JICA Project 1

ndvi (trial) Processed by CEPA‐JICA Project 1
ndwi (trial) Processed by CEPA‐JICA Project 1

kokoda_catchmentboundary.
shp

Catchment area intersect with Kokoda project
area

Kokoda project area CEPA database

Kokoda_Interim_Protection_
Zone.shp

Kokoda project area Kokoda project area CEPA database

Kokoda_Track_BillJames.shp Kokoda track Kokoda project area CEPA database

NMB_Cadastral_M
Goldie_NW.tif/Kokoda_SW.ti
f/Sogeri_NE/Sogeri_SE

Topographic map Kokoda project area CEPA database

Social_Mapping Kokoda_Social_Mapping.gdb Kokoda project area CEPA database

PNG_Coast
PNG PROVINCIAL
BOUNDARY.TAB

Coast line PNG CEPA database

Project_boundary.shp Project are boundary Project Area Created by CEPA‐JICA Project 1
Project_boundary_20160328.
shp

Project are boundary (updated on 28th March
2016)

Project Area Created by CEPA‐JICA Project 1

Project_boundary_20160328
_utm55.shp

Project area boundary (UTM zone 55) Project Area Created by CEPA‐JICA Project 1

Analysis data

21_Boundary

12_SatelliteAnalyst

11_TopoAnalyst

Folder name

02_DEM

01_Satellite

SRTM_90

Satellite &
airborne imagery
(original/pre‐
analysis data)

Kokoda

SRTM

ASTER_GDEM

SRTM_30



File type File name Description Extent Souce PreparedFolder name

Project_boundary_20160328
_outside.shp

Central Province areas outside
"Project_bouhdary_20160328.shp"
(for map)

Project Area Created by CEPA‐JICA Project 1

Central_LLG_20151015.shp LLG data in Central province Central province Created from Census data 1

Central_LLG_20161012.shp LLG data in Central province Central province
Originally from Cencus data; modified
coastline with XX and World View imagery
for around target area

1

PNG_outside.shp
Sea area outside PNG
(for map)

Created by CEPA‐JICA Project 1

22_Census Census2011 (many) PNG Census 2011 PNG NSO 1
23_ForestMap (many) Forest Base Map created by JICA‐FA project Central province PNGFA 1

CRC_SI (many) Land cover classification map PNG CEPA database
DAL_landuse (many) Land use map PNG CEPA database
vegetation (many) Vegetation map PNG CEPA database
EnvironmentalConstraints (many) PNG CEPA database
PeatSoils (many) Peat soil PNG CEPA database

26_GeologicalMap MRA_PNG_GeologicalRegion
MRA PNG Geological
Region.shp

Geological map PNG CEPA database

27_Fishery NewGuinea_Fisheries (many) Fishery related data PNG CEPA database
28_Mining MRA_Mining_Tenaments (many) Mining related data PNG CEPA database
29_ProtectedArea PNG_Protected_Areas (many) Protected area PNG CEPA database

Power
Naoro_Brown_Power_Infruct
ure.shp

Electric power plant NCD around CEPA database

Thumb_Mountains_Track (many) Mountain track NCD around CEPA database
VNP_Boundary.shp Varirata NP boundary Vrirata NP Digitized Varirata National Park Map 1
VNP_Boundary_buffer.shp 3 km buffer area of Varirata NP boundary Vrirata NP 1

Landuse_201610 Land use map Project Area (terrestrial)
Created by interpreting WorldView imagery,
site visit, and referring Varirata National Park
map, past LANDSAT imagery, etc.

1

VNP_VegetationMap_1510.s
hp

Vegetation map around Varirata NP created by
interpreting and digitizing openlayer (google
images) on QGIS

Vrirata NP around Created by CEPA‐JICA Project 1

VNP_River.shp River Project Area
Created by referring ISCGM data, DEM,
Varirata National Park Map, etc., digitizing
World View imagery, and field survey

1

VNP_Road.shp Road in Varinata NP Vrirata NP
Created by digitizing World View imagery
and getting location with GPS

1

Settlement_CEN Settlement Central province
Modified PNG Geobook data by hearing and
site visit

1

hillshd_VNP_5idw_p1_fix30.ti
f

Hillshade Vrirata NP Analyzed SRTM DEM 1

VNP_Facility_db.xls Facility in Vrirata NP (database) Vrirata NP Created by CEPA‐JICA Project 1

VNP_Facility_pnt.shp
Facility in Vrirata NP (point data) (Results of the
first VNP facility assessment implemented by the
CEPA‐JICA Project)

Vrirata NP
The data is used for the maps before April,
2018.

1

VNP_Facility_lin.shp
Facility in Vrirata NP (line data) (Results of the
first VNP facility assessment implemented by the
CEPA‐JICA Project)

Vrirata NP
The data is used for the maps before April,
2018.

1

VNP_Facility_png.shp
Facility in Vrirata NP (polygon data) (Results of
the first VNP facility assessment implemented by
the CEPA‐JICA Project)

Vrirata NP
The data is used for the maps before April,
2018.

1

VNP_Facility_update_pnt.shp Facility in Vrirata NP (point data) Vrirata NP
The data is updated according to the
situation of the facility on site with
"VNP_Facility_db.xls".

1

VNP_Facility_update_lin.shp Facility in Vrirata NP (line data) Vrirata NP
The data is updated according to the
situation of the facility on site with
"VNP_Facility_db.xls".

1

VNP_Facility_update_png.shp Facility in Vrirata NP (polygon data) Vrirata NP
The data is updated according to the
situation of the facility on site with
"VNP_Facility_db.xls".

1

VNP_DistancePiles.shp Distance piles placed in Varirata NP Vrirata NP Created by CEPA‐JICA Project 1
DigicelTower2.shp Digicel tower Vrirata NP Created by CEPA‐JICA Project 1

30_Others

25_LandCon

24_Landuse

ProjectArea



File type File name Description Extent Souce PreparedFolder name
PoliceTower.shp Police Repeater Communication Tower Vrirata NP Created by CEPA‐JICA Project 1
CameraTrap.shp Camera trap (data before 15 Oct 2015) Vrirata NP Created by CEPA‐JICA Project 1
CameraTrap_update.shp Camera trap Vrirata NP Created by CEPA‐JICA Project 1
PotentialBirdWatchingSites.s
hp

Potential bird watching sites (2016.04.06 version) Project Area Created by CEPA‐JICA Project 1

VNP_Zone.shp VNP management zone Vrirata NP Created by CEPA‐JICA Project 1
MAB_Zone1.shp MAB zone for terrestrial Project Area Created by CEPA‐JICA Project 1
MAB_Zone2.shp MAB zone between terrestrial and marine Project Area Created by CEPA‐JICA Project 1

MAB_Zone_merge.shp
Merged data of MAB_Zone1.shp and
MAB_Zone2.shp (Created for BR Nomination
Form)

Project Area Created by CEPA‐JICA Project 1

MAB_Zone_merge_diss.shp
Dissolved data of MAB_Zone_merge.shp
(Created for BR Nomination Form)

Project Area Created by CEPA‐JICA Project 1

MAB_Zone_merge_diss_pnt.
shp

Center point of MAB_Zone_merge_diss.shp
(Created for BR Nomination Form)

Project Area Created by CEPA‐JICA Project 1

MAB_Zone_terrestrial.shp
MAB zone (only proposed terrestrial area)
(Created for BR Nomination Form)

Project Area Created by CEPA‐JICA Project 1

MAB_Zone_terrestrial_pnt.sh
p

Center, mostnorthern, mostsouthern,
mosteastern, and mostwestern points of
MAB_Zone_terrestrial.shp
(Created for BR Nomination Form)

Project Area Created by CEPA‐JICA Project 1

PopDen2008_sqkm.tif
Population density analyzed using Census Unit
2008

Project Area Created by CEPA‐JICA Project 1

PopDen2008_sqkm_clp.tif
Population density analyzed using Census Unit
2008 (clip with land area)

Project Area Created by CEPA‐JICA Project 1

ward_boundary_smp.shp Tentative boundary of wards Project Area Created by CEPA‐JICA Project 1

landuse_r (many)
Process data for developing land use map
merged Landuse_201610 and Forest Base Map

Vrirata NP around Created by CEPA‐JICA Project 1

Frog_habitat.shp Distribution of lake frogs Vrirata NP
Raggiana Bird of
Paradise_display tree.shp

Location of Raggiana Bird of Paradise display
trees

Vrirata NP

Megapode_mounds.shp Location of Megapode Mounds Vrirata NP
Giant_Bandicoot_distribution
.shp

Potential distribution of the Giant Bandicoot
(Peroryctes broadbenti )

Vrirata NP

Castanopsis forests.shp Castanopsis acuminatissima  dominated forests Vrirata NP

Field survey data implemented in the CEPA‐
JICA Project.
Data reported in "Final Report Biodiversity
(Flora) Survey for Varirata National Park May
2018"

1

Lantana camara.shp Occurrence of Lantana camara Vrirata NP
Spathodea campanulata.shp Occurrence of Spathodea campanulata Vrirata NP
Tradescantia sp.shp Occurrence of Tradescantia  sp. Vrirata NP
Mature Piper aduncum
plants.shp

Distribution of mature Piper aduncum Vrirata NP

Clidemia_density.shp Density of Clidemia (Miconia crenata ) Vrirata NP

Dogs_observed.shp
Areas of VNP where dogs are commonly
observed

Vrirata NP

Rusa Deer_observed.shp
Areas of VNP where rusa deer are commonly
observed

Vrirata NP

Wild Pigs_observed.shp
Areas of VNP where wild pigs are commonly
observed

Vrirata NP

varirata.shp Protected area derived from PNG Geobook Vrirata NP CEPA database

varirata_facility.shp
Facilities including Lookouts and toilets in VNP
protted by referring Varirata NP map

Vrirata NP Created by CEPA‐JICA Project 1

map_layoutframe.shp Layout frame for VNP map Vrirata NP Created by CEPA‐JICA Project 1
MapPges_DetailLocation.shp Data for map Vrirata NP Created by CEPA‐JICA Project 1

map_tile_WV2.shp
Layout frame of VNP map for World View 2
images

Vrirata NP Created by CEPA‐JICA Project 1

ProposedBR_location_pnt.sh
p

Points data to confirm Proposed BR location for
BR Nomination Form

Vrirata NP Created by CEPA‐JICA Project 1

variratamap.tiff Varirata NP map Vrirata NP CEPA database
variratamap_reference.tiff Varirata NP map georeferenced Vrirata NP CEPA database

31_VarirataNP

Thematic data

1

1

ref

biological_survey_
2017

Field survey data implemented in the CEPA‐
JICA Project.
Data reported in "Final Report Biodiversity
(Fauna) Survey for Varirata National Park
May 2018"

Field survey data implemented in the CEPA‐
JICA Project.
Data reported in "Final Report Invasive
Species Management Plan for Varirata
National Park May 2018"

etc

old

data



File type File name Description Extent Souce PreparedFolder name
variratabasemap.tif Varirata NP map georeferenced Vrirata NP Created by CEPA‐JICA Project 1
digicel tower.txt Lat/long infomation of degicel tower Vrirata NP GPS info by CEPA‐JICA Project 1

BBay_Sites.shp
Sites (International dive site, UPNG research site,
Customary/traditional fishing feround)

Project Area (marine) Created by CEPA‐JICA Project 1

BBay_coastline_buff20m.shp 20m buffer from coastline Project Area (marine) Created by CEPA‐JICA Project 1

Road_P.shp Road Project Area
Modified Openstreetmap line data by
interpreting WorldView‐2 imagery

1

Mangrove.shp Mangrove Project Area (marine)
Created by referring World View imagery
and field survey

1

Mangrove_area.shp Mangrove (divided regions) Project Area (marine) Created by CEPA‐JICA Project 1
Mangrove_outline.shp Outline of Mangrove Project Area (marine) Created by CEPA‐JICA Project 1
Mangrove_sanctuary.shp Mangrove inside Marine Sanctuary area Project Area (marine) Created by CEPA‐JICA Project 1

Mangrove_outline_pnt.shp
Rough points along outlines of mangrove inside
marine sanctuary area

Project Area (marine) Created by CEPA‐JICA Project 1

Reef.shp Reef Project Area (marine)

Created by referring World View imagery
and "PAPUA NEW GUINEA SOUTH COAST
APPROACHES TO PORT MORESBY DEPTH IN
METRES" map

1

Reef_sanctuary.shp Reaf inside Marine Sanctuary area Project Area (marine) Created by CEPA‐JICA Project 1
Seagrass.shp seagrass Project Area (marine) Created on the basis of field survey 1
Sargassum.shp sargassum (seaweed) Project Area (marine) Created on the basis of field survey 1

Depth_line.shp Depth in meter Project Area (marine)

Created by referring World View imagery
and "PAPUA NEW GUINEA SOUTH COAST
APPROACHES TO PORT MORESBY DEPTH IN
METRES" map

1

Motupore_island.shp Motupore Island Project Area (marine) Created by CEPA‐JICA Project 1
Motupore_island_630mbuf.s
hp

630m buffer from coast line of Motupore Island Project Area (marine) Created by CEPA‐JICA Project 1

630m_line.shp (for map) Project Area (marine) Created by CEPA‐JICA Project 1
Motupore_island_20mbuf.sh
p

20m buffer from coast line of Motupore Island Project Area (marine) Created by CEPA‐JICA Project 1

Motupore_Zone.shp Zone in Motupore Island Project Area (marine) Created by CEPA‐JICA Project 1
Motupore_Zone2.shp Zone in Motupore Island (second plan) Project Area (marine) Created by CEPA‐JICA Project 1

UPNG_land.shp UPNG survey area at Tahira Project Area (marine)
Created by the paper map shown UPNG land
and and field survey (GPS data)

1

UPNG_Zone.shp Zone in UPNG land Project Area (marine) Created by CEPA‐JICA Project 1
UPNG_Zone2.shp Zone in UPNG land (second plan) Project Area (marine) Created by CEPA‐JICA Project 1
CPC_land.shp CPC land boundary Project Area (marine) Created by CEPA‐JICA Project 1
CPC_Zone.shp Zone in CPC Project Area (marine) Created by CEPA‐JICA Project 1
Tahira_farm_Mangrove.shp Tahira farm and neaby mangrove areas Project Area (marine) Created by CEPA‐JICA Project 1
Tahira_farm_Zone.shp Zone in Tahira farm Project Area (marine) Created by CEPA‐JICA Project 1
CPG_land.shp CPG land boundary Project Area (marine) Created by CEPA‐JICA Project 1
Proposed MPA
Boundary_lin.shp

Boundary of marine area of proposed Marine
Protected Area

Project Area (marine) Created by CEPA‐JICA Project 1

Proposed MPA
Boundary_pin.shp

Main points on boundary of marine area of
proposed Marine Protected Area

Project Area (marine) Created by CEPA‐JICA Project 1

MPA_Terrestrial_area.shp Terrestrial area of Marine Sanctuary area Project Area (marine) Created by CEPA‐JICA Project 1
MPA_Marine_area.shp Marine area of Marine Sanctuary area Project Area (marine) Created by CEPA‐JICA Project 1
CEN_gov_land.shp Central government land Project Area (marine) Created by CEPA‐JICA Project 1
Customary_land.shp Customary land Project Area (marine) Created by CEPA‐JICA Project 1

Signboard_prohibition
Signboard for prohibition against mangrove
trimming

Project Area (marine) Created by CEPA‐JICA Project 1

Pipeline.shp Pipeline Project Area (marine) Digitized 1
MAB_Zone_Marine.shp MAB zone for marine Project Area (marine) Created by CEPA‐JICA Project 1

NMS_region_areas.shp Rough region areas of National Marine Sanctuary Project Area (marine) Created by CEPA‐JICA Project 1

NMS_Zone.shp Management zone of National Marine Sanctuary Project Area (marine) Created by CEPA‐JICA Project 1

Feature.shp
Jetty, Resort, Habitat areas, Cultural/Historical
areas

Project Area (marine) Created by CEPA‐JICA Project 1

Tuna migratory route.shp Tuna migratory route Project Area (marine) Created by CEPA‐JICA Project 1
Yellow‐fin tuna.shp Yellow‐fin tuna Project Area (marine) Created by CEPA‐JICA Project 1

32_MarineNP

data

ref



File type File name Description Extent Souce PreparedFolder name
Ship route ship route Project Area (marine) Created by CEPA‐JICA Project 1
Docking mooring facility.shp Docking and mooring facilities (location options) Project Area (marine) Created by CEPA‐JICA Project 1
High water mark.shp Estimated high water mark Project Area (marine) Created by CEPA‐JICA Project 1
cal_Area.xlsx Area of proposed MPA and Mangroves Project Area (marine) Created by CEPA‐JICA Project 1
mangrove_outline_LatLon.xls
x

latitude and longitude of
"Mangrove_outline_pnt.shp"

Project Area (marine) Created by CEPA‐JICA Project 1

map tile_mangrove2000.shp Tiles for mangrove map (1:2,000) Project Area (marine) Created by CEPA‐JICA Project 1
ref google_capture.jpg google image around Bootles Bay Project Area (marine) 1

PNGRIS2007_PNG
_Capitals

PNG_Provincial_Capitals_PN
GRIS.shp

Provincial capitals PNG CEPA database

PNGRIS2007_PNG
_Coastline

PNG_coastline.shp PNG coastline PNG CEPA database

PNGRIS2007_PNG
_Districts

(many) Districts PNG CEPA database

PNGRIS2007_PNG
_Provinces

PNG_Provincial_Boundaries_
PNGRIS2007.shp

Provinces PNG CEPA database

42_Geobooks PNG_Geobook (many) PNG geobook Central province CEPA database

51_Hansen (many)
Global Forest Change data by Hansen et al.
:Forest cover, Loss, Gain, Lossyear, First, Last

PNG
http://earthenginepartners.appspot.com/sci
ence‐2013‐global‐
forest/download_v1.2.html

1

52_Openstreetmap
line.shp/point.shp/polygon.s
hp

Road Project Area https://openstreetmap.jp/ 1

53_Google varirata google.jpg google earth capture imagery Project Area Google Earth 1
54_ISCGM (many) PNG http://www.iscgm.org/ 1

Atlas Map layout for Atlas Created by CEPA‐JICA Project 1
MAB Map layout related to the Project Project Area Created by CEPA‐JICA Project 1
Mangrove Map layout related to Mangrove Project Coastal Area Created by CEPA‐JICA Project 1
Marine Map layout related to Marine PA Project Coastal Area Created by CEPA‐JICA Project 1
Motupore Map layout related to Motupore Motupore Created by CEPA‐JICA Project 1
VarirataNP Map layout related to Varirata NP Varirata NP Created by CEPA‐JICA Project 1
Zoning Map layout related to Zoning Created by CEPA‐JICA Project 1
etc Other map layout Created by CEPA‐JICA Project 1

82_Maps Output maps Created by CEPA‐JICA Project 1
83_Logo Images for map (ex: PNG logo and JICA logo) 1

List of
Facility_YYYYMMDD.xlsx

Lists of VNP Facility 1

VNP‐Facility‐profile‐No.xlsx Profiles of VNP Facility 1
Updating facility
database_201607.pptx

Manual on updating VNP facility database (Excel)
(July 2016, by Mr Imai)

1

Update of VNP facility
database_20181025.pptx

Manual on updating VNP facility database (GIS)
(October 2018)

1

Maps for VNP Facility
Management_20181025.xlsx

Contents of Maps for VNP Facility Management
(October 2018)

1

Manual on Getting location
information_20180209.pptx

Manual on Getting location information
(Importing GPS data to GIS) (February 2018)

1

ENVI manual_20170404.pdf ENVI manual (4 April 2017) 1
20160422_Introduction of
Satellite Imagery.pptx

Introduction of Satellite Imagery ‐ WorldView‐2
(22 April 2016)

1

20200204_GIS Data
Management.pptx

GIS Data Management (February 2020) 1

CEPA‐JICA Project GISDB
list.xlsx

CEPA‐JICA Project GIS Database list 1

CEPA‐JICA Project Map
list.xlsx

CEPA‐JICA Project Map list 1

Presentation documents

Manuals and related documents

VNP Facility management

81_MapLayout

Exsisting system
& data sets

Other documents
(non‐spatial data)

91_Documents

PNGRIS2007_PNG

etc

Map layout &
output images

41_PNGRIS



 
 
 
 
 
 
 
 
 

添付資料 4.1.2 Project map list 



Maps for target protected areas (overall map)

Map document
Data folder GISDB\81_MapLayout\MAB
Data File name Description

MAB_base.mxd Provisional Project Boundary Map
Project Site.mxd Project Site map (there are several maps)
Terrestrial Areas Map.mxd Terrestrial Areas Map (WorldView-2)
Terrestrial Areas Map_VNP.mxd Varirata National Park Map (WorldView-2)
Terrestrial Areas_Landuse.mxd Land Use Map (Proposed terrestrial areas)
Marine Areas Map (satellite).mxd Marine / Coastal Areas Map (WorldView-2)
Marine Areas Map_Bbay (satellite).mxd Marine / Coastal Areas (Bootles Bay) Map (WorldView-2)
MAB_zoning.mxd Management zone map

Exported map
Data folder GISDB\82_Maps\MAB
Data File name Description Corresponding map document

MAB_base.jpg Provisional Project Boundary Map MAB_base.mxd
Project Site.jpg Project Site map (there are several maps) Project Site.mxd
Terrestrial Areas Map.jpg Terrestrial Areas Map (WorldView-2) Terrestrial Areas Map.mxd
Terrestrial Areas Map_VNP.jpg Varirata National Park Map (WorldView-2) Terrestrial Areas Map_VNP.mxd
Terrestrial Areas_Landuse.jpg Land Use Map (Proposed terrestrial areas) Terrestrial Areas_Landuse.mxd
Marine Areas Map (satellite).jpg Marine / Coastal Areas Map (WorldView-2) Marine Areas Map (satellite).mxd
Marine Areas Map_Bbay (satellite).jpg Marine / Coastal Areas (Bootles Bay) Map (WorldView-2) Marine Areas Map_Bbay (satellite).mxd
MAB_zoning.jpg Management zone map MAB_zoning.mxd



Maps for Varirata National Park

Map document
Data folder GISDB\81_MapLayout\VarirataNP
Data File name Description

VarirataNP_base.mxd VNP basic map included land use

VarirataNP_facility.mxd
Map for facility management (maps of overall view/ distribution 
of detail location maps of facility)

VarirataNP_facility_D.mxd Map for facility management (detail location maps)
VarirataNP_camera trap.mxd Map for facility management (distribution of camera traps)
VarirataNP_Main Signboard.mxd Map designed for main signboard
VarirataNP_guide map.mxd Map designed for guide map (overall view)
VarirataNP_guide map_circuit track.mxd Map designed for guide map (circuit track)
VarirataNP_guide map_gares lookout track.mxd Map designed for guide map (gares lookout track)
VarirataNP_guide map_scarp track.mxd Map designed for guide map (scarp track)
VarirataNP_guide map_self guide track.mxd Map designed for guide map (self guide track)
VarirataNP_IC.mxd Map for Information Center
VarirataNP_zoning.mxd Varirata National Park zoning map

Exported map
Data folder GISDB\82_Maps\VarirataNP
Data File name Description Corresponding map document

VarirataNP_base.jpg VNP basic map included land use VarirataNP_base.mxd
VarirataNP_facility_A.jpg Map for facility management (overall view: main facility) VarirataNP_facility.mxd

VarirataNP_facility_B.jpg
Map for facility management (distribution of detail location maps 
of facility)

VarirataNP_facility.mxd

VarirataNP_facility_C1.jpg
Map for facility management (overall view: sign board, bridge, 
hand rail, car parking)

VarirataNP_facility.mxd

VarirataNP_facility_C2.jpg Map for facility management (overall view: toilet) VarirataNP_facility.mxd
VarirataNP_facility_C3.jpg Map for facility management (overall view: structure) VarirataNP_facility.mxd
VarirataNP_facility_D_01.jpg Map for facility management (detail location map (1)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_02.jpg Map for facility management (detail location map (2)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_03.jpg Map for facility management (detail location map (3)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_04.jpg Map for facility management (detail location map (4)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_05.jpg Map for facility management (detail location map (5.1)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_06.jpg Map for facility management (detail location map (5.2)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_07.jpg Map for facility management (detail location map (6.1)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_08.jpg Map for facility management (detail location map (6.2)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_09.jpg Map for facility management (detail location map (7)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_10.jpg Map for facility management (detail location map (8.1)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_11.jpg Map for facility management (detail location map (8.2)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_12.jpg Map for facility management (detail location map (9)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_13.jpg Map for facility management (detail location map (10)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_14.jpg Map for facility management (detail location map (11)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_15.jpg Map for facility management (detail location map (12 & 13)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_16.jpg Map for facility management (detail location map (12)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_17.jpg Map for facility management (detail location map (13)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_18.jpg Map for facility management (detail location map (14)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_19.jpg Map for facility management (detail location map (15)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_20.jpg Map for facility management (detail location map (16)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_21.jpg Map for facility management (detail location map (17.1)) VarirataNP_facility_D.mxd
VarirataNP_facility_D_22.jpg Map for facility management (detail location map (17.2)) VarirataNP_facility_D.mxd
VarirataNP_camera trap_[Date].jpg Map for facility management (distribution of camera traps) VarirataNP_camera trap.mxd
VarirataNP_Main Signboard.jpg Map designed for main signboard VarirataNP_Main Signboard.mxd
VarirataNP_guide map.jpg Map designed for guide map (overall view) VarirataNP_guide map.mxd
VarirataNP_guide map_circuit track.jpg Map designed for guide map (circuit track) VarirataNP_guide map_circuit track.mxd
VarirataNP_guide map_gares lookout track.jpg Map designed for guide map (gares lookout track) VarirataNP_guide map_gares lookout track.mxd
VarirataNP_guide map_scarp track.jpg Map designed for guide map (scarp track) VarirataNP_guide map_scarp track.mxd
VarirataNP_guide map_self guide track.jpg Map designed for guide map (self guide track) VarirataNP_guide map_self guide track.mxd
VarirataNP_IC.jpg Map for Information Center VarirataNP_IC.mxd
VarirataNP_zoning.jpg Varirata National Park zoning map VarirataNP_zoning.mxd



Maps for Marine Protected Areas

Map document
Data folder GISDB\81_MapLayout\Marine
Data File name Description

Mangrove.mxd Mangrove map

Marine Areas Map_Bbay_protected area.mxd
Marine Areas (Bootles Bay) Map for Marine Protected Areas 
(there are several version)

Marine Areas Map_Bbay_NMS.mxd Marine Areas (Bootles Bay) Map for National Marine Sanctuary
Marine PA_FieldSurvey.mxd Marine Protected Areas map
Marine PA_CPC.mxd Marine Protected Areas (CPC land) map
Marine PA_Motupore.mxd Marine Protected Areas (Motupore Island) map
Marine PA_Tahira farm.mxd Marine Protected Areas (Tahira farm) map
Marine PA_UPNG.mxd Marine Protected Areas (UPNG land) map
Marine PA_CPG.mxd Marine Protected Areas (CPG land) map
Marine PA_mangrove location.mxd Mangrove location map of Marine Protected Areas
Marine PA_signboad.mxd Marine Protected Areas map for signboad

Exported map
Data folder GISDB\82_Maps\Marine
Data File name Description Corresponding map document

Mangrove.jpg Mangrove map Mangrove.mxd

Marine Areas Map_Bbay_protected area.jpg
Marine Areas (Bootles Bay) Map for Marine Protected Areas 
(there are several version)

Marine Areas Map_Bbay_protected area.mxd

Marine Areas Map_Bbay_NMS.jpg Marine Areas (Bootles Bay) Map for National Marine Sanctuary Marine Areas Map_Bbay_NMS.mxd
Marine PA.jpg Marine Protected Areas map Marine PA_FieldSurvey.mxd
Marine PA_CPC land.jpg Marine Protected Areas (CPC land) map Marine PA_CPC.mxd
Marine PA_CPC land_Zone.jpg Marine Protected Areas (CPC land) zoning map Marine PA_CPC.mxd
Marine PA_Motupore.jpg Marine Protected Areas (Motupore Island) map Marine PA_Motupore.mxd
Marine PA_Motupore_Zone.jpg Marine Protected Areas (Motupore Island) zoning map Marine PA_Motupore.mxd
Marine PA_Tahira Farm.jpg Marine Protected Areas (Tahira farm) map Marine PA_Tahira farm.mxd
Marine PA_Tahira Farm_Zone.jpg Marine Protected Areas (Tahira farm) zoning map Marine PA_Tahira farm.mxd
Marine PA_UPNG land.jpg Marine Protected Areas (UPNG land) map Marine PA_UPNG.mxd
Marine PA_UPNG land_Zone.jpg Marine Protected Areas (UPNG land) zoning map Marine PA_UPNG.mxd
Marine PA_CPG.jpg Marine Protected Areas (CPG land) map Marine PA_CPG.mxd



Various types of maps requested

Map document
Data folder GISDB\81_MapLayout\etc
Data File name Description

Protected Area_0.1.mxd PNG Protected Areas
Potential Bird Watching Sites_1.0.mxd Potential Bird Watching Sites
Landsat.mxd Time-series LANDSAT images of the target sites
Hansen.mxd Distribution of Hansen data of the proposed terrestrial areas
White Map.mxd White map with settlements

Exported map
Data folder GISDB\82_Maps\etc
Data File name Description Corresponding map document

Protected Area_0.1.jpg PNG Protected Areas Protected Area_0.1.mxd
Potential Bird Watching Sites_1.0.jpg Potential Bird Watching Sites Potential Bird Watching Sites_1.0.mxd
Landsat.jpg Time-series LANDSAT images of the target sites Landsat.mxd
Hansen.jpg Distribution of Hansen data of the proposed terrestrial areas Landsat_Hansen.mxd
White Map.jpg White map with settlements White Map.mxd



Maps for the Project Atlas 2017

Map document
Data folder GISDB\81_MapLayout\Atlas
Data File name Description

C1_S1_01_Location.mxd Location map of the target sites
C1_S1_02_LANDSAT.mxd Time-series LANDSAT images of the proposed terrestrial areas
C1_S1_02_WorldView2.mxd WorldView-2 images of the proposed terrestrial areas
C1_S2_01_Environment.mxd Physical environment maps of the proposed terrestrial areas
C1_S3_01_Ward.mxd Socioeconomic maps of the proposed terrestrial areas
C2_S1_01_Location.mxd Location map of the target sites 2
C2_S1_02_WorldView2.mxd WorldView-2 images of the Varirata National Park

Exported map
Data folder GISDB\82_Maps\Atlas
Data File name Description Corresponding map document

C1_S1_01_Location.jpg Location map of the target sites C1_S1_01_Location.mxd
C1_S1_02_LANDSAT.jpg Time-series LANDSAT images of the proposed terrestrial areas C1_S1_02_LANDSAT.mxd
C1_S1_02_WorldView2.jpg WorldView-2 images of the proposed terrestrial areas C1_S1_02_WorldView2.mxd
C1_S2_01_Altitude.jpg Altitude of the proposed terrestrial areas C1_S2_01_Environment.mxd
C1_S2_02_Slope.jpg Slope of the proposed terrestrial areas C1_S2_01_Environment.mxd
C1_S2_02_Basin.jpg Catchment of the proposed terrestrial areas C1_S2_01_Environment.mxd
C1_S2_02_Vegetation.jpg Land Use Map of the proposed terrestrial areas C1_S2_01_Environment.mxd
C1_S3_01_Population.jpg Population per Census Units C1_S3_01_Ward.mxd
C1_S3_01_PopulationDensity.jpg Population density C1_S3_01_Ward.mxd
C1_S3_01_Ward.jpg Distribution of Words C1_S3_01_Ward.mxd
C2_S1_01_Location.jpg Location map of the target sites 2 C2_S1_01_Location.mxd
C2_S1_02_WorldView2.jpg WorldView-2 images of the Varirata National Park C2_S1_02_WorldView2.mxd



Map for Facility Management in Varirata National Park
Last revised date: 25th October, 2018

Map document folder: GISDB\81_MapLayout\VarirataNP
Exported map folder: GISDB\82_Maps\VarirataNP
* Version of the files, which trailling number indicates, could be changed.
* The maps should be updated periodically followed by field survey of facility management.
* Refer to each Sheet for the original layer setting.

No. File name of exported map Map document Map reflects result of … Note
1 Location of Facilities in Varirata National Park (Gazette Area) (to be exported when needed) VarirataNP_facility_update_1.0.mxd Latest facility update as of May 2018
2 Facility Map (Sign board, bridge, hand rail, car parking) (to be exported when needed) VarirataNP_facility_update_1.0.mxd Latest facility update as of May 2018
3 Facility Map (Structure) (to be exported when needed) VarirataNP_facility_update_1.0.mxd Latest facility update as of May 2018
4 Facility Map (Toilet) (to be exported when needed) VarirataNP_facility_update_1.0.mxd Latest facility update as of May 2018
5 Distribution of Camera Traps (22 SEP 2015 ‐ 15 OCT 2015) VarirataNP_camera trap_22SEP15_2.0.jpg VarirataNP_camera trap_update_1.0.mxd Latest facility update as of May 2018
6 Distribution of Camera Traps (15 OCT 2015 ‐ 2016) VarirataNP_camera trap_15OCT15_2.0.jpg VarirataNP_camera trap_update_1.0.mxd Latest facility update as of May 2018
7 Distribution of Camera Traps (2016 ‐ Early 2017) VarirataNP_camera trap_2016_2.0.jpg VarirataNP_camera trap_update_1.0.mxd Latest facility update as of May 2018
8 Distribution of Camera Traps (As of 10 NOV 2017) VarirataNP_camera trap_10NOV17_2.0.jpg VarirataNP_camera trap_update_1.0.mxd Latest facility update as of May 2018
9 Distribution of Detail Location Maps of Facilities in Varirata National  (to be exported when needed) VarirataNP_facility_update_1.0.mxd Latest facility update as of May 2018
10 Detail Location Map of Facilities (1) Along main road: Entrance ‐ Main(to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
11 Detail Location Map of Facilities (2) Main Picnic Area (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
12 Detail Location Map of Facilities (3) Picnic Site 2 (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
13 Detail Location Map of Facilities (4) Lodge Area (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
14 Detail Location Map of Facilities (5.1) Lake Site (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
15 Detail Location Map of Facilities (5.2) Lake Site (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
16 Detail Location Map of Facilities (6.1) Camping Area (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
17 Detail Location Map of Facilities (6.2) Camping Area (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
18 Detail Location Map of Facilities (7) Main Outlook (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
19 Detail Location Map of Facilities (8.1) Self Guide Track (Main Outlook (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
20 Detail Location Map of Facilities (8.2) Self Guide Track (Picnic site 2 si (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
21 Detail Location Map of Facilities (9) Circuit Track (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
22 Detail Location Map of Facilities (10) Picnic Site 3 (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
23 Detail Location Map of Facilities (11) Picnic Site 4 (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
24 Detail Location Map of Facilities (12 & 13) Ranger's quarter & house (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
25 Detail Location Map of Facilities (12) Ranger's quarter (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
26 Detail Location Map of Facilities (13) Ranger's house (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
27 Detail Location Map of Facilities (14) Signs on main road (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
28 Detail Location Map of Facilities (15) Scarp Track (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
29 Detail Location Map of Facilities (16) Gare's Lookout Track (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
30 Detail Location Map of Facilities (17.1) Boundary Track (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
31 Detail Location Map of Facilities (17.2) Boundary Track (to be exported when needed) VarirataNP_facility_D_update_1.0.mxd Latest facility update as of May 2018
32 Location of Facilities in Varirata National Park (Gazette Area) VarirataNP_facility_A_1.1.jpg VarirataNP_facility_1.1.mxd First facility assessment
33 Facility Map (Sign board, bridge, hand rail, car parking) VarirataNP_facility_C1_1.1.jpg VarirataNP_facility_1.1.mxd First facility assessment
34 Facility Map (Structure) VarirataNP_facility_C2_1.1.jpg VarirataNP_facility_1.1.mxd First facility assessment
35 Facility Map (Toilet) VarirataNP_facility_C3_1.1.jpg VarirataNP_facility_1.1.mxd First facility assessment
36 Distribution of Camera Traps (22 SEP 2015 ‐ 15 OCT 2015) VarirataNP_camera trap_22SEP15_1.1.jpg VarirataNP_camera trap_1.1.mxd First facility assessment
37 Distribution of Camera Traps (15 OCT 2015 ‐ as of Today) VarirataNP_camera trap_15OCT15_1.1.jpg VarirataNP_camera trap_1.1.mxd First facility assessment as of 20 Oct 2015
38 Distribution of Detail Location Maps of Facilities in Varirata National  VarirataNP_facility_B_1.1.jpg VarirataNP_facility_1.1.mxd First facility assessment
39 Detail Location Map of Facilities (1) Along main road: Entrance ‐ MainVarirataNP_facility_D_01_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
40 Detail Location Map of Facilities (2) Main Picnic Area VarirataNP_facility_D_02_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
41 Detail Location Map of Facilities (3) Picnic Site 2 VarirataNP_facility_D_03_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
42 Detail Location Map of Facilities (4) Lodge Area VarirataNP_facility_D_04_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
43 Detail Location Map of Facilities (5.1) Lake Site VarirataNP_facility_D_05_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
44 Detail Location Map of Facilities (5.2) Lake Site VarirataNP_facility_D_06_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
45 Detail Location Map of Facilities (6.1) Camping Area VarirataNP_facility_D_07_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
46 Detail Location Map of Facilities (6.2) Camping Area VarirataNP_facility_D_08_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
47 Detail Location Map of Facilities (7) Main Outlook VarirataNP_facility_D_09_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment

Map
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48 Detail Location Map of Facilities (8.1) Self Guide Track (Main OutlookVarirataNP_facility_D_10_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
49 Detail Location Map of Facilities (8.2) Self Guide Track (Picnic site 2 siVarirataNP_facility_D_11_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
50 Detail Location Map of Facilities (9) Circuit Track VarirataNP_facility_D_12_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
51 Detail Location Map of Facilities (10) Picnic Site 3 VarirataNP_facility_D_13_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
52 Detail Location Map of Facilities (11) Picnic Site 4 VarirataNP_facility_D_14_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
53 Detail Location Map of Facilities (12 & 13) Ranger's quarter & house VarirataNP_facility_D_15_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
54 Detail Location Map of Facilities (12) Ranger's quarter VarirataNP_facility_D_16_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
55 Detail Location Map of Facilities (13) Ranger's house VarirataNP_facility_D_17_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
56 Detail Location Map of Facilities (14) Signs on main road VarirataNP_facility_D_18_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
57 Detail Location Map of Facilities (15) Scarp Track VarirataNP_facility_D_19_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
58 Detail Location Map of Facilities (16) Gare's Lookout Track VarirataNP_facility_D_20_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
59 Detail Location Map of Facilities (17.1) Boundary Track VarirataNP_facility_D_21_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
60 Detail Location Map of Facilities (17.2) Boundary Track VarirataNP_facility_D_22_1.1.jpg VarirataNP_facility_D_1.1.mxd First facility assessment
61 Varirata National Park Map (to be exported when needed) VarirataNP_guide map_update_1.0.mxd Latest facility update as of May 2018
62 Gare's Lookout Track (to be exported when needed) VarirataNP_guide map_gares lookout track_u Latest facility update as of May 2018
63 Circuit Track (to be exported when needed) VarirataNP_guide map_circuit track_update_ Latest facility update as of May 2018
64 Self Guide Track (to be exported when needed) VarirataNP_guide map_self guide track_updatLatest facility update as of May 2018
65 Scarp Track (to be exported when needed) VarirataNP_guide map_scarp track_update_1 Latest facility update as of May 2018
66 Varirata National Park Map VarirataNP_guide map_1.3.jpg VarirataNP_guide map_1.3.mxd First facility assessment
67 Gare's Lookout Track VarirataNP_guide map_gares lookout_1.3.jpg VarirataNP_guide map_gares lookout track_1 First facility assessment
68 Circuit Track VarirataNP_guide map_circuit_1.3.jpg VarirataNP_guide map_circuit track_1.3.mxd First facility assessment
69 Self Guide Track VarirataNP_guide map_scarp_1.3.jpg VarirataNP_guide map_self guide track_1.3.mFirst facility assessment
70 Scarp Track VarirataNP_guide map_self guide_1.3.jpg VarirataNP_guide map_scarp track_1.3.mxd First facility assessment
71 Varirata National Park Main Area (to be exported when needed) VarirataNP_Main Signboard_update_1.0.mxd Latest facility update as of May 2018
72 Varirata National Park Main Area VarirataNP_Main Signboard_1.1.jpg VarirataNP_Main Signboard_1.1.mxd First facility assessment
73 Base map Land Use Map of Varirata National Park VarirataNP_base_landuse_1.3.jpg VarirataNP_base_1.3.mxd

Main signboard

Guide map



Facility management

Map document
VarirataNP_facility_update_1.0.mxd

To do:
 ‐ Change layer on/off.
 ‐ Change title.
 ‐ Change legend.

Location of Facilities in Varirata National Park (Gazette Area)

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt "Id" =1
VNP_Facility_update_lin "Id" =1
VNP_Facility_update_png(6,7,9)

Image

Facility Map (Sign board, bridge, hand rail, car parking)

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt(4,5,8) "VNP_Facility_update_pnt.Id" = 2 AND( 

"Sheet1$.Sub_category_No" =  4 OR 
"Sheet1$.Sub_category_No" =  5 OR 
"Sheet1$.Sub category No" = 8 )

VNP_Facility_update_pnt(29‐35) "VNP_Facility_update_pnt.Id" = 2 AND( 
"Sheet1$.Sub_category_No" =  29 OR 
"Sheet1$.Sub_category_No" =  30 OR 
"Sheet1$.Sub_category_No" =  31 OR 
"Sheet1$.Sub_category_No" =  32 OR 
"Sheet1$.Sub_category_No" =  33 OR 
"Sheet1$.Sub_category_No" =  34 OR 
"Sheet1$.Sub_category_No" =  35 ) AND ( "Sheet1$.Condition" 
<> 'Removed' AND "Sheet1$.Condition" <> 'will be removed' )

Image

Facility Map (Structure)

Rendered Layers Major Definition Query
Layer name Definition Query

(dummy image)



VNP_Facility_update_pnt(9‐13,18‐
22)

"VNP_Facility_update_pnt.Id" = 2 AND( 
"Sheet1$.Sub_category_No" =  9 OR 
"Sheet1$.Sub_category_No" =  10 OR 
"Sheet1$.Sub_category_No" =  11 OR 
"Sheet1$.Sub_category_No" =  12 OR 
"Sheet1$.Sub_category_No" =  13 OR 
"Sheet1$.Sub_category_No" =  18 OR 
"Sheet1$.Sub_category_No" =  19 OR 
"Sheet1$.Sub_category_No" =  20 OR 
"Sheet1$.Sub_category_No" =  21 OR 
"Sh t1$ S b t N " 22 )

Image

Facility Map (Toilet)

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt(28) VNP_Facility_update_pnt.Id =2 AND 

"Sheet1$.Sub_category_No" =  28 AND ( "Sheet1$.Condition" 
<> 'Removed' AND "Sheet1$.Condition" <> 'will be removed' )

Image

Distribution of Detail Location Maps of Facilities in Varirata National Park (Gazette Area)

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt "Id" =1
VNP_Facility_update_lin "Id" =1
VNP_Facility_update_png(6,7,9)

Image

(dummy image)



Facility management

Map document
VarirataNP_camera trap_update_1.0.mxd

To do:
 ‐ Change layer on/off.
 ‐ Change title.

Distribution of Camera Traps (22 SEP 2015 ‐ 15 OCT 2015)

Rendered Layers Major Definition Query
Layer name Definition Query
CameraTrap_22SEP15‐15OCT15 "st_date" = date '2015‐09‐22 00:00:00'
VNP_Facility_update_pnt "Id" = 1 AND( "facility" = 'Car road' OR "facility" = 'Lookout' 

OR "facility" = 'Track' )

Image

Distribution of Camera Traps (15 OCT 2015 ‐ 2016)

Rendered Layers Major Definition Query
Layer name Definition Query
CameraTrap_15OCT15‐
AsOfToday

"end_date" = date '2015‐12‐31 00:00:00'

VNP_Facility_update_pnt "Id" = 1 AND( "facility" = 'Car road' OR "facility" = 'Lookout' 
OR "facility" = 'Track' )

Distribution of Camera Traps (2016 ‐ Early 2017)

Rendered Layers Major Definition Query
Layer name Definition Query
CameraTrap_15OCT15‐
AsOfToday

"end_date" = date '2015‐12‐31 00:00:00'

VNP_Facility_update_pnt "Id" = 1 AND( "facility" = 'Car road' OR "facility" = 'Lookout' 
OR "facility" = 'Track' )

Distribution of Camera Traps (As of 10 NOV 2017)

Rendered Layers Major Definition Query
Layer name Definition Query
CameraTrap_15OCT15‐
AsOfToday

"end_date" = date '2015‐12‐31 00:00:00'

VNP_Facility_update_pnt "Id" = 1 AND( "facility" = 'Car road' OR "facility" = 'Lookout' 
OR "facility" = 'Track' )



Facility management

Map document
VarirataNP_facility_D_update_1.0.mxd

To do:
 ‐ Change View extent by using bookmark.
 ‐ Change title.
 ‐ Change legend.

Detail Location Map of Facilities (1) Along main road: Entrance ‐ Main Picnic Area

Bookmark
Bookmark 1_3000

Detail Location Map of Facilities (2) Main Picnic Area

Bookmark
Bookmark 2_1000

Detail Location Map of Facilities (3) Picnic Site 2

Bookmark
Bookmark 3_700

Detail Location Map of Facilities (4) Lodge Area

Bookmark
Bookmark 4_500

Detail Location Map of Facilities (5.1) Lake Site

Bookmark
Bookmark 5_1500

Detail Location Map of Facilities (5.2) Lake Site

Bookmark
Bookmark 6_600

Detail Location Map of Facilities (6.1) Camping Area

Bookmark
Bookmark 7_1500

Detail Location Map of Facilities (6.2) Camping Area

Bookmark
Bookmark 8_500

Detail Location Map of Facilities (7) Main Outlook

Bookmark
Bookmark 9_500

Detail Location Map of Facilities (8.1) Self Guide Track (Main Outlook side)

Bookmark
Bookmark 10_3000

Detail Location Map of Facilities (8.2) Self Guide Track (Picnic site 2 side)

Bookmark
Bookmark 11_3000

Detail Location Map of Facilities (9) Circuit Track

Bookmark
Bookmark 12_3000

Detail Location Map of Facilities (10) Picnic Site 3

Bookmark
Bookmark 13_1000

Detail Location Map of Facilities (11) Picnic Site 4

Bookmark
Bookmark 14_500

Detail Location Map of Facilities (12 & 13) Ranger's quarter & house

Bookmark
Bookmark 15_1000

Detail Location Map of Facilities (12) Ranger's quarter

Bookmark
Bookmark 16_500

Detail Location Map of Facilities (13) Ranger's house



Bookmark
Bookmark 17_500

Detail Location Map of Facilities (14) Signs on main road

Bookmark
Bookmark 18_3000

Detail Location Map of Facilities (15) Scarp Track

Bookmark
Bookmark 19_4500

Detail Location Map of Facilities (16) Gare's Lookout Track

Bookmark
Bookmark 20_4500

Detail Location Map of Facilities (17.1) Boundary Track

Bookmark
Bookmark 21_6000

Detail Location Map of Facilities (17.2) Boundary Track

Bookmark
Bookmark 22_4500

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt(4,5,8) "VNP_Facility_update_pnt.Id" = 2 AND( 

"Sheet1$.Sub_category_No" =  4 OR 
"Sheet1$.Sub_category_No" =  5 OR 
"Sheet1$.Sub category No" = 8 )

VNP_Facility_update_pnt(29‐35) "VNP_Facility_update_pnt.Id" = 2 AND( 
"Sheet1$.Sub_category_No" =  29 OR 
"Sheet1$.Sub_category_No" =  30 OR 
"Sheet1$.Sub_category_No" =  31 OR 
"Sheet1$.Sub_category_No" =  32 OR 
"Sheet1$.Sub_category_No" =  33 OR 
"Sheet1$.Sub_category_No" =  34 OR 
"Sheet1$.Sub_category_No" =  35 ) AND ( 
"Sheet1$.Condition" <> 'Removed' AND "Sheet1$.Condition" 

' ill b d' )VNP_Facility_update_pnt(9‐
13,18‐22)

"VNP_Facility_update_pnt.Id" = 2 AND( 
"Sheet1$.Sub_category_No" =  9 OR 
"Sheet1$.Sub_category_No" =  10 OR 
"Sheet1$.Sub_category_No" =  11 OR 
"Sheet1$.Sub_category_No" =  12 OR 
"Sheet1$.Sub_category_No" =  13 OR 
"Sheet1$.Sub_category_No" =  18 OR 
"Sheet1$.Sub_category_No" =  19 OR 
"Sheet1$.Sub_category_No" =  20 OR 
"Sheet1$.Sub_category_No" =  21 OR 
" h $ b " )VNP_Facility_update_pnt(28) VNP_Facility_update_pnt.Id =2 AND 
"Sheet1$.Sub_category_No" =  28 AND ( "Sheet1$.Condition" 
<> 'Removed' AND "Sheet1$.Condition" <> 'will be removed' )

VNP_Facility_update_pnt(16,17,2
4‐26)

VNP_Facility_update_pnt.Id =2 AND( 
"Sheet1$.Sub_category_No" =  16 OR 
"Sheet1$.Sub_category_No" =  17 OR 
"Sheet1$.Sub_category_No" =  25 OR 
"Sheet1$ Sub category No" = 26 )

VNP_Facility_update_lin(14,15,23
,27)

VNP_Facility_update_lin.Id =2

VNP_Facility_update_lin "Id" =1
VNP_Facility_update_png(6,7,9)

Image



Guide map

Varirata National Park Map

Map document
VarirataNP_guide map_update_1.0.mxd

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt(4,8(sub
set))

"VNP_update_Facility_pnt.Id" = 2 AND ( 
"Sheet1$.Sub_category_No" =  8 OR ( "Sheet1$.Facility_No" = 
 23 OR "Sheet1$.Facility_No" =  92 OR "Sheet1$.Facility_No" = 
 99 OR "Sheet1$.Facility_No" =  130 OR "Sheet1$.Facility_No" 
=  137 OR "Sheet1$.Facility_No" =  178 ))

VNP_Facility_update_pnt(30,31,3
4,35)

"VNP_Facility_update_pnt.Id" = 2 AND ( 
"Sheet1$.Sub_category_No" =  30 OR 
"Sheet1$.Sub_category_No" =  31 OR 
"Sheet1$.Sub_category_No" =  34 OR 
"Sheet1$ Sub category No" = 35 )

VNP_Facility_update_pnt(32) "VNP_Facility_update_pnt.Id" = 2 AND 
"Sheet1$.Sub_category_No" =  32  AND ( "Sheet1$.Condition" 
<> 'Removed' AND "Sheet1$.Condition" <> 'will be removed' )

VNP_Facility_update_pnt "Id" =1
VNP_Facility_update_lin "Id" =1
VNP_Facility_update_png(6,7,9)
Settlement_CEN onoff = 1

Image

Gare's Lookout Track

Map document
VarirataNP_guide map_gares lookout track_update_1.0.mxd

Circuit Track

Map document
VarirataNP_guide map_circuit track_update_1.0.mxd

Self Guide Track

Map document
VarirataNP_guide map_self guide track_update_1.0.mxd

Scarp Track

Map document
VarirataNP_guide map_scarp track_update_1.0.mxd



Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt(4,8(sub
set))

"VNP_update_Facility_pnt.Id" = 2 AND ( 
"Sheet1$.Sub_category_No" =  8 OR ( "Sheet1$.Facility_No" = 
 23 OR "Sheet1$.Facility_No" =  92 OR "Sheet1$.Facility_No" = 
 99 OR "Sheet1$.Facility_No" =  130 OR "Sheet1$.Facility_No" 
= 137 OR "Sheet1$ Facility No" = 178 ))

VNP_Facility_update_pnt(30,31,3
4,35)

"VNP_Facility_update_pnt.Id" = 2 AND ( 
"Sheet1$.Sub_category_No" =  30 OR 
"Sheet1$.Sub_category_No" =  31 OR 
"Sheet1$.Sub_category_No" =  34 OR 
"Sheet1$ Sub category No" = 35 )

VNP_Facility_update_pnt(32) "VNP_Facility_update_pnt.Id" = 2 AND 
"Sheet1$.Sub_category_No" =  32  AND ( "Sheet1$.Condition" 
<> 'Removed' AND "Sheet1$.Condition" <> 'will be removed' )

VNP_Facility_update_pnt "Id" =1
VNP_Facility_update_lin "Id" =1
VNP_Facility_update_png(6,7,9)
Settlement_CEN onoff = 1

Image



Main signboard

Varirata National Park Main Area

Map document
VarirataNP_Main Signboard_update_1.0.mxd

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt(4,8(sub
set))

"VNP_Facility_update_pnt.Id" = 2 AND ( 
"Sheet1$.Sub_category_No" =  8 OR ( 
"Sheet1$.Facility_No" =  23 OR "Sheet1$.Facility_No" =  92 
OR "Sheet1$.Facility_No" =  99 OR "Sheet1$.Facility_No" =  
130 OR "Sheet1$.Facility_No" =  137 OR 
"Sheet1$ Facility No" = 178 ))

VNP_Facility_update_pnt(30,31,3
4,35)

"VNP_Facility_update_pnt.Id" = 2 AND ( 
"Sheet1$.Sub_category_No" =  30 OR 
"Sheet1$.Sub_category_No" =  31 OR 
"Sheet1$.Sub_category_No" =  34 OR 
"Sheet1$ Sub category No" = 35 )

VNP_Facility_update_pnt(32) "VNP_Facility_update_pnt.Id" = 2 AND 
"Sheet1$.Sub_category_No" =  32  AND ( 
"Sheet1$.Condition" <> 'Removed' AND 
"Sheet1$ Condition" <> 'will be removed' )

VNP_Facility_update_pnt "Id" =1
VNP_Facility_update_lin "Id" =1
VNP_Facility_update_png(6,7,9)

Image



Base map

Land Use Map of Varirata National Park

Map document
VarirataNP_base_1.3.mxd

Rendered Layers Major Definition Query
Layer name Definition Query
VNP_Facility_update_pnt "Id" = 1 AND ( "facility" = 'Gate' OR "facility" = 'Lookout' )
VNP_Road "Id" = 1 OR "type" = 'Car road'

Image
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Introduction of Satellite Imagery
‐WorldView‐2 ‐ procured in the Project

Ayako OCHI
22 Apr 2016

The Project for
Biodiversity Conservation through Implementation of

the PNG Policy on Protected Areas 

Contents

• Introduction to satellite imagery procured
– Purpose of procurement of satellite imagery
– Image type, price, extent purchased
– Points of concern

• Introduction of WorldView‐2
– Features and Design specifications
– How to search imagery

• View of the imagery (Demo)
– Condition of imagery, comparison to other satellite 
imagery, image composition, and application

• Future plan



Introduction to Satellite Imagery Procured
Purpose of procurement of satellite imagery

High resolution satellite imagery enables you to…
• Get a grasp of environment (land use/cover) in area 
of interest,

• Figure out location and amount of environment 
elements more precisely by interpreting and 
analyzing imagery,

• Capture condition and location of mangroves and 
coral reef spatially, and

• Create more catching map, say use of imagery for 
base map.

Introduction to Satellite Imagery Procured
Image Type, Price, Extent Purchased

• Satellite image: WorldView‐2 (Archive, Orthoready, 
50‐60cm class) 

• Supplier: DigitalGlobe
• Price: 4,300 yen/km2 (about 110K/km2) + tax

– Got 40 % discount because of an agreement between KKC 
and supplier of DigitalGlobe product in Japan

• Target area
– Terrestrial areas: 494km2
– Marine / coastral areas: 223km2



Introduction to Satellite Imagery Procured
Terrestrial areas

Acquisition date: 24 Jul 2012,
1 Nov 2011,

and 29 Jan 2011

Introduction to Satellite Imagery Procured
Marine / coastral areas

Acquisition date: 25 Mar 2015,
25 Mar 2015,

and 11 Jun 2014



Introduction to Satellite Imagery Procured
Points of Concern

Introduction of WorldView‐2
Features and Design Specifications

• Launch Information
– Date: October 8, 2009
– Launch Site: Vandenberg Air Force Base, California

• Orbit
– Altitude: 770 km
– Period: 100 min.

• Mission Life: 10‐12 years
• Sensor Bands

– Panchromatic: 450 ‐ 800 nm
– 8 Multispectral:

• Coastal: 400 ‐ 450 nm  Red: 630 ‐690 nm
• Blue: 450 ‐ 510 nm  Red Edge: 705 ‐ 745 nm
• Green: 510 ‐ 580 nm  Near‐IR1: 770 ‐ 895 nm
• Yellow: 585 ‐ 625 nm  Near‐IR2: 860 ‐ 1040 nm

Altitude and slew time

The most spectral diversity commercially available
• 4 standard colors: blue, green, red, near‐IR1
• 4 new colors: coastal, yellow, red edge, and near‐IR2



Introduction of WorldView‐2
Features and Design Specifications

• Sensor Resolution
– Panchromatic: 0.46 m GSD at nadir, 0.52 m GSD at 20° off‐nadir
– Multispectral: 1.85 m GSD at nadir, 2.07 m GSD at 20° off‐nadir

• Swath Width: 16.4 km at nadir
• Retargeting Agility: Time to Slew 200 km: 10 sec
• Revisit Frequency (at 40°N Latitude):

– 1.1 days at 1 m GSD or less
– 3.7 days at 20° off‐nadir or less (0.52 m GSD)

• Capacity: 1 million km2 per day

* GSD: Ground Sample Distance

Very high resolution: 
Product: 50‐60cm class 

Introduction of WorldView‐2
How to Search imagery

https://browse.digitalglobe.com/imagefinder



Introduction of WorldView‐2
How to Search imagery

Introduction of WorldView‐2
How to Search imagery



View of the Imagery (Demo)

• Condition of imagery
• Comparison to other satellite imagery
• Image composition

View of the Imagery – Application



View of the Imagery
– Application

View of the Imagery – Application



View of the Imagery – Application

View of the Imagery – Application



View of the Imagery – Application

View of the Imagery – Application



View of the Imagery – Application

View of the Imagery – Application



View of the Imagery
– Application

Future Plan

• To share maps created in the folder below
– ¥¥JICA¥JICA_public¥Maps

• To create land use/cover map for terrestrial areas
• To update mangrove map
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Updating facility database
VNP facility management

July, 2016
CEPA‐JICA Project Prepared

Procedure of updating the database

• At the site
1. Check the condition of facility
2. Record on existing profile
3. Record photos which show condition such as, change, repair, replace 

conditions

• In the office
1. Collect photos of updated facilities
2. Resize photos in size of 1024 x 768 pixels and save in a specific holder
3. Add one page next to the existing sheet of profile
4. Fill necessary data



Updating activities at the site

• Case 1: repair, repaint, replace
• Record on hard copy paper of the previous sheet 
[Point]
• What parts were repaired?
• How?
• Current condition: size (measured record), condition (narratively record)  
• with sketch, memo

• Case 2: newly set up
• Fill out the full sheet

Example of records on hard copy paper of 
previous sheet

New photo No.

Sketch of structure
Including change 
by repair/ repaint/ 
update/ replace

Survey (monitoring) date



1. Collect photos of updated facilities & 
2. Resize photos in size of 1024 x 768 pixels and save in a specific holder

Original Photos 
Holder

P7220134.jpg
P7220135.jpg
P7220136.jpg
P7220137.jpg

….
….
….

Resized Photos 
Holder

P7220134.jpg
P7220135.jpg
P7220136.jpg
P7220137.jpg

….
….
….

Resize each 
photos into 1024 
x 768 pixels

Resized Photos 
Holder

Facility‐No.1
P7220134.jpg
P7220135.jpg

Facility‐No.2
P7220136.jpg
P7220137.jpg

….
….
….

Put photos into 
specific sub‐
holders of each 
facility

Add one page next to the existing sheet of 
profile

Copy original sheet 
to the next position

No.xx: No. of facility

170726: data of monitoring
Year+ month+ day

Facility Profile file



Fill necessary data (Important information)

Sketch of facility Pictures showing change (renew, repair, repaint,etc)

Monitoring “date” & Facility No.

Example of monitoring format (Excel file)

Monitoring
results

Crack on timber was filled and repainted.

New photos by monitoring
Photos shall show repair/ repaint/ replace conditions

Dimension: Length: __3m______, Width: __0.3m_______, Height: ___1.5m______

Condition shall be described here

New dimension shall be described here



Update list of facility
4 columns are added to 
record results and plan of 
monitoring.

Monitoring will be 
implemented twice a year

Results and date of 
updating
Date: year and month

Results of Monitoring Schedule of next 
Monitoring

Purpose of Updating list

• Recording history of each facility
• Specify not‐updated facilities (= update required facilities)
• Specify next timing of updating

This is management of facility



End of presentation

Thanks for listening!
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P

The Project for 
Biodiversity Conservation through Implementation of 
the PNG Policy on Protected Areas

Update of VNP facility database

‐Workflows ‐

VNP Facility management

CEPA‐JICA Project Prepared

October, 2018

Introduction

• The database of the facilities in Varirata National Park (VNP) was 
created by CEPA‐ JICA Biodiversity Project Team.

• The VNP facility database is composed of (1) a list and profiles of 
facilities in Excel format, (2) spatial data in GIS (shapefile) format, 
and (3) related maps for management.

• These database need to be updated in accordance with facility 
status on‐site such as removal, renovation and new construction for 
continuous facility management.

• This document illustrates overarching structure of the database and 
workflows and procedures of updating the database.

2



Contents

• Overarching structure
• Workflows and timeline
• Procedure: Field work
• Procedure: Update of Excel database
• Fundamental knowledge of ArcGIS database

– Construction of GIS facility data
– Relational database (RDB) of facility
– Join RDB to facility attribute table
– Definition Query of facility features

• Procedure: Update of ArcGIS database
• Procedure: Update of ArcGIS Map layout
• Data / Folder construction

3

Overarching structure

4

GIS

List

Profile

Map

Facility Database

+

List of Facility.xlsx

VNP‐Facility‐profile‐001‐020.xlsx
VNP‐Facility‐profile‐021‐040.xlsx
VNP‐Facility‐profile‐041‐060.xlsx
…

VNP_Facility_update_pnt.shp
VNP_Facility_update_lin.shp
VNP_Facility_update_png.shp
…

VarirataNP_facility.mxd
…
VarirataNP_facility.jpg
…

Excel database

ArcGIS database

ArcGIS map layout
& Exported map

• List of all the facilities and facility profiles of each 
facility

• Extensive facility information
• Database is updated as a result of field work

• GIS database of all the facilities
• Database includes other related data of the park
• Database is updated by using the “List of 

Facility.xlsx”

• Maps are created/updated for facility 
management and other materials, say guide map

• There are map layouts created ArcGIS and 
exported maps for use



Workflows and timeline

5

Map

• Update the map layout using the 
updated GIS database

• Export the updated map to use next 
field work, etc.

Update of map layout 
& export of map

GIS• Update the GIS database as a result of 
field work

Update of ArcGIS database

• Update the facility attribute table (relational database) 
by replacing the updated “List of Facility.xlsx”

 Never delete records even if they are removed on site
Recommended timeline:
• Record in the field and update 

of Excel DB throughout the year
• Update of the list of facility at 

least once a year
• Annually update of GIS 

database and Map

JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

Field Work

Excel DB

GIS DB

MAP

• Check facility 
condition on site

• Record on hard copy 
paper

Field work

List

Profile

+

Update of Excel database
• Fill necessary information in facility profile
• Update the list of facility

 Prepare new profile sheet to keep prior 
profile sheet

 Never change Facility No., which is key to link 
to GIS database

 Never delete records (lines of the list) even if they are 
removed on site, as Facility No. is unique id 

Procedure: Field work

1. Check the condition of facility
2. Record on existing profile on hard copy paper
3. Record photos which show condition such as, change, repair, 

replace conditions

 For more details, refer to “Updating facility database.pptx” 
prepared by the Project in July, 2016.

6



Procedure: Update of Excel database

Record of facility profile
1. Collect photos of updated facilities
2. Resize photos in size of 1024 x 768 pixels and save in a specific 

holder
3. Add one page next to the existing sheet of profile
4. Fill necessary data

Update of the list of facility
1. Update the list of facility in accordance with the facility profiles

 For more details, refer to “Updating facility database.pptx” 
prepared by the Project in July, 2016.

7

Never change Facility No. and delete facility records even if they are 
removed on site, as Facility No., unique id, is key to link to GIS database. 

Fundamental knowledge of ArcGIS database

• Construction of GIS facility data
• Relational database (RDB) of facility
• Join RDB to facility attribute table
• Definition Query of facility features

8



Construction of GIS facility data

• GIS facility data are composed of three data:
– Point data (VNP_Facility_update_pnt.shp),
– Line data (VNP_Facility_update_lin.shp), and
– Polygon data (VNP_Facility_update_pgn.shp).

Facility type of each data

Bridge Kitchen Track sign board
hand rail Lodge Traffic sign board
House Shower room Other Other
Kitchen Toilet
Shed Water tank Fence
Toilet Car parking facility Car parking area Gate
Water tank Shed Camp Facility Gate
BBQ set Water tank Car stop pile
Flag pole Water tap Fence
Information center Toilet Toilet Water supply facility Water pipe
Office Area sign boad
Other Distance pile House
Shelter/ hut Facility sign board Outlook
Tollgate Reference pile Picnic area
Workshop Road sign board

Sign

Station

Car parking facility

Point data Point data Point data

Line data

Polygon data

Camp Facility

Water supply facility

Sign Open area

Station

Traffic line

Rangers' facility

9

Construction of GIS facility data (Cont.)

• Fields of attribute tables of facility data
Field description:

FID
Shape

id

name
facility

no

area

These fields are added automatically, 
so you cannot edit them.

Temporary work fields

This field is facility number, unique 
id. The Excel database also has 
this number, so that the field is 
used to join tables.

Area (ha)

This field manages features.
“2”: usual facility data, 
“1”: facility data used for only some 
map (only display data), and 
“0”: data created through work process. 
“1” and “0” are not recorded in the 
Excel database. 

10

[id] and [no] fields are significant fields. 
You can not change these values without 
reason, since they affect map view. 



Relational database (RDB) of facility

• Excel database (List of facility.xlsx)

– The relational database of facility is created from the Excel database 
using columns which could be used in GIS. For example, 
[Sub_category_No] column is used to control which facilities are 
shown in a map and define symbol and color of each facility.

– [Facility_No] column is used to join the facility RDB to the attribute 
tables of facility data.

11

No use in GIS

Latest facility 
condition

Join RDB to facility attribute table

• Join Table
– The prepared facility RDB is joined to the attribute tables of facility.
– “Join Table” function lets you append additional information table 

(RDB) to the target feature’s attribute table so that you can use 
information of RDB when symbolizing the features, etc.

– A Key field, which both tables of GIS and Excel have in common, is 
used to join the tables.

Feature’s attribute table of facility Facility RDB

Join the tables 
using these fields

12



Definition Query of facility features

• Update of facility condition
– There are 6 designation values for facility condition column:

• (blank)
• Maintain
• New construction
• Renovated
• Removed
• will be removed

13

– On the maps for facility 
management, only “blank”, 
“Maintain”, “New 
construction” and 
“Renovated” are displayed.

Definition Query of facility features (Cont.)

• Definition Query
– “Definition Query” function defines data (features) to be displayed by 

using values of fields.

14

‐> Show features whose “Id” field is 2 and “Sub_category_No” field is 28 (toilet) only.



Procedure: Update of ArcGIS database

1. Create new facility features
2. Update the relational database of facility

15

Procedure: Update of ArcGIS database

1. Create new facility features
1. Copy location data (GPS data) of facility acquired in the field
2. Convert GPS data to GIS data (shapefile format)
3. Add new field for facility no. to converted data

• Field name: no
• Type: Short Integer

4. Record facility no. of each feature
5. Delete unneeded fields
6. Change name of existing facility data in the GIS database

• ex. VNP_Facility_pnt_bu20170321.shp

7. Merge the existing data (step 6) and the created data (step 1‐5) 
together, and save in the GIS database
• Name of new facility data should be that of original existing facility data 

(ex. VNP_Facility_update_pnt.shp).

16



2. Update the relational database of facility
1. Change name of the existing facility RDB

• ex. VNP_Facility_db_bu20170321.xls

2. Arrange the Excel databas, and save it in the GIS database
• Create a table with columns whose values could be used in GIS
• Name of new facility RDB should be the same name of the original existing 

facility RDB (VNP_Facility_db.xls).

Procedure: Update of ArcGIS database (cont.)
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Procedure: Update of ArcGIS map layout

1. Confirm if “Definition Query” and “Join Table” work correctly
2. Update the labels of the facility features if there are annotations 

in the maps
3. Export the Maps

18



Procedure : Update of ArcGIS map layout

1. Confirm if “Definition Query” and “Join Table” work correctly
1. Open the existing map documents related to the facilities in VNP
2. Check if facility layer setting for “Join Table” works correctly

• It is fine if the facility RDB is joined to the facility layers.

3. Check if facility layer setting for “Definition Query” works correctly
• It is fine if the only defined facility features render.

 If the RDB does not joined or the defined features are not rendered, 
check the process of creating the facility data.

19

Procedure : Update of ArcGIS map layout (cont.)

2. Update the labels of the facility features if there are annotations 
in the maps
 “Label” is automatically updated according to data update, but 

“annotation” need to be updated manually.
 “Label” is placed on a map by GIS so it cannot be edited manually. 

Conversely, “annotation” can be edited so it is created by converting 
label for sophisticated map.

1. Delete the existing annotations of the facilities
2. Label the features of the facilities
3. Convert the labels to annotations
4. Lay out the created annotations in place

20



Procedure : Update of ArcGIS map layout (cont.)

3. Export the Maps
1. Set layer on/off, legend, and title of the layout
 A number of maps would be exported from one map document.

2. Export the maps
• Normal settings:

– Resolution: 200 dpi   (1,200dpi for poster in A0 size) 
– Format: JPEG or PDF
– JPEG Quality: Max (100)

21

Data / Folder construction: Excel database

• List of facility
– List of Facility.xlsx (Result of VNP existing facility assessment in 2015) 
– List_Analysis_Facility_VNP_151214_No1‐254‐fin.xlsx (ditto)
– List of Facility_20180727.xlsx (as of 27th Jul 2018)

• Facility profiles
– VNP‐Facility‐profile‐001‐020.xlsx
– VNP‐Facility‐profile‐021‐040.xlsx
– VNP‐Facility‐profile‐041‐060.xlsx
– …

• Manual
– Updating facility database.pptx

22



Data / Folder construction: GIS database

• Facility data / relational database
– Data folder: GISDB¥31_VarirataNP¥data
– Point facility data: VNP_Facility_update_pnt.shp
– Line facility data: VNP_Facility_update_lin.shp
– Polygon facility data: VNP_Facility_update_pgn.shp
– Facility relational database: VNP_Facility_db.xls

• Map document (layout)
– Data folder: GISDB¥81_MapLayout¥VarirataNP

• Exported map
– Data folder: GISDB¥82_Maps¥VarirataNP

• Documents (manual)
– Data folder: GISDB¥91_Documents¥VN Facility Management
 Refer to “Map for VNP Facility Management.xlsx” for more detailed 

information of map setting

23



 
 
 
 
 
 
 
 
 

添付資料 4.1.6 Manual on Getting location information 



P

The Project for
Biodiversity Conservation through Implementation of
the PNG Policy on Protected Areas

Manual on
Getting location information
(Importing GPS data to GIS)

Facility management

CEPA JICA Project Prepared

February, 2018

Introduction

• You would be required to get location information of
features to create GIS data for managing National Parks,
say:
– Updating the VNP facility database for new facilities,
– Getting location where animals or plants are found,
– Confirming location where an unexpected event happens, etc.

• This document shows general procedure on creating GIS
data from GPS data of features/events which you get in
the field.

2



Procedure of importing GPS data to GIS

1. Get locations of features/events by GPS.
2. Import GPS data into GIS.
3. Arrange the imported data. (Option)

3

Procedure 1: Get locations of features/events by GPS

1. Set out GPS.
1. Turn on the power of GPS.
2. Confirm that battery charge is enough. If not, charge up.
3. Navigate to [Setup] > [Position Format] on the screen to

confirm GCS (Geographic Coordinate System) of [Map Datum]
and [Map Spheroid] isWGS 84.

2. Get location of a feature or an event in the field by pushing [Mark
Waypoint] button and then [Save].

See not to block to getting satellites by your body.

3. Turn the power off when completing getting required data.

4



Procedure 2: Import GPS data into GIS

1. Start PC, and connect the GPS to the PC.
2. Navigate to the GPS folder >Garmin/GPX, and copy

Waypoints_xxxx.gpx file in your folder (or designated
work folder).

3. Open ArcMap.
4. From ArcToolbox, double click

[GPX To Features] under
Conversion Tools.

5

Procedure 2: Import GPS data into GIS (Cont.)

5. In [GPX To Features] window, appoint
Waypoints_xxxx.gpx file in [Input GPS File], and name
folder and output file in [Output Feature class].

6. Click OK.
GPS data will be converted to
GIS data.
The converted data are
automatically imported in
ArcMap.
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Procedure 2: Import GPS data into GIS (Cont.)

7. Confirm the imported data in ArcMap.

7

Procedure 3: Arrange the imported data (Option)

1. Open table of the imported
(created) layer by right
clicking on the layer, and
select [Open Attribute Table].

8



Procedure 3: Arrange the imported data (Cont.)

2. Delete unneeded fields (columns) by right clicking on
the filed and select
[Delete Field].

3. Repeat step 2 until all
unneeded fields are
deleted.

9

Procedure 3: Arrange the imported data (Cont.)

4. Change name of each record (row).
1. On Editor tool bar, click [Editor] and select [Start Editing] to

edit table of the layer.

You can see that colour of
fields become white when edit
session starts. That means you
can edit records in the table.

2. Rename each record
appropriate one.
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Procedure 3: Arrange the imported data (Cont.)

4. Change name of each record (row). (Cont.)
3. After you finish step 2, click [Editor] and select [Save Edits] to

save your changes.
4. Then, click [Editor] again and select [Stop Editing] to stop edit

session.
Now, edit session is finished.

5. Save the created data in the appropriate folder.

You can compare the created data with other data by adding
interested data in the ArcMap if you like.
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添付資料 4.1.7 ENVI manual 



GETTTING STARTED
WITH ENVI 5.2

ENVI combines image processing and geospatial technology to help you extract
meaningful information from all kinds of data and make better decisions. This
document is introductory manual to operate ENVI 5.2 for your work.



Menu bar Basic functions for tools related to file, edit and display, window 
view such as split window, and imagery. 

Tool bar Operation tools for imagery displayed. 

Menu bar Tool bar

Layer Manager 

Toolbox

Process bar Display Cursor Value

Overview

Image window view



Layer Manager Manage the images displayed on image window view. 

Click the check box to the left of the layer to turn the layer 
on/off. You can access sub-menu for the layer to right-click on 
the layer. 

Oveview Display overview of the layer to click the check box to the left 
of [Overview] in the Layer Manager. 

Toolbox Storage of ENVI analysis tools in categories. 

Type keyword in [Search the toolbox] to display corresponding 
tools.  

Display Cursor Value Display information as you hover the cursor over either the 
Overview or the current Image window view. 

Process bar Process bar displays the process name and status for the oldest 
running process, along with an option to cancel the process 

(click the Cancel Process button). When all processes 
finish, this segment becomes blank. 

As one or more processes are running, click the Process 
Description button to display a window that shows the 
name and status of each process, and the name of the input 
raster images. 

File > Open As

File > Open As >WorldView-2

Show panel

Detach



Display > Cursor Value

Cursor Value

Crosshairs

Crosshairs

Rotate View Rotate the display in the current Image window view. 

Place the cursor in the Image window view and do one of 
the following: 

Click and drag the cursor to rotate clockwise or 
counter clockwise. 

Press an arrow key to rotate 5 degrees clockwise 
(down/right arrows) or counter clockwise (up/left 
arrows). 

Press and hold the Ctrl key, then press an arrow 
key to rotate 1 degree clockwise (down/right 
arrows) or counter clockwise (up/left arrows). 

Press and hold the Shift key, then press an arrow 
key to rotate 45 degrees clockwise (down/right 
arrows) or counter clockwise (up/left arrows). 

Rotate Up Rotate the display in the current Image window view so 
that objects (especially buildings) are oriented vertically 
with your monitor. If the image contains rational 
polynomial coefficient (RPC) information, ENVI uses that 
to compute the rotation angle. If the image does not 
contain RPC information, or if it uses a standard 
projection, ENVI rotates the display to 0 degrees. 

North Up Rotate the display in the current Image window view so 
that North is at the top of the Image window view. This 
option is only available for georeferenced images. 

Rotate To Select a fixed rotation angle (expressed in degrees) for 
the display in the current Image window view. Or, type 
your own degree of rotation and press Enter on your 
keyboard. This drop-down list interactively reports the 
current degree of rotation of the display when you use 
any rotation tool. 

The following options are available from the Rotate To
drop-down list (in degrees): 0, 90, 180, and -90.

Zoom Zoom in on the display. Do one of the following: 

Click and drag over an area to draw a rubber-
band box and zoom in on that area. 

Click once in the display to center the display on 
that location and zoom in by a fixed percentage. 

To exit this tool, click the Select button. 



Fixed Zoom 
In

Click this button to zoom into the center of the display 
by a fixed percentage. The default is 1.25x, which can 
be set using the Zoom Factor preference. 

Fixed Zoom 
Out 

Click this button to zoom out from the center of the 
display by a fixed percentage. The default is 1.25x, 
which can be set using the Zoom Factor preference. 

Zoom to Full 
Extent 

Click this button to zoom the full extent of the data 
layer. 

Zoom To Select a fixed zoom percentage for the display in the 
current Image window view. Or, type your own 
percentage of zoom and press Enter on your 
keyboard. 

Shift
Ctrl

Go To
Crosshairs

Go To
Go To

Enter

Go To

Lat,Lon Enter the values in decimal degrees format or in degrees, minutes, 
seconds format. 

Decimal degrees format examples: 

40.004036,105.219047
40.004036N,105.219047W 
40.0481N, 105.3420W  

Degrees, minutes, seconds examples: 

40 0 14.53,105 13 8.57 
40 0 14.53N,105 13 8.57W 
40 0'34.34"N, 105 13'46.20"W 

DataX, DataY Enter the value as x,y points and append an asterisk (*) to one of 
the values to indicate it is a data coordinate.  

Data x,y format examples: 

181.1*, 91.1 
169*, 79 
29*, 45 

MapX,MapY Enter the value as x,y points in a map coordinate. 

Map x,y format examples: 

481168,4426792 
481872.8250, 4427702.4750 
482970.42, 4427702.47 

Mensuration

Page Up
Page Down

Home End

Reset



Undo Redo Edit > Undo action Edit > Redo action

Brightness Darken or brighten the display of the selected 
image. The valid range is 0 (dark) to 100 
(bright). To return to the default value of 50, 
click the Reset Brightness button. 

Contrast Adjust the contrast of the selected image. The 
valid range for this slider is 0 (low contrast) to 
100 (high contrast). When you adjust the 
contrast, the selection in the Stretch Types
drop-down list automatically changes to 
Custom. To return to the default contrast value 
of 20, click the Reset Contrast button.  

Sharpen Blur or sharpen the display of the selected 
image. The valid range for this slider is 0 
(blurry) to 100 (sharp). To return to the default 
value of 10, click the Reset Sharpen button.  

Transparency Make your image or vector layer more opaque 
or transparent. The valid range for this slider is 
0 (opaque) to 100 (transparent). To return to 
the default value of 0, click the Reset 
Transparency button. 

Default Stretch

Stretch Types

Contrast
Custom

Stretch on View Extent

Update Stretch

Stretch to Full Extent

No stretch
Linear, Linear 1%, Linear 2%, Linear 5%

Custom Stretch
Equalization
Gaussian

Custom Stretch
Square Root

Logarithmic

Optimized Linear

Custom

Reset Stretch Type

Custom Stretch
Stretch Types



Custom Stretch Display > Custom Stretch
Custom Stretch Types

Brightness Contrast

Red Green Blue

Enter
Linear Gaussian

Linear Linear (Percent Value)
Enter
Gaussian Gaussian

Gaussian (Standard Deviation)
Enter

Reset Dialog

Ctrl+C
Ctrl+V

File > Preference

Default Input 
Directory 

The directory for input images. ENVI uses this directory unless 
you specify another path when opening a file. 

Output Directory The directory for output files. ENVI writes output files to this 
directory unless you specify another path when entering an 
output filename. 



Temporary 
Directory 

The directory used to store ENVI temporary files. 

Auxiliary File 
Directory 

The directory for auxiliary files such as header files (.hdr), 
pyramid files (.enp), and vector auxiliary files.  

This directory contains auxiliary files associated with data from 
read-only devices such as a CDs or folders with no write 
permissions. 

Remember Input/Output Directories Yes
Input Directory

Output Directory
No Input Directory Output Directory

File > Open
Open
File > Open As

Remove

File > Close All

File > Close All

Stretch types



Display > Custom Stretch Data manager

File > Data Manager
Open

Data Manager

Close Close All
File

> Close All

Pin

Remove

File > Data Manager

Load Grayscale

[RedEdge] is added in the Layer Manager.



[Change Color Table] [Raster Color Slices]

You will assign false color to grayscale [RedEdge] by use of Change Color Table.

Change Color
Table > Rainbow

The image are displayed by use of the color table you selected.

Change Color Table > More

In the Change Color Table dialog, you can select other color table in the pull down list and change color line in
the right color area.

Rainbow



Visible 
bands 

Blue Mapping coastal water areas 
Differentiating between soil and vegetation 
Forest types mapping 
Cultural features 

0.45-0.52 

Green Healthy vegetation 
Cultural features 

0.52-0.60 

Red –Discriminating different plant species 
–Soil boundaries 
–Geological boundaries 
–Cultural features 

0.63-0.69 

Reflective 
infrared 
bands 

Near
Infrared 

Vegetation biomass 
Crop identification 
Soil/crop and land/water contrasts 

0.76-0.90 

Mid-
Infrared 

Moisture content of plants 
Crop drought studies 
Plant health analyses 
Discriminating between clouds, snow and ice 
Geologic rock type and soil boundaries 
Soil and vegetation moisture content 

1.55-1.74 

2.08-2.35 

Thermal 
bands 

Heat intensity 
Insecticide applications 
Thermal pollution 
Geothermal activity 

10.04-12.35 

True color Show like a color 
photograph 

Red Green Blue 3:2:1 5:3:2 

False color Similar to and infrared 
photograph 
Vegetation appears in red 
Water appears navy or 

black 

NIR Red Green 4:3:2 7:5:3 

Natural 
color 

Vegetation appears 
brilliant green 

Red NIR Green 3:4:2 5:7:3 

LANDSAT 4-5 TM



LANDSAT 7 ETM+

LANDSAT 8 OLI, TIRS

WorldView-2

Band Selections
Load

Data
Load True Color

Load CIR

Load Grayscale
Load Default

Load Default Auto Display Method For
Multispectral Files

File > Data Manager

Load Data



Portal

Transparency bar

Close Portal



Views > Create New View

A new window is shown.

View

Load Grayscale

Views > Link Views

Link All OK



Remove

Remove View.

There are data in the Data Manager. To close unnecessary file, right click the appropriate file in the Data
Manager, and select Close File. Radiometric Calibration

File > Open

ALOS AVNIR-2 and 
PRISM Level-1B2 data 

* *  HDR*.txt 

GeoEye-1 * *  .til 

IKONOS * *  metadata.txt 

Landsat TM, ETM+, 
and Landsat-8 
OLI/TIRS data 

* * * *_MTL.txt, *WO.txt, 
*.met

QuickBird * *  .til 

RapidEye Level-1B * * *_metadata.xml 

A NITF/NSIF license is 
required to open these 
files.

SPOT DIMAP * * METADATA.DIM 

WorldView * *  .til 

Radiometric Correction > Radiometric Calibration



OK

Calibration Type

Radiance:

Reflectance:
and

Brightness Temperature:

Output Interleave

BSQ
BIL
BIP

Output Data Type

Float
Double
Unit

Scale Factor

Apply FLAASH Settings

Display Result

OK

Radiometric Correction > Radiometric Calibration



Spatial Subset

The Radiometric Calibration dialog opens. Parameters needed for calibration are automatically imported.



Display > Profiles > Spectral

Dark Subtraction

Radiometric Correction > Dark Subtraction

OK

Subtraction Method

OK

File Memory

OK

Select Band Minimum Subtraction

Band Minimum
OK

Select Region of Interest Subtraction

Region of Interest

OK

Select User Value Subtraction

User Value
Current Subtraction Values

Edit Selected Item Enter

OK

Radiometric Correction > Dark Subtraction



Band
Minimum

You will check the difference between [koiari_ref.dat], pre processed image, and [koiari_dark.dat], processed
image.

Options > Additional Profiles > Add File

Reflectance spectrum of grassland is added on the one of forest.



Scatter Plot Tool
Display > 2D Scatter Plot

Full Band

File > Select New Band > X-Axis Y-Axis

OK

Display > 2D Scatter Plot

Display > 2D Scatter Plot

Add Class



File > Export All Classes to ROIs

Codicil:

After executing processing above, you can classify the image being based on the ROI by executing Supervised
Classification in the Toolbox.

In the Classification workflow, ROI for training data is available in shapefile format. Therefore ROI should be
converted to shapefile. Click Region of Interest (ROI) Tool from the toolbar to open, select File > Export >
Export to Shapefile.

Band Math

Band Algebra > Band Math

Enter an expression

Previous Band Math Expressions

Enter an expression OK



Save
OK

Restore
OK

Clear Previous Band Math Expressions

Delete Previous Band Math Expressions

Add to List Previous Band Math Expressions
Enter an expression Add to List

Enter an expression OK

Enter an expression

Variables used in expression
B1 - [undefined]

Available Bands List

Variables used in expression

Map Variable to Input File

OK

File Memory

OK

Band Math is one of the main processing of remote sensing imagery. Arithmetic processing such as sum,
difference, product, and quotient is executed for multiple bands. Operands are DN values located in the same
(x,y) pixel between the bands.

In this exercise, you will calculate NDVI (Normalized Difference Vegetation Index) by the use of the Band Math,
using the following equation:

NDVI = (Near Infrared – Red) / (Near Infrared + Red)

Band Math Band Math

Enter and expression

Variable to Bands Pairings dialog appears. Bands will be assigned to variables, B5 and B7.

Variable used in expression

Variable used in expression

Output Result to



After the processing, [koiari_ndvi.dat] image will be added in the Layer Manager.

Display > Cursor Value

Cursor Value

Although there are several vegetation indices, one of the most widely used is the NDVI. NDVI values range from
+1.0 to 1.0. Areas of barren rock, sand, or snow usually show very low NFVI values (for example, 0.1 or less).
Sparse vegetation such as shrubs and grasslands or crop lands may result in moderate NDVI values
(approximately 0.2 to 0.5). High NDVI values (approximately 0.6 to 0.9) correspond to dense vegetation such
as that found in temperate and tropical forests or crops at their peak growth stage.

Codicil:

Through you calculate NDVI manually by using the Band Math tool for basic processing exercise in this
processing, you can do it easily by using NDVI tool prepared under Spectral > Vegetation folder in the
Toolbox.

Classification References:



Mahalanobis, Maximum Likelihood, Minimum Distance:

J.A.Richards, 1999, Remote Sensing Digital Image Analysis, Springer Verlag, Berlin, p. 240.

Spectral Angle Mapper:

Kruse, F. A., A. B. Lefkoff, J. B. Boardman, K. B. Heidebrecht, A. T. Shapiro, P. J. Barloon, and A. F. H.
Goetz, 1993, "The Spectral Image Processing System (SIPS) Interactive Visualization and Analysis of
Imaging spectrometer Data." Remote Sensing of Environment, v. 44, p. 145 163.

ISODATA:

Tou, J. T. and R. C. Gonzalez, 1974. Pattern Recognition Principles, Addison Wesley Publishing
Company, Reading, Massachusetts.

Browse

Next

Next

No Training Data:

Use Training Data:

Supervised Classification Settings

Maximum Likelihood:

MinimumDistance:

Mahalanobis Distance:

Spectral Angle Mapper: n

n



Preview

Next

Training Data Enter

Maximum Likelihood

Set Probability Threshold

None:
Single Value Multiple Values Probability Threshold

Single Value Multiple Values

Minimum Distance

Set Standard Deviations fromMean Set Maximum Distance Error

Set Standard Deviations fromMean

None:
Single Value Multiple Values

Single Value Multiple Values
Standard Deviations fromMean

Set Maximum Distance Error

None:

Single Value Multiple Values Distance Error
Single Value Multiple Values

None

Mahalanobis Distance

Set Maximum Distance Error:

None:
Single Value Multiple Values Distance Error

Single Value Multiple Values

Spectral Angle Mapper

Set Maximum Spectral Angle:

None:
Single Value Multiple Values Spectral
Angle Single Value Multiple
Values

Compute Rule Images

Compute Rule Images



Maximum Likelihood

i i
x n n
p i

i

i

mi

Minimum Distance

D
i i
x n n
mi

Mahalanobis Distance

D
i i
x n n

i

mi

Spectral Angle Mapper

x n n
mi

Load Previously Defined Training Data

Load Training Data Set

Interactively Define Training Data

Use Training Data Symbol Annotation Polygon Annotation Rectangle
Annotation Ellipse Annotation

Symbol
Annotation

Training Data



Delete Class

Delete Class Select
Delete

Add Class Add Class

Delete Class
Delete Class

Save Training Data Set
Note:

Edit Class Properties

Class Name:
Class Color:
Fill Interior: Solid None

Tip:

Enable Smoothing:
Enable Aggregation:

Smooth Kernel Size

3
Aggregate Minimum Size

9

Preview

Next

Export Classification Image
Export Classification Vectors

Note:

Export Classification Statistics

Export Rule Images
Compute Rule Images

Finish

In this exercise, you will implement supervised classification.

ClassificationWorkflow

File Selection Browse Next File
Selection



Classification Type Use Training Data Next

You will create training data by using polygon in the Define Training Data dialog. You will take out training
data for forest, grassland, bare land, water, cloud, and shadow.

Polygon Annotation

Polygon Annotation Accept

Select Clear
Delete

Select

Select

Add Class

Smooth Kernel Size Aggregate Minimum Size





The classification results were exported to vector file and raster file in the last exercise. You will verify each
result.

View/Edit Attributes

The Attribute Viewer appears. You can confirm class and area of each classified polygon.

Next, you will compare raster data.

Portal

You will confirm statistics using the raster classification result.

Class Statistics

Classification Input File



Statistics Input File

Class Selection

Compute Statistics Parameters



In this exercise, you will learn how to save an image. You will save the classification result in TIFF format.

File > Save As > Save As… (ENVI, NITF, TIFF, DTED)

File Selection

Save File As Parameters

Codicil:

There are several save menus in the Save Asmenu bar.



Satellite Imagery Procured in CEPA-JICA Biodiversity Project

WorldView-2 (Archive / Ortho Ready Standard / 50, 60 cm)  

Area of interest in Papua New Guinea 

site_buf_simple_01_dd (054763411020_01) 492 km2 

site_buf_simple_02_dd (054763411010_01) 233km2 





Help > Contents

ENVI Runtime for Windows 

ENVI Runtime 5.2 for Windows Floating License 1 

ENVI5.2 for Windows Feature Extraction Module 1 



 
 
 
 
 
 
 
 
 

添付資料 4.1.8 GIS Data Management 



P

The Project for
Biodiversity Conservation through Implementation of
the PNG Policy on Protected Areas

GIS Data Management

Transfer the data created in the Project to CEPA

for the sustainable use of the data

CEPA JICA Project Prepared

February, 2020

Introduction

• The CEPA JICA Biodiversity Project will terminate in July 2020.

• In the Project, various GIS data and maps have been collected and
created through the activities to strengthen Varirata National Park
(VNP) management and to establish Marine Protected Area (MPA).

• It is desirable for CEPA to utilize the data and maps after the Project
terminates.

2

Objectives

• To ensure the sustainability of the data created in the Project into
the future, it is planned to:

i. let CEPA staff concerned with Protected Area know the
contents of GIS data and maps,

ii. let IT/GIS/DB staff know GIS data formation,

iii. discuss possibility of utilization of the data and maps after the
Project,

iv. share and discuss method of updating facility data in VNP for
the future Park management, and

v. discuss how to manage / store the data in the CEPA server.

3

Contents / Schedule

4

Section Date / Time Title Target person

1 4 Feb 2020
9:30 (1.5 hours)

Introduction of the data / maps to be
shared (technical)

GIS/DB/IT officers

2 4 Feb 2020
11:00 (30 min)

Discussing how to store the data in the
CEPA server

GIS/DB/IT officers

3 5 Feb 2020
9:30 (30 min)

Introduction of the data / maps to be
shared (for Protected Area
management officers)

PA management
officers

4 5 Feb 2020
10:00 (2 hours)

Technical transfer and discussion of
GIS data management / update for the
future VNP management

GIS/DB officers,
VNP management
officers

5 5 Feb 2020
12:00 (30 min)

Discussion on possibility of utilization
of the data and maps after the Project

PA management
officers,
GIS/DB officers

* GIS data server should be set up until January 2020.



1. Introduction of the data / maps to be shared

5Section 1

Introduction and Objectives

• In this section, the items below will be introduced.
– the data purchased, collected and created in the Project
– basic information of satellite imagery purchased and collected
– basic information of Global Forest Change (GFC) data and how to get and

process the data
– the maps created
– formation of files and folders which the data and maps are stored

• GIS data manager and operator will get grasp of the data and maps
prepared in the Project to manage them for the future.

• GIS data manager and operator will get basic knowledge of satellite
imagery and GFC data.

• Project GIS database and maps including GIS DB list and the related
documents will be shared.

6Section 1

Contents

• CEPA JICA Project GIS Database
• Data / Folder construction
• Main data in the Project DB

– Introduction of main data in the Project DB
– Basic information of optical satellite images collected in the Project
– Basic knowledge of SAR image
– Introduction of Global Forest Change data and how to process the data

• Main maps created in the Project

7Section 1

CEPA JICA Project GIS Database

• GIS Database and GIS Detabase List (to be shared after the Project)
• Data shared by CEPA / Data created in the Project
• File format: shapefile (vector)

8Section 1



Data / Folder construction

• Main folder description

9Section 1

Section 1

Data / Folder construction

• Sub folder (GIS Database List)

10

1: Prepared by the Project

Main data in the Project DB

• Main data
– 01_Satellite

• LANDSAT: for Project area/ downloaded about every 5 years/ unprocessed

• WorldView2: for Project area/ purchased in the Project/ high resolution (for more
detail, refer to other PPT document)

• RapidEye2010: for entire PNG/ from PNGFA

• PALSAR: for entire PNG/ from PNGFA/ ALOS PALSAR imagery

• IndexMap_Satellite.mxd: index map of satellite imagery

– 02_DEM
• ALOS DEM: for Project area

• ASTER GDEM: for Project area

• SRTM DEM (90m): for entire PNG

• SRTM DEM (30m): for entire PNG

– 11_TopoAnalyst (surface, hillshade, slope, contour)
• ASTER: for Project area

• SRTM: for entire PNG

11Section 1

Main data in the Project DB

• Main data
– 21_Boundary

• Project area, etc.

– 22_Census: PNG Census 2011 (NSO)
– 23_ForestMap: Forest Base Map 2012 (PNGFA): for CEN, NCD

* PNGFA revised Forest Base Map 2012, and also created Forest Cover Map 2015.

– 31_VarirataNP
• VNP boundary

• Land use map of Project area

• Facilities in VNP

• Camera traps in VNP

• MAB zoning map of Project area

• Biological survey data implemented in the Project in 2017

12Section 1



Main data in the Project DB

• Main data
– 32_MarineNP

• Mangrove map of Project area

• Reef map of Project area

• Depth line

• Zoning map of MPA (Motupore island, UPNG land, CPC land, and Tahira farm)

• Proposed National Marine Sanctuary

• Management zone of National Marine Sanctuary

• A variety of features such as jetty, resort, habitat areas, cultural/historical areas

– 51_Hansen: Global Forest Change data by Hansen et al.
• Forest cover

• Loss

• Gain

• Lossyear

13Section 1

Main data in the Project DB

• Main data
– 81_MapLayout: folder for Map documents (mxd)
– 82_Maps: folder for maps (jpg, pdf): maps exported from the Map documents

– 91_Documents: folder for non spatial data
• GIS database list
• Manuals and related documents

– Updating facility database (July 2016, by Mr Imai)
– Update of VNP facility database (October 2018)
– Manual on Getting location information (Importing GPS data to GIS)
(February 2018)

– ENVI manual (4 April 2017)
• Presentation documents

– Introduction of Satellite Imagery WorldView 2 (22 April 2016)
– GIS Data Management (February 2020)

14Section 1

Main data in the Project DB

• LANDSAT
– Launch date:

• LandLandsat 1, 2, 3: 1972

• Landsat 4, 5: 1982

• Landsat 7: 1999

• Landsat 8: 2013

• Landsat 9: 2020 (plan)

– Operation status: under operation
– Supplier: USGS/NASA
– Global revisit time: 16 – 18 day
– Swath width: 185 km

– Reference: https://directory.eoportal.org/web/eoportal/satellite missions/l/landsat 8 ldcm

15

For your reference

Image credit: NASA, OSC

No. Bands Wavelength range (nm) GSD

1 New Deep Blue 433 – 453 30 m

2 Blue 450 – 515 30 m

3 Green 525 – 600

4 Red 630 – 680

5 NIR 845 – 885

6 SWIR 2 1560 – 1660

7 SWIR 3 2100 – 2300

8 PAN 500 – 680 15 m

9 SWIR 1360 – 1390 30 m

10 TIRS 1 10.6 – 11.19 μm 100 m

11 TIRS 2 11.5 – 12.51 μm

Bands & GSD (Landsat 8)

Section 1

Main data in the Project DB

• RapidEye
– Launch date: 29 August 2008
– No of satellite: 5
– Operation status: under operation for all 5 satellites
– Supplier: DigitalGlobe
– Global revisit time: 1 day
– Swath width: 77 km
– GSD at nadir: 6.5 m (Ortho: 5 m)
– Bands: 5 (400 – 850 nm)

• Blue ... 440 – 510 nm

• Green ... 520 – 590 nm

• Red ... 630 680 nm

• Red edge ... 690 – 730 nm

• Near infrared ... 760 – 850 nm

– Reference: https://directory.eoportal.org/web/eoportal/satellite missions/r/rapideye
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For your reference

Image copyright: BlackBridge

Section 1



Main data in the Project DB

• WorldView 2
– Launch date: Oct 2009 (WorldView 2)

• WorldView 1: Sep 2007

• WorldView 3: Aug 2014

• WorldView 4: Nov 2016

– Operation status: under operation
– Supplier: DigitalGlobe
– Global revisit time:

• 1.1 days at 1 m GSD

• 3.7 days at 20 off nadir or less (0.52 m GSD)

– Swath width: 16.4 km at nadir
– GSD at nadir:

• 0.46 m (panchromatic)

• 1.85 m (multispectral)

– Reference: https://directory.eoportal.org/web/eoportal/satellite missions/v w x y
z/worldview 2

17

For your reference

* For more details, refer to the presentation: Introduction of Satellite Imagery WorldView 2 (22 April 2016)

Image credit: Digital Globe

Bands Wavelength range (nm)

Panchromatic 400 – 800

8
multispectral

Coastal 400 – 450

Blue 450 – 510

Green 510 – 580

Yellow 585 – 625

Red 630 – 690

Red Edge 705 – 745

Near IR1 770 – 895

Near IR2 860 – 1040

Bands

Section 1

Main data in the Project DB

• ALOS/PALSAR (Phased Array type L band Synthetic Aperture
Radar)
– Launch date: 24 January 2006
– Operation status: Termination on 22 April 2011

• ALOS 2 was launched in 2014.

• ALOS 3 and ALOS 4 are planned in 2020.

– Supplier: JAXA
– Global revisit time: 46 days
– Swath width: 70 km (High resolution mode)
– GSD at nadir: 10 m (High resolution mode)
– Center frequency: 1270 MHz (L band)
– Polarization: HH or VV / HH + HV or VV + VH

– Reference: https://directory.eoportal.org/web/eoportal/satellite missions/a/alos
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For your reference

Image credit: JAXA

Section 1

Main data in the Project DB

• What is SAR Features and points to keep in mind –
SAR Basic Principle
– SAR (Synthetic Aperture Radar)
– Active sensor, provides its own source of electromagnetic energy, emits

radiation in the direction of the target to be investigated, and then detects
and measures the radiation that is backscattered from the target

– The advantages of day night operability, cloud penetration, and the ability to
calibrate without performing atmospheric corrections
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For your reference

SAR Antenna

Ground Targets

Incident
Radar Pulse

Backscattered
Radar Pulse

Wavelength
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Microwave

UV

Visible

Near
Infrared

Thermal infraredMid
Infrared

Atmospheric transmission
is almost 100%.

Cloud particles
(radius 10 m)

Rain particles
(radius 1mm)

Less susceptible to
clouds and rain

Section 1

Main data in the Project DB

• What is SAR images Features and points to keep in mind –
Differences between SAR and optical images
– A Single polarization SAR image is amonochrome image that shows the

reflection intensity of microwaves, and it is difficult to intuitively determine
the ground covering condition (difference between bare land and vegetation,
etc.) compared to an optical image.

– Since the SAR image is photographed obliquely downward, the image looks
like a bird’s eye view, which has the characteristics image distortion and
layover.
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For your reference

Adapted from research material
by National Institute for Land and
Infrastructure Management

Section 1

Optical SAR



Main data in the Project DB

• What is SAR images Features and points to keep in mind –
Difference in wavelength (band)
– Electromagnetic wave is divided into separate bands by wavelength, and

called the table below.
– Currently operating SAR satellites mainly use L, C, and X bands.
– Longer wavelength electromagnetic waves can easily penetrate trees.

21

For your reference

Bands Wavelength (nm)

Ka 7.5 – 11

K 11 – 16.7

Ku 16.7 – 24

X 24 – 37.5

C 37.5 – 75

S 75 – 150

L 150 – 300

P 300 1000

X band

C band

L band
Reflection off leaves

Reflection off branches

Reflection off tree
trunk and ground

Section 1

Main data in the Project DB

• What is SAR images Features and points to keep in mind –
Polarization
– Polarization describes the relationship between the amplitude and the

direction of a time varying electric field oscillation.
– It divided into horizontal polarization (H) and vertical polarization (V) by the

direction of electric field, and describes HH, HV, VH, or VV depending on the
combination of transmitting and receiving (1st character: transmitting, 2nd
character: receiving).

22

For your reference

Vertical polarization (V)

Horizontal polarization (H)

Electric field

Magnetic field

– Strength of backscattering refers to
the strength at which microwaves
emitted from the SAR satellites
antenna are scattered by the
target object and return toward
the antenna.

Section 1

Main data in the Project DB

• What is SAR images Features and points to keep in mind –
Microwave scattering
– Scattering from the object is surface scattering. Microwaves are scattered at

the interface between media.
– The scattering is stronger as permittivity of the medium is larger.

Backscattering increases as surface roughness increases (left hand figure).
– Double scattering also occurs due to artificial structures (building, etc.) (right

hand figure).
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Incident wave

Scattered wave

Section 1

Main data in the Project DB

• What is SAR images Features and points to keep in mind –
Characteristic phenomena of SAR images

24

For your reference

ForeshorteningLayover

Radar shadow
Cast a shadow

Foreslope is “reversed”
@building walls and steep slopes

Off nadir angle

Position on image

Ground
surface

SAR satellite

Angle of
incidence

Mountains seem to “lean”
towards the sensor
@tall buildings and mountains

No information
No information

Section 1



Main data in the Project DB

• What is SAR images Features and points to keep in mind –
Characteristic phenomena of SAR images
– In a steep mountainous area, there are terrain and features that are difficult

to see depending on the position, shape, direction, and gradient of the object.
– Rader shadow zones appear as shadow, jet black, on the image > No

information
– Smooth and flat surface (water surface, parking lot, ground, etc.) is similar to

rader shadow on the image. On these surfaces, the emitted radio waves are
specularly reflected, and the reflected waves do not return to the antenna.
Therefore, they become black on the image, similar to radar shadow, so it is
necessary to judge them from the surrounding situation.

– Layover zones appear as bright features on the image > No information
– Since foreshortening distorts the shape of the object, you should always keep

that in mind when interpreting and proceed with the interpretation while
restoring the actual shape.
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For your reference

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data) (1/7)
– Results from time series analysis of Landsat images

characterizing forest extent and change.
– Published by Hansen et al., University of Maryland
– Dataset:

• Tree cover in the year 2000
• Forest cover gain during the period 2000 2012
• Forest cover loss during the period 2000 2018
• Circa year 2000 Landsat 7 cloud free image composite
• Circa year 2018 Landsat cloud free image composite
Trees are defined as vegetation taller than 5m in height and are encoded
as a percentage per output grid cell, in the range 0 100.
Forest gain is encoded as either 1 (gain) or 0 (no gain).
Forest loss is encoded as either 0 (no loss) or else a value in the range 1–
17, representing loss detected primarily in the year 2001–2018,
respectively.
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For your reference

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data) (2/7)
– Data can be downloaded from the site:

http://earthenginepartners.appspot.com/science 2013 global forest
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For your reference

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data) (3/7)
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For your reference

Section 1



Main data in the Project DB

• Global Forest Change data (Hansen data) (4/7)
– Tree cover in the year 2000
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For your reference

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data) (5/7)
– Forest cover gain
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For your reference

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data) (6/7)
– Forest cover loss
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For your reference

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data) (7/7)
– Forest cover loss (year)

32

For your reference

Section 1



Main data in the Project DB

• Global Forest Change data (Hansen data): Data adjustment (1/3)
– PNG covers four tiles, so you need to mosaic the four tiles and clip the

mosaicked data only within PNG area to handle the data easily.

1. Open ArcMap and add the data which you have downloaded.

33

For your reference

You can find forest loss year by showing data by unique value. For example,
“0” in Value field indicates “2000”, and “14” indicates “2014”.

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data): Data adjustment (2/3)
2. Mosaic layers by usingMosaic to New Raster tool.

• Tool: Data Management tools > Raster > Raster Dataset > Mosaic to New
Raster
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For your reference

Section 1

Main data in the Project DB

• Global Forest Change data (Hansen data): Data adjustment (3/3)
3. Add PNG boundary data.
4. Clip the mosaic data with PNG boundary data.

• Tool: Data Management tools > Raster > Raster Processing > Clip
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For your reference

PNG boundary

Data clipped within PNG area is created.

Section 1

Main maps created in the Project

• Map documents: 81_MapLayout folder
• Exported maps: 82_Maps folder
• Main maps

– [MAB] Overview maps: project boundary, satellite images, land
use map, geology map, MAB zoning

– [VarirataNP] VNP management maps: park facilities, camera
traps, maps for signboard in VNP and wall in ICC, VNP guide
maps, VNP management zone

– [Marine] MPA management maps: MPA and NMS including
zoning maps, mangroves of Bootles Bay

– [Etc] Various maps for discussions
– [Atlas] Maps additionally created for Project Atlas: location,

satellite images, altitude, slope, basin, vegetation, population,
ward

36Section 1



Main maps created in the Project

• Map document files (.mxd) are saved in ver. 10.3.
• Layers in map layout are linked to each data in the Project DB.

37Section 1

Main maps created in the Project

38

Map document file is GIS data, whichmap layout
is set in.

.mxd files are saved in
the folder: 81_MapLayout.

Map document files (.mxd) are saved in ver. 9.3.

Main maps created in the Project

39

Map layout can be exported to image file (jpg, pdf, etc.)

Exported files are saved in
the folder: 82_Maps.

Section 1

Main maps created in the Project

40

Map consists of many layers (data).

These layers in map layout are linked to
each data in the Project DB.

Section 1



2. Discussing how to store the data
in the CEPA server

41Section 2

Introduction and Objectives

• In this section, the items below will be confirmed/discussed.
– current situation of the CEPA’s GIS data server
– how to store the data in the CEPA server in view of section 1

• The data will be stored in the CEPA server in appropriate way so
that GIS data manager and operator can manage the data readily,
and CEPA staff can access to the data for the future.

42Section 2

Contents (Discussions)

• Storage facility
– Has GIS data server been prepared?
– Is there any storage space for the Project data?
– When is ready for storing the data?

• GIS data management rule
– Is there any rule to store data?
– Does the data need to be arranged to store in the server? (Who will do it?)
– Who can access (view/edit) data in the server?
– Who manages the data?

• AOB

* The meeting with the PA management officers is also planned to discuss how to
utilize and manage the PA data and maps after the Project.

43Section 2



3. Introduction of the data / maps to be shared
(for Protected Area management officers)

44Section 3

Introduction and Objectives

• In this section, the items below will be introduced.
– the data purchased, collected and created in the project activities
– formation of files and folders which the data and maps are/will be stored to

share

• Staff concerned with PA will get to know the data and maps
prepared in the project activities.

• Staff concerned with PA will utilize and update the data and maps
for their works as needed for the future.

45Section 3

Contents

• CEPA JICA Project GIS Database
• Data / Folder construction
• Main data in the Project DB
• Main maps created in the Project

46Section 3

CEPA JICA Project GIS Database

• GIS Database and GIS Detabase List (to be shared after the Project)
• Data shared by CEPA / Data created in the Project
• File format: shapefile (vector)

47Section 3



Data / Folder construction

• Main folder description

48Section 3

Data / Folder construction

• Sub folder (GIS Database List)

49Section 3

1: Prepared by the Project

Main data in the Project DB

• Main data
– 01_Satellite

• LANDSAT: for Project area/ downloaded about every 5 years/ unprocessed

• WorldView2: for Project area/ purchased in the Project/ high resolution

• RapidEye2010: for entire PNG/ from PNGFA

• PALSAR: for entire PNG/ from PNGFA/ ALOS PALSAR imagery

– 02_DEM
• ALOS DEM: for Project area

• ASTER GDEM: for Project area

• SRTM DEM (90m/30m): for entire PNG

– 11_TopoAnalyst (surface, hillshade, slope, contour)
– 21_Boundary (Project area, etc.)
– 22_Census: PNG Census 2011 (NSO)
– 23_ForestMap: Forest Base Map 2012 (PNGFA): for CEN, NCD

* PNGFA revised Forest Base Map 2012, and also created Forest Cover Map 2015.

50Section 3

Main data in the Project DB

• Main data
– 31_VarirataNP

• VNP boundary

• Land use map of Project area

• Facilities and Camera traps in VNP

• MAB zoning map of Project area

• Biological survey data implemented in the Project in 2017

– 32_MarineNP
• Mangrove map of Project area

• Reef map of Project area

• Depth line

• Zoning map of MPA (Motupore island, UPNG land, CPC land, and Tahira farm)

• Proposed National Marine Sanctuary

• Management zone of National Marine Sanctuary

• A variety of features such as jetty, resort, habitat areas, cultural/historical areas

51Section 3



Main data in the Project DB

• Main data
– 51_Hansen: Global Forest Change data (Forest cover, Loss, Gain)
– 81_MapLayout: folder for Map documents (mxd)
– 82_Maps: folder for maps (jpg, pdf): maps exported from the Map documents

– 91_Documents: folder for non spatial data
• GIS database list
• Manuals and related documents

– Updating facility database (July 2016, by Mr Imai)
– Update of VNP facility database (October 2018)
– Manual on Getting location information (Importing GPS data to GIS)
(February 2018)

– ENVI manual (4 April 2017)
• Presentation documents

– Introduction of Satellite Imagery WorldView 2 (22 April 2016)
– GIS Data Management (February 2020)

52Section 3

Main maps created in the Project

• Map documents: 81_MapLayout folder
• Exported maps: 82_Maps folder
• Main maps

– [MAB] Overview maps: project boundary, satellite images, land
use map, geology map, MAB zoning

– [VarirataNP] VNP management maps: park facilities, camera
traps, maps for signboard in VNP and wall in ICC, VNP guide
maps, VNP management zone

– [Marine] MPA management maps: MPA and NMS including
zoning maps, mangroves of Bootles Bay

– [Etc] Various maps for discussions
– [Atlas] Maps additionally created for Project Atlas: location,

satellite images, altitude, slope, basin, vegetation, population,
ward

53Section 3

Main maps created in the Project

54Section 3

Main maps created in the Project

55

Map document file is GIS data, whichmap layout
is set in.

.mxd files are saved in
the folder: 81_MapLayout.

Map document files (.mxd) are saved in ver. 9.3.



Main maps created in the Project

56

Map layout can be exported to image file (jpg, pdf, etc.)

Exported files are saved in
the folder: 82_Maps.

Section 3

Main maps created in the Project

57

Map consists of many layers (data).

These layers in map layout are linked to
each data in the Project DB.

Section 3

4. Technical transfer and discussion of
GIS data management / update
for the future VNP management

58Section 4

Introduction and Objectives

• The data and maps of VNP facilities were created through the
facility assessment in the project activities. The training on updating
facility database, which consists of the list and the field survey
sheets in Excel, was held by Mr Imai in July, 2016.

• In this section, the items below will be introduced and discussed.
– structure of the data and maps of the VNP facilities, and how to update them
– how to get location data using GPS and covert GPS data (gpx) into GIS data

(shapefile)
– workflow and method on updating facility information, including field survey

and excel database

• Staff concerned with PA will get knowledge of how to get location
information using GPS and convert the data to use in GIS.

• The GIS data and maps of the VNP facilities will be continuously and
appropriately updated to manage the VNP.

59Section 4



Contents

A) Review of the presentation on updating facility database in Excel
B) Introduction of the procedure to get location data using GPS and

covert the data into GIS
C) Introduction of the data and maps of the VNP facilities, and

discussion of workflow and method on updating them
– Overarching structure
– Workflows and timeline
– Procedure: Field work
– Procedure: Update of Excel database
– Fundamental knowledge of ArcGIS database

• Construction of GIS facility data
• Relational database (RDB) of facility
• Join RDB to facility attribute table
• Definition Query of facility features

– Procedure: Update of ArcGIS database
– Procedure: Update of ArcGIS Map layout
– Data / Folder construction

60Section 4

A) Review of the training on updating facility database,
which consists of list and field survey sheets in Excel,

held by Mr Imai in July 2016

61Section 4 – A)

B) The procedure to get location data using GPS
and covert the data into GIS

for the VNP facility management

62Section 4 – B)

Introduction

• You would be required to get location information of
features to create GIS data for managing National Parks,
say:
– Updating the VNP facility database for new facilities,
– Getting location where animals or plants are found,
– Confirming location where an unexpected event happens, etc.

• This document shows general procedure on creating GIS
data from GPS data of features/events which you get in
the field.

63Section 4 – B)



Procedure of importing GPS data to GIS

1. Get locations of features/events by GPS.
2. Import GPS data into GIS.
3. Arrange the imported data. (Option)

64Section 4 – B)

Procedure 1: Get locations of features/events by GPS

1. Set out GPS.
1. Turn on the power of GPS.
2. Confirm that battery charge is enough. If not, charge up.
3. Navigate to [Setup] > [Position Format] on the screen to

confirm GCS (Geographic Coordinate System) of [Map Datum]
and [Map Spheroid] isWGS 84.

2. Get location of a feature or an event in the field by pushing [Mark
Waypoint] button and then [Save].

See not to block to getting satellites by your body.

3. Turn the power off when completing getting required data.

65Section 4 – B)

Procedure 2: Import GPS data into GIS

1. Start PC, and connect the GPS to the PC.
2. Navigate to the GPS folder >Garmin/GPX, and copy

Waypoints_xxxx.gpx file in your folder (or designated
work folder).

3. Open ArcMap.
4. From ArcToolbox, double click

[GPX To Features] under
Conversion Tools.

66Section 4 – B)

Procedure 2: Import GPS data into GIS (Cont.)

5. In [GPX To Features] window, appoint
Waypoints_xxxx.gpx file in [Input GPS File], and name
folder and output file in [Output Feature class].

6. Click OK.
GPS data will be converted to
GIS data.
The converted data are
automatically imported in
ArcMap.
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Procedure 2: Import GPS data into GIS (Cont.)

7. Confirm the imported data in ArcMap.

68Section 4 – B)

Procedure 3: Arrange the imported data (Option)

1. Open table of the imported
(created) layer by right
clicking on the layer, and
select [Open Attribute Table].

69Section 4 – B)

Procedure 3: Arrange the imported data (Cont.)

2. Delete unneeded fields (columns) by right clicking on
the filed and select
[Delete Field].

3. Repeat step 2 until all
unneeded fields are
deleted.

70Section 4 – B)

Procedure 3: Arrange the imported data (Cont.)

4. Change name of each record (row).
1. On Editor tool bar, click [Editor] and select [Start Editing] to

edit table of the layer.

You can see that colour of
fields become white when edit
session starts. That means you
can edit records in the table.

2. Rename each record
appropriate one.
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Procedure 3: Arrange the imported data (Cont.)

4. Change name of each record (row). (Cont.)
3. After you finish step 2, click [Editor] and select [Save Edits] to

save your changes.
4. Then, click [Editor] again and select [Stop Editing] to stop edit

session.
Now, edit session is finished.

5. Save the created data in the appropriate folder.

You can compare the created data with other data by adding
interested data in the ArcMap if you like.

72Section 4 – B)

C) Workflow and method on updating
the VNP facility database (GIS data and maps)

for the park management

73Section 4 – C)

Introduction

• The database of the facilities in Varirata National Park (VNP) was
created by CEPA JICA Biodiversity Project Team.

• The VNP facility database is composed of (1) a list and profiles of
facilities in Excel format, (2) spatial data in GIS (shapefile) format,
and (3) related maps for management.

• These database need to be updated in accordance with facility
status on site such as removal, renovation and new construction for
continuous facility management.

• This document illustrates overarching structure of the database and
workflows and procedures of updating the database.

74Section 4 – C)

Contents

• Overarching structure
• Workflows and timeline
• Procedure: Field work
• Procedure: Update of Excel database
• Fundamental knowledge of ArcGIS database

– Construction of GIS facility data
– Relational database (RDB) of facility
– Join RDB to facility attribute table
– Definition Query of facility features

• Procedure: Update of ArcGIS database
• Procedure: Update of ArcGIS Map layout
• Data / Folder construction
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Overarching structure

76

GIS

List

Profile

Map

Facility Database

+

List of Facility.xlsx

VNP Facility profile 001 020.xlsx
VNP Facility profile 021 040.xlsx
VNP Facility profile 041 060.xlsx
…

VNP_Facility_update_pnt.shp
VNP_Facility_update_lin.shp
VNP_Facility_update_png.shp
…

VarirataNP_facility.mxd
…
VarirataNP_facility.jpg
…

Excel database

ArcGIS database

ArcGIS map layout
& Exported map

• List of all the facilities and facility profiles of each
facility

• Extensive facility information
• Database is updated as a result of field work

• GIS database of all the facilities
• Database includes other related data of the park
• Database is updated by using the “List of

Facility.xlsx”

• Maps are created/updated for facility
management and other materials, say guide map

• There are map layouts created ArcGIS and
exported maps for use

Section 4 – C)

Workflows and timeline
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Map

• Update the map layout using the
updated GIS database

• Export the updated map to use next
field work, etc.

Update of map layout
& export of map

GIS• Update the GIS database as a result of
field work

Update of ArcGIS database

• Update the facility attribute table (relational database)
by replacing the updated “List of Facility.xlsx”

Never delete records even if they are removed on site
Recommended timeline:
• Record in the field and update

of Excel DB throughout the year
• Update of the list of facility at

least once a year
• Annually update of GIS

database and Map

JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

Field Work

Excel DB

GIS DB

MAP

• Check facility
condition on site

• Record on hard copy
paper

Field work

List

Profile

+

Update of Excel database
• Fill necessary information in facility profile
• Update the list of facility

Prepare new profile sheet to keep prior
profile sheet
Never change Facility No., which is key to link
to GIS database
Never delete records (lines of the list) even if they are
removed on site, as Facility No. is unique id
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Procedure: Field work

1. Check the condition of facility
2. Record on existing profile on hard copy paper
3. Record photos which show condition such as, change, repair,

replace conditions

For more details, refer to “Updating facility database.pptx”
prepared by the Project in July, 2016.
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Procedure: Update of Excel database

Record of facility profile
1. Collect photos of updated facilities
2. Resize photos in size of 1024 x 768 pixels and save in a specific

holder
3. Add one page next to the existing sheet of profile
4. Fill necessary data

Update of the list of facility
1. Update the list of facility in accordance with the facility profiles

For more details, refer to “Updating facility database.pptx”
prepared by the Project in July, 2016.
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Never change Facility No. and delete facility records even if they are
removed on site, as Facility No., unique id, is key to link to GIS database.

Section 4 – C)



Fundamental knowledge of ArcGIS database

• Construction of GIS facility data
• Relational database (RDB) of facility
• Join RDB to facility attribute table
• Definition Query of facility features
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Construction of GIS facility data

• GIS facility data are composed of three data:
– Point data (VNP_Facility_update_pnt.shp),
– Line data (VNP_Facility_update_lin.shp), and
– Polygon data (VNP_Facility_update_pgn.shp).

Facility type of each data
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Construction of GIS facility data (Cont.)

• Fields of attribute tables of facility data
Field description:

FID
Shape

id

name
facility

no

area

These fields are added automatically,
so you cannot edit them.

Temporary work fields

This field is facility number, unique
id. The Excel database also has
this number, so that the field is
used to join tables.

Area (ha)

This field manages features.
“2”: usual facility data,
“1”: facility data used for only some
map (only display data), and
“0”: data created through work process.
“1” and “0” are not recorded in the
Excel database.

82

[id] and [no] fields are significant fields.
You can not change these values without
reason, since they affect map view.
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Relational database (RDB) of facility

• Excel database (List of facility.xlsx)

– The relational database of facility is created from the Excel database
using columns which could be used in GIS. For example,
[Sub_category_No] column is used to control which facilities are
shown in a map and define symbol and color of each facility.

– [Facility_No] column is used to join the facility RDB to the attribute
tables of facility data.

83

No use in GIS

Latest facility
condition
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Join RDB to facility attribute table

• Join Table
– The prepared facility RDB is joined to the attribute tables of facility.
– “Join Table” function lets you append additional information table

(RDB) to the target feature’s attribute table so that you can use
information of RDB when symbolizing the features, etc.

– A Key field, which both tables of GIS and Excel have in common, is
used to join the tables.

Feature’s attribute table of facility Facility RDB

Join the tables
using these fields
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Definition Query of facility features

• Update of facility condition
– There are 6 designation values for facility condition column:

• (blank)
• Maintain
• New construction
• Renovated
• Removed
• will be removed

85

– On the maps for facility
management, only “blank”,
“Maintain”, “New
construction” and
“Renovated” are displayed.
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Definition Query of facility features (Cont.)

• Definition Query
– “Definition Query” function defines data (features) to be displayed by

using values of fields.

86

> Show features whose “Id” field is 2 and “Sub_category_No” field is 28 (toilet) only.
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Procedure: Update of ArcGIS database

1. Create new facility features
2. Update the relational database of facility

87Section 4 – C)



Procedure: Update of ArcGIS database

1. Create new facility features
1. Copy location data (GPS data) of facility acquired in the field
2. Convert GPS data to GIS data (shapefile format)
3. Add new field for facility no. to converted data

• Field name: no
• Type: Short Integer

4. Record facility no. of each feature
5. Delete unneeded fields
6. Change name of existing facility data in the GIS database

• ex. VNP_Facility_pnt_bu20170321.shp

7. Merge the existing data (step 6) and the created data (step 1 5)
together, and save in the GIS database
• Name of new facility data should be that of original existing facility data

(ex. VNP_Facility_update_pnt.shp).
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2. Update the relational database of facility
1. Change name of the existing facility RDB

• ex. VNP_Facility_db_bu20170321.xls

2. Arrange the Excel databas, and save it in the GIS database
• Create a table with columns whose values could be used in GIS
• Name of new facility RDB should be the same name of the original existing

facility RDB (VNP_Facility_db.xls).

Procedure: Update of ArcGIS database (cont.)

89Section 4 – C)

Procedure: Update of ArcGIS map layout

1. Confirm if “Definition Query” and “Join Table” work correctly
2. Update the labels of the facility features if there are annotations

in the maps
3. Export the Maps
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Procedure : Update of ArcGIS map layout

1. Confirm if “Definition Query” and “Join Table” work correctly
1. Open the existing map documents related to the facilities in VNP
2. Check if facility layer setting for “Join Table” works correctly

• It is fine if the facility RDB is joined to the facility layers.

3. Check if facility layer setting for “Definition Query” works correctly
• It is fine if the only defined facility features render.

If the RDB does not joined or the defined features are not rendered,
check the process of creating the facility data.
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Procedure : Update of ArcGIS map layout (cont.)

2. Update the labels of the facility features if there are annotations
in the maps
“Label” is automatically updated according to data update, but
“annotation” need to be updated manually.
“Label” is placed on a map by GIS so it cannot be edited manually.
Conversely, “annotation” can be edited so it is created by converting
label for sophisticated map.

1. Delete the existing annotations of the facilities
2. Label the features of the facilities
3. Convert the labels to annotations
4. Lay out the created annotations in place
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Procedure : Update of ArcGIS map layout (cont.)

3. Export the Maps
1. Set layer on/off, legend, and title of the layout

A number of maps would be exported from one map document.

2. Export the maps
• Normal settings:

– Resolution: 200 dpi (1,200dpi for poster in A0 size)
– Format: JPEG or PDF
– JPEG Quality: Max (100)
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Data / Folder construction: Excel database

• List of facility
– List of Facility.xlsx (Result of VNP existing facility assessment in 2015)
– List_Analysis_Facility_VNP_151214_No1 254 fin.xlsx (ditto)
– List of Facility_20180727.xlsx (as of 27th Jul 2018)

• Facility profiles
– VNP Facility profile 001 020.xlsx
– VNP Facility profile 021 040.xlsx
– VNP Facility profile 041 060.xlsx
– …

• Manual
– Updating facility database.pptx
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Data / Folder construction: GIS database

• Facility data / relational database
– Data folder: GISDB¥31_VarirataNP¥data
– Point facility data: VNP_Facility_update_pnt.shp
– Line facility data: VNP_Facility_update_lin.shp
– Polygon facility data: VNP_Facility_update_pgn.shp
– Facility relational database: VNP_Facility_db.xls

• Map document (layout)
– Data folder: GISDB¥81_MapLayout¥VarirataNP

• Exported map
– Data folder: GISDB¥82_Maps¥VarirataNP

• Documents (manual)
– Data folder: GISDB¥91_Documents¥VN Facility Management

Refer to “Map for VNP Facility Management.xlsx” for more detailed
information of map setting
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5. Discussion on possibility of utilization of
the data and maps after the Project

96Section 5

Introduction and Objectives

• In this section, the items below will be discussed.
– possibility of the use of the data and maps after the Project
– how to manage the data and who manages the data

• The participants will confirm the possibility of the use of the data
and maps, and the necessity of data management.

• Data management system, including person responsible for data
management and update, will be established.
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Contents (Discussions)

• Data usability and sustainability
– Is the data prepared in the Project usable after the Project?
– Are the maps prepared in the Project usable after the Project?
– Is there any data needed to be updated (regularly) in the future?
– Can the data and maps be updated and used for your future works?
– In what situations and uses can the maps be usable?

• Data management
– Who gets new/updated information if needed?
– Who updates and manages GIS data and creates maps?
– Who can access (view/edit) data in the server?

• AOB
– PR: Project facebook page
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E-2 広報活動 

 

  



活動実績報告書：活動コンポーネント成果 4-2 

 

活動コンポーネントの概要及び主要な成果品 

広報活動 

 

1. 背景及び概要 

本プロジェクトが目指す保護区管理及び設立では、地域住民を始め広く PNG国民の理解

と支持を得て、多様なステークホルダーと協働することが重要である。そのため、広報的

な手法を用いてプロジェクトの認知度を上げるとともに、活動への参加・協力を促すこと

とした。 

プロジェクト開始段階に、C/Pとともに広報/啓発戦略を策定し、広報/啓発上の課題と目的

を特定した上で、具体的な手段や方法を設定した。本広報/啓発に係るアクションプランに

沿い、収集・作成した情報やマップ等を活用して、様々な情報発信ツールの作成、並びに

様々な媒体を通じた配布、及び発信を行った。 

 

2. 目的 

広報・啓発戦略を策定し、情報発信ツールの作成、適切な媒体を通じた配布・発信を行う 

 

3. 活動内容 

(1) 広報・啓発戦略の策定 

(2) 広報・啓発戦略に沿った情報発信媒体の作成 

(3) プロジェクト関連情報や作成した情報発信媒体の配布・発信 

(4) 適切な媒体を通じたプロジェクト活動の宣伝・流布 

 

4. 活動経緯と実績 

(1) 広報・啓発戦略の策定 

2015年 7月-10

月 

プロジェクトの広報・啓発の目的と果たすべき役割を明確にし、

CEPAの能力を評価し、課題とともに活動内容を確認した。 

2015年 7月-10

月 

広報・啓発活動の手段や対象、活動事項、期待される結果を特定し

た。 

2015年 10月-

2016年 2月 

添付資料 4.2.1 

 

上記活動の結果を受けて、「広報・啓発戦略」と「アクションプラ

ン」を策定した。 

2018年 7月 

添付資料 4.2.2 

プロジェクトの進捗や目標集団の状況を反映し、2015年 10月に策定

した広報・啓発戦略を見直し、改定を行った。 



2019年 10月-

2020年 3月 

添付資料 4.2.3 

プロジェクトの中で実施された広報・啓発活動を精査し、広報・啓発

の最終報告書を作成した。 

 

(2) 広報・啓発戦略に沿った情報発信媒体の作成 

2015年 6月-

2020年 2月 

添付資料 4.2.4 

プロジェクト活動を紹介するプロジェクト冊子を年 1回作成した。 

2016年 4月-

2020年 1月 

添付資料

4.2.5、4.2.6 

プロジェクトニュースレターを年 2回作成し、プロジェクトファクト

シートを年 1回作成した。 

2015年 8月-

2020年 6月 

添付資料 4.2.7-

4.2.12 

策定した広報・啓発戦略に沿って、情報発信媒体を作成した（アトラ

ス、環境教育教材、ポスター、バナー、サインボード、ポロシャツ、

Tシャツ、ベスト、ロゴ、ステッカー、スタンプ、プロモーションビ

デオ、等）。 

 

(3) プロジェクト関連情報や作成した情報発信媒体の配布・発信 

2015年 10月-

2020年 11月 

作成した情報発信媒体をセミナーやワークショップ、その他のイベン

トで配布した。 

2016年 5月-

2020年 11月 

プロジェクト関連情報をセミナーやワークショップ、その他のイベン

トで発信した。 

 

(4) 適切な媒体を通じたプロジェクト活動の宣伝・流布 

2015年 7月-

2020年 12月 

JICAプロジェクトホームページ（英語・日本語バージョン）を立ち

上げ、プロジェクト活動を紹介する記事を配信した。  

2015年 10月-

2020年 12月 

添付資料 4.2.13 

プロジェクトフェースブックページを立ち上げ、タイムリーにプロジ

ェクト活動を投稿した。 

2016年 12月 CEPAのホームページ内に CEPA-JICAプロジェクトページを開設し

た。 

2015年 8月-

2019年 5月 

PNGの新聞やテレビ等マスメディアや JICA広報雑誌にプロジェクト

関連情報を提供した。 

 

5. 評価 

(1) 目標達成度の評価 



評価指標 指標の到達度の自己

評価 

評価結果 

広報・啓発戦

略を実施す

る。 

Achieved プロジェクト開始時に広報・啓発戦略を策定

し、適時、戦略の実施状況をレビューしながら

実施した。実施した結果は広報・啓発戦略最終

報告書として取り纏めた。（添付資料 4.2.3） 

2016年 9月ま

でにプロジェ

クトウェブサ

イト作成し、

計画に沿って

定期的に更新

する。 

Achieved 2015年 7月に JICAプロジェクトホームページ

（英語・日本語）を立ち上げ、2015年 10月に

はプロジェクトフォースブックページを立ち上

げ、2016年 12月には CEPAのホームページ内

にプロジェクトページを開設した。それぞれの

サイトの性質に合わせ、定期的な更新を行っ

た。最も更新頻度の高いフェースブックページ

では、プロジェクト終了時までに 400回近く投

稿を行った。 

5種類以上の情

報発信媒体を

作成し、広

報・啓発戦略

に沿って、タ

ーゲット集団

の 30%以上に

宣伝する。 

Achieved 10種類以上の情報発信媒体を作成し、広報/啓

発戦略に沿って、ワークショップ・セミナーや

各種イベントの際に配布、宣伝を行った。パン

フレット類等は 500部単位で作成し、プロジェ

クト前半に作成した物は追加作成もしており、

ターゲット集団の 30%以上に宣伝できたと考え

る。 

 

(2) 目標到達度の評価 

評価指標 指標の到達度 評価結果 

プロジェクト

の年次報告書 

Achieved  プロジェクト年次報告（プロジェクトパンフレ

ット）やプロジェクトファクトシートで広報・

啓発戦略の実施状況を報告した（本報告書には

他の成果の実施状況も含まれる）。（添付資料

4.2.4、4.2.6） 

プロジェクト

の年次報告書

内のウェブサ

イトモニタリ

ング報告書 

Achieved 最も更新の多いプロジェクトフェースブックペ

ージのモニタリングを定期的に（全 11回）行

い、モニタリング報告書を作成した。（添付資

料 4.2.13） 



広報・啓発戦

略、情報発信

媒体 

Achieved 10種類以上の情報発信媒体を作成した。（添付

資料 4.2.1～4.2.12） 

 

6. 教訓 

(1) 「広報・啓発戦略とアクションプラン」に沿った適切で効果的な広報活動の実施 

プロジェクト開始時に本活動に特化した「広報・啓発戦略とアクションプラン」を策定

し、対象者、広報ツール、広報手法等を明確にすることで、様々なツールを用いて適時に

適切な広報活動を実施することが可能となった。その結果、広報活動を効果的なものにす

ることが出来た。これは関係者や地元住民のプロジェクトへの理解や自然環境保全に対す

る興味を醸成するだけでなく、彼らの反応を促すことにも役だった。 

 

7. 提言 

(1) プロジェクト終了後の情報発信媒体の有効活用の努力 

プロジェクトで作成した様々な情報発信媒体は、プロジェクト終了後もそのまま利用でき

るものが多く、また最低限の改定作業により長く使えるものが多い。観光振興局（TPA; 

Tourism Promotion Authority）等、他関連機関とも協力し、広報発信媒体を常時設置しても

らうなど、引き続き保護区や CEPAの活動についての露出を増やしていくことを提案す

る。また、プロジェクトのフェースブックページは、プロジェクト終了後は CEPAの保護

区活動全体の紹介ページとして、引き続き CEPAの活動を紹介、発信していくことを提案

する。更に、保護区のガイドや環境教育教材は、印刷したものを訪問客に販売するなど、

公園管理のための収入源として活用することを提案する。 

 

8. 主要な成果品リスト: 

1) Public Relations and Awareness Strategy for CEPA-JICA Biodiversity Project 2016 - 2020, 

December 2015 （添付資料 4.2.1） 

2) Public Relations and Awareness Strategy for CEPA-JICA Biodiversity Project 2016 – 2020 

(Revised Version), July 2018 （添付資料 4.2.2） 

3) Public Relations and Awareness Strategy for CEPA-JICA Biodiversity Project 2016 – 2020 

(Final Report), March 2020 （添付資料 4.2.3） 

4) Project brochure (project annual report) ver. 1 – 6, Output 3 version （添付資料 4.2.4） 

5) Project newsletter vol. 1 – 9 （添付資料 4.2.5） 

6) Project factsheet vol. 1 – 2 （添付資料 4.2.6） 

7) Project Atlas (1st edition) （添付資料 4.2.7） 

8) Field guide brochure: Plants, Mammals, Birds, Reptiles, Flogs, Invertebrates) （添付資料

4.2.8） 



9) Biodiversity reports/Executive summary of the biodiversity reports （添付資料 4.2.9） 

10) Guide Map of Varirata National Park （添付資料 4.2.10） 

11) Mangrove of Bootless Bay – Identification guide （添付資料 4.2.11） 

12) Common Birds of Bootless Bay – A field guide （添付資料 4.2.12） 

13) Monitoring report of Facebook page for the Project （添付資料 4.2.13） 

 

以上 
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Acronyms and Abbreviations 

 

CEPA   Conservation and Environment Protection Authority 

CSR   Corporate Social Responsibility 
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1. Introduction 

This Public Relations (PR) and Awareness Strategy is aimed at CEPA-JICA Biodiversity Project 

staff that play either a strategic, operational or influential role in communications, public 

relations and campaigning for the respective conservation activities affecting marine, forests, 

and freshwater ecosystems within the framework of CEPA-JICA Biodiversity Project (the 

Project) specifically focused on these thematic ecosystems - Varirata National Park in Koiari 

LLG and Motupore Island near Bootless Bay of Central Province. 

 

It is the responsibility of everyone within the Project to lead and raise awareness of the status of 

the project target area1 of PNG as the center of biodiversity including the network of Protected 

Areas (PA), and the need to conserve its biodiversity and promote sustainable livelihoods for the 

customary landowners. 

 

The major targets detailed in this document relies on the cooperation of all staff of CEPA and 

JICA Expert Team, particularly those working at the local grass roots level such as the Koiari 

Rural Local-level Government (LLG) and Hiri Rural LLG.  

 

This document shall be guided by the Environmental Communication Strategy of DEC (Draft 

Version 1, 2013). In addition there is  a strong emphasis on how to create effective public 

relations and awareness campaign and the steps involved in this process. 

 

 

  

                                                           
1
 Terrestrial target and  marine/coastal target (pls refer to Map 1: Locality of CEPA-JICA Project) 
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2. Background of the Project 

The PNG’s strong position on the environment is drawn from the Preamble of the National 

Constitution which declares our goal to be PNG’s natural resources and environment conserved 

and used for the benefit of us and our future generation. With that position, GoPNG formulated 

the National Biodiversity Strategy and Action Plan (NBSAP) in 2007. However, the 

implementation of NBSAP has been hindered, by lack of coordination and lack of proper 

funding and institutional capacity. The current protected area system is small, fragmented, and 

is highly unlikely to be adequate in providing protection to PNG’s high biodiversity. CEPA is in 

charge of monitoring and management of the protected areas however there is virtually no 

monitoring or management activity by CEPA. 

 

The PNG Policy on the Protected Areas (PPA) was developed and approved in 2014. PPA aims to 

enhance PNG’s governmental institutions at national, provincial and local levels to effectively 

manage PA network of PNG, and achieve operational function of the PPA.  

 

CEPA-JICA Biodiversity Project is a conservation initiative, which commenced its operation in 

June 2015.  The Project is a joint initiative between the Governments of PNG and Japan. The 

overall goal of the Project is “Protected Area Network is effectively managed by applying PA 

management (and establishment) model(s), which were developed by the Project” directly 

addresses the PPA implementation, to be achieved by accomplishing the project purpose by the 

end of the project period. 

 

3. Project Target Areas 

Project target area includes Central Province, NCDC and several target PAs. Output 2 targets 

Varirata National Park to be a model terrestrial PA, and Koiari Rural LLG to be a target LLG for 

livelihood development activities in the Project Design Matrix (PDM). Besides, Output 3 targets 

Motupore Island and Bootless Bay areas for developing a new marine PA model. Table 1 

indicates basic information of the target areas, and Figure 1 shows the location of the target 

areas for the Project. 

Table 1 Basic Information of target areas of the Project 

WARD Househol
d No. 

Populati
on 

VILLAGES & HAMLETS 
No. Name Member 

Terrestrial targets - Output 2 

2 Mesime Hon. Auda Arua 552 3130 

Mesime,KOB,Iiimo Station,Pukpuk Banis,Bolo 
Estate, Farm, Reform Churches, Farm 
16,Boroma, 14 mile Piggery 
Farmers,Rabidudu,Gary's Farm, Laloki 
Secondary, Lobunakouba Primary 

3 Madovate Hon. Manaka Bore 36 283 Madovate, Vaiagai, Maradahana, Tabeani, 
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Foxsy Block 

4 Furimuti Hon. Vakari Koua 364 1870 

Furimuti,CPA Compound, Koiari LLG 
Compound, Mekere Block, Kipalan Block, 
Radho, Hugo Canning, 15 Mile Station, Sidco, 
Riverside, Bluff Inn Motel, Hebou Compound, 
Franciscan Friary, Mt Koiari Block, Ted Diro, 
17 mile, Gagibevai, Scout Camp, Rauna 4, 
Rouna 1&3, Rouna Works 

5 Depo Hon. Billy Ivai 164 967 

Depo, Rouna 2, Varirata National Park, Sogeri 
Lodge, Kokoda Motel, Chamber, Anglician 
Church, Manurinumu, Magere, Bisiatabu SDA 
Mission, Gogosenumu, Bisianumu DPI, 
Ianabevai 

6 Vesulogo Hon. Helen Wiena 159 735 
Vesulogo, Iiolo, New Camp(Vataro), Moenaro, 
Salvation Army, Girinumu 1, Girinumu 2, 
Owens Corner Memorial Park 

7 Bereadabu Hon. Kidu Toina 70 349 
Bereadabu, Fakonama, Numuranumu, 
Wantomia, Pineapple Farm, Mababoto, 
Waharo,Boda. 

8 Kailaki Hon. Keroko 190 987 
Kailaki, Edobevai, Patiki, Ekoro, Itikinumu 
Primary School & Estate, Manubada, Aipiri, 
Subitana, Kailaki Community School 

10 Ogotana Hon. Baia Toina 61 377 
Ogotana, Mororo, Katalina Estate, Eilogo 
Estate, Wararo, Ninoa Estate 

11 Kahaitana Hon. Avana Koroi 88 631 
Kahaitana, Bausaka, Nainumu 2, Forokorata, 
Boredabu 

12 Berebei Vacant 114 576 
Berebei, Manamiro, Sirinumu Dam, Nainumu 
1, Gurunumu, Koeaba, Sirinumu Primary 
School, Wahonadada, Kouaro, Lorikitana 

13 Wautanumu Hon. Kareki Karimu 29 149 Warutanumu, Ubatana 

20 Sogeri Urban Hon. Tau Wahona 98 554 
Sogeri Station, Botoguni, Sogeri Police Station, 
Sogeri Health Centre, Larowari Secondary 
School, Sogeri Primary, Moronumu. 

Total 1,925  10,608    

Source: Population Census 2010 

WARD Househol
d No. 

Populati
on 

VILLAGES & HAMLETS 
No. Name Member 

Marine/coastal targets - Output 3 
8 Barakau - 183 1,598 Barakau, Kerekadi, Rabuka 

9 Tubusereia - 402 3,673 Tubusereia 

10 Mt Diamond - 
113 540 

Loloata Island,Gwarume-Mase, Mirigeda 
Settlement, Garameia Settlement, Sebore 
Settlement, Borabora Settlement, Motupore 
Island, Tahira Boat Centre, Mt Diamond High 
School, Jason Farm 

12 Dagoda - 
114 718 

Dabunari, Dagoda, Seme, Vaivai 

Total 812 6,529 
 

Source: Population Census 2000 
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Figure 1 Map showing the location of the target areas for the Project 
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4. Public Relations and Awareness in the Project Framework 

4.1 Project framework 

Followings are key components in the project framework of CEPA-JICA Project. The PDM 

activities of Output 4 were developed specifically in order to share project related information 

and promote activities in respective project proponent. This will create an enabling 

environment for collaborative work and effective public relations/awareness towards 

achieving the common goals of the Project.  

 

 (1) Project Purpose: 

Institutional capacity of CEPA for protected area (PA) management is strengthened through 

enhancing national-level PA governance and sustainable use of natural resources with local 

communities in the model Protected Areas as per the provision of the Policy on Protected 

Areas (PPA). 

 

(2) Overall Goal of the Project: 

Protected Area Network is effectively managed by applying Protected Area management (and 

establishment) model(s), which were developed by the Project. 

 

(3) Outputs of the Project: 

There are four specific outputs for this Project as following: 

(1) National-level governance and management arrangement for Protected Area Network 

(i.e., PPA Action Plan, National Conservation Council (NCC)) is strengthened. 

(2) The Varirata National Park (VNP) is enhanced as a terrestrial PA management model in 

accordance with PPA. 

(3) A model of establishing a new marine PA is developed as per the provision of PPA and 

concerned laws. 

(4) Public relations/awareness for biodiversity conservation is improved by disseminating 

project related information. 

 

(4) Activities of Output 4 

Activities related to public relations and awareness will be carried out under Output 4.   

Specific activities under Output 4 are: 

(1) Develop strategy for public relations/awareness 

(2) Collect and manage data/information for the management of model PA(s) 
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(3) Elaborate data/information sharing materials and disseminate through appropriate 

media 

(4) Conduct workshop/seminar for better public relations/awareness.  

 

5. Necessity of Developing PR Strategy for the Project 

CEPA (DEC) once has developed a draft Environmental Communication Strategy (Draft Version 

1) in February 2013. The Strategy tried to provide a broad overview of the guidelines for the 

development of effective public communication program, communicating sustainably within 

CEPA and the various tools, standards and training that can be utilized for the implementation 

of the education and awareness of different environmental issues. However, this draft strategy 

was neither finalized nor endorsed. At the moment, CEPA does not have policies, plans nor 

operational instructions for public relations and awareness, and environmental education. 

Therefore, it is believed that there is a greater need to develop a strategy for public relations and 

awareness for the Project, which can be utilized by all stakeholders and at the same time, 

provides guidance for the users including the PR/Communications Officers of CEPA or media 

officers. 

 

6. Key Targets for the Strategy 

The Strategy will play an integral role in the Project in order to assist in realizing various targets 

of the project activities by disseminating vital messages to the public and greater communities. 

The targets of the Strategy shall be relevant to the scope of the work for the Project. This section 

tries to clarify key targets of the Project to be assisted by the Strategy.  

 

Towards the end of the Project’s 5 year period by 2020, the Project would anticipate to realize 

following major targets: 

 

(1) Make VNP management fully functioning as a model PA of terrestrial 

ecosystem/biodiversity management in PNG,  

(2) Realize increasing number of visitors and tourists visiting the VNP on the monthly or 

annual basis because of improved facilities and management on the park, 

(3) Promote sustainable livelihood with cultural and traditional values together with the 

preservation of the biodiversity in the target LLGs, 

(4) Strengthen and maintain partnership with local communities including the Central 

Province administration, Kairiku-Hiri District administration, Koiari LLG, Hiri LLG and 

other key actors that the Project works with, 
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(5) Strengthen partnership with utility providers such as PNG Power Limited and Eda Ranu, 

and 

(6) Be recognized as the important project partner with the other government agencies, 

private sectors, NGO’s and civil societies. 

 

7. Basic Strategy 

There is a need to increase awareness of the Project over the first year (mid 2015 to mid 2016) 

and over the five year period, to raise the recognition among all of the key target audiences, and 

to prepare them for more targeted public relations/awareness. For that, the Project states basic 

strategies as below: 

(1) To increase the number of regular PR/awareness outputs/activities. 

(2) To enhance project team members on how to work with the media, how to be interviewed 

well, identify possible problem areas in dealing with the media, and how to avoid them. 

(3) To increase collaboration between PR section of CEPA and the Project Team to identify 

good ideas for PR.  

(4) To maintain and expand relations with key journalists/reporters in order to generate 

frequent and supportive reporting on the organisation. Special publications, social events, 

and journalist workshops are possible components of this strategy. 

(5) Aside from the print media, the disseminating of information to the landowning 

communities have to be in a desired dialect ( Tok Motu, or Tok Pisin) for easy 

communication. 

 

8. Principles for the Strategy 

All the activities under the strategy need to comply with following principles: 

 

(1) More interaction, encouragement and dialogue among all team members of the Project 

and key partners in order to encourage and ensure all communication requirements are 

satisfied. 

(2) Various PR and communications tools are to be utilized effectively to assist in promoting 

the overall objectives of the Project through its activities, and that communities are made 

aware and educated on the importance of conservation and sustainable management of 

the natural resources. 

(3) Communication/PR Outputs (Output 4) from the implementation timeline will be 

reviewed and revised in consultation with respective project team members, during 

important and major events or occasions. 



 

   pg. 10 

 

(4) All CEPA internal communication protocols including issuance of public media 

statements will be fully observed.  

 

9. Target Audience and Key Message 

There are basically two types of audiences which the Project targets when carrying out its 

PR/communications activities: 

 

(1) Primary audience 

 Local communities or landowners including churches 

 Governments (including all levels of government) – decision-makers on natural resource 

management 

 Funders/donor agencies 

 Private sectors/corporations that are prepared to work in partnership and accept the 

environmental compliance standards as their corporate social responsibility (CSR). 

 

(2) Secondary audience 

 CEPA  

 Schools and academia 

 Key partners and stakeholders 
 

It is vital for this Project and CEPA to produce relevant and key messages which can reach the 

target audiences and at the same time these messages can be easily understood and interpreted 

by them. Key messages and target audience are indicated in the table 2. 

 

Table 2 Key messages and target audience 

Key Messages Target Audience 
Terrestrial Target – Output 2 
Forging partnership to promote 
livelihood development and conservation 
of the VNP 

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 
 Government line agencies (DAL, TPA) 

Managing species and their habitats for 
the future health and benefit of local 
communities in one of the intact forest 
and least polluted freshwater systems  

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 
 Government line agencies (DAL, TPA) 



pg. 11 

 Schools/academia
Local communities and governments 
leading efforts to conserve the 
unpolluted headwaters of Siriminu Dam 
and surrounding savannah woodlands 

 Local communities
 Koiari LLG (including Ward areas and councilors)
 Kairiku-Hiri District (esp. Hiri)
 Central Provincial administration
 Private sector/corporate (Eda Ranu, PNG Power Ltd)

Marine/Coastal Target – Output 3 
Protect ‘fringing of coastal barrier 
complex’ along coastlines of Central 
province/Port Moresby (including Hiri 
coastal shores and Bootless Bay) 
(source: Map 2 
Shallow_feat_data_2014_0426, 
University of Queensland)

 Local communities
 Hiri LLG (including Ward areas and councilors)
 Kairiku-Hiri District (esp. Hiri)
 Central Provincial administration
 UPNG
 Private sector/corporate (Loloata Resort, TPA, etc)
 Schools/academia(UPNG, PAU)

Conserve priority WCMC offshore 
habitat within the Coral Triangle 
Scientific Boundary (source: Map 2
Shallow_feat_data_2014_0426, 
University of Queensland)

 Local communities
 Hiri LLG (including Ward areas and councilors)
 Kairiku-Hiri District (esp. Hiri)
 Central Provincial administration
 Private sector/corporate (Loloata Resort, TPA, etc)
 Schools/academia(UPNG, PAU)

CEPA-JICA Biodiversity Project – cross-cutting 
Protection and sustainable management 
of natural resources that enhances 
biodiversity conservation and 
livelihoods of local communities 

All partners and stakeholders 

10. Tools for PR

The Project employ specific tools and medium for effective public relations and awareness as 

enlisted below: 

(1) Website/homepage

The Project is intended to design and produce a website which will be the integral part of

the public relations/awareness and communications leading to achieving its objectives. 

The site will be created in CEPA homepage. The Project’s website, which was developed 

by JICA (www.jica.go.jp/png/english/activities/activity18.html) can also be linked to the 

CEPA homepage. Project staff will be trained to manage the web content. This will 

include identifying a designated project/CEPA staff who can be able to continue to 

upload material and update the web structure on a regular and timely basis. 

Responsibility for these activities lies with the PR/Communications Officer of CEPA with 

the direct supervision by the Project Manager.  

http://www.jica.go.jp/png/english/activities/activity18.html
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(2) Photo library 

A user friendly ‘photo library’ will be set up at the project homepage so that photographs 

of the new priority landscapes, species, project’s achievements and other project related 

events can be accessed to illustrate the Project’s work. 

 

(3) Print media 

The PR and Awareness/Communications Officer of CEPA will monitor daily newspapers 

to keep track of the number of the project’s press releases and feature stories which are 

published or reported on those newspapers. Any stories or news of relevance to the 

project’s staff will be emailed on the day these stories were published to keep staff 

informed and enable them to prepare comments where necessary. 

 

(4) Brochures/Publications 

Brochures are information sheets for the Project in relation to the activities undertaken 

as per the respective Outputs. Publications are project’s outputs, which are produced 

during the course of project activities, and also are appropriate to be distributed to 

stakeholders for enhancing effectiveness in the specific field of the project activities. The 

example of such brochures and publications may include the following:  

 Project brochure 

 VNP pamphlet 

 Marine PA pamphlet 

 A guide book for birds, insects, etc for VNP 

 Flora and fauna biodiversity reports for VNP and new marine PA 

 Monthly or annual technical reports by the Project 

 

(5) Factsheets 

The simplified and inexpensive factsheets about the Project and relevant Outputs will be 

published regularly(tentatively planned to be once a year). These materials can be one or 

two page documents following a template of factsheet to be set by the Project. 

Factsheets will include: 

 Basic information of the project activities 

 Project achievements 

 Products and publications 

 Other relevant information of the VNP or new marine PA 
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 (6) Newsletter 

A newsletter (can be both hard and e-newsletter) with a given name (to be suggested by 

the Project, e.g. Park Toktok, Varirata Toksave) should be developed. This will be the 

primary newsletter for conveying information on significant events, achievements, and 

project progress, which will be communicated to stakeholders, partners, donor and JICA 

network. This newsletter can be produced quarterly, bi-monthly or annually with 

contribution of stories, news from all Project staff. The PR/Communications Officer will 

work closely with the Project Team members, short-term consultants and graphic 

designers to develop and finalise the publication and circulate the newsletter on specific 

time frame. 

 

(7) Maps 

The Geographical Information System (GIS) specialist of JICA Expert Team will work 

with consultation of CEPA GIS and Remote Sensing unit and if need arises work in 

collaboration with other institutions such as PNGFA (FIMS datasets), DAL (PNGRIS 

datasets), Department of Lands and Physical Planning, etc. to produce maps, which will 

be focusing on priority landscapes, species and other related information for the project 

documentation, presentations and external communications, public relations and 

awareness.  
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11. Key Activities, Target Audience and Actions 

The Project will make necessary actions for PR and awareness as indicated below table: 

 

Table 3 Key activities, target audiences and actions 

 Key Activity Target Audience Action 
1 Offering information 

by project website/ 
homepage (English/ 
Japanese) 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Open project webpage in JICA homepage 
(English/Japanese) 
2. Open project homepage (facebook page) to 
introduce project related information 
3. Publish newsletters to introduce progress of 
project activities and report appeal of target site 

2 Producing materials 
for public relation/ 
environmental 
education using 
project outputs   

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration, UPNG, 
PAU and other 
schools/academia 

1. Produce atlas(es) using information collected, 
maps created and satellite imagery analyzed in the 
Project to report appeal of target site 

2. Produce environmental educational materials to 
let PNG’s natural environment be known  
3. Create brochures 
4. Create poster, banner, etc. to vitalize seminar and 
workshop 

3 Presenting events 
(producing event 
goods) 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Produce and distribute public relation materials in 
seminars, workshops, events, etc. to disseminate the 
Project and let appealing project site be known 
2. Present project outputs to report and disseminate 
the Project 
3. Run a booth at events to report and disseminate 
the Project 

4 Information 
supplement to JICA 
and mass media in 
Japan 

General nation, Japanese 
national 

1. Contribute articles to JICA public relations 
magazine to disseminate project related information 
if requested 

5 Offer/ cooperation on 
mass media in PNG 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Provide information of the Project to press 
release: TV, radio, newspaper, magazine, etc. in 
PNG 

6 Approach to Japanese 
private sector/ 
corporate  in PNG 

Japanese nationals and 
private sector/ corporate  in 
PNG, Japanese national  

1. Provide information of the Project to press 
release: Japanese magazine, newspaper to introduce 
project activities, if requested 
2. Approach and cooperate to mass media in Japan 
(ex. NHK nature program) to introduce project 
activities and PNG, if requested. 
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12. Implementation Schedule 
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Ⅳ

4. Create poster, banner, etc. to vitalize seminar and workshop

1. Contribute articles to JICA public relations magazine to disseminate project

related information if requested

3. Create brochures

1. Provide information of the project to press release: TV, radio, newspaper,

magazine, etc. in PNG

2. Present project outputs to report and disseminate the project

2. Produce environmental educational materials to let PNG’s natural

environment be known

1. Produce atlas(es) using information collected, maps created and satellite imagery

analyzed in the project to report appeal of target site

1. Open project webpage in JICA homepage (English/Japanese)

2. Open project homepage (facebook page) to introduce project related

information
3. Publish newsletters to introduce progress of project activities and report

appeal of target site

2016

Ⅲ Ⅳ Ⅱ Ⅲ Ⅳ Ⅰ Ⅱ Ⅲ ⅣⅠ ⅡⅠ Ⅲ

2017 2018 2019

1. Offering information by project website/ homepage (English/ Japanese)

4. Information supplement to JICA and mass media in Japan

5. Offer/ cooperation on mass media in PNG

6. Approach to Japanese private sector/ corporate in PNG

2. Producing materials for public relation/ environmental education using project outputs

2015

Ⅰ Ⅱ

1. Produce and distribute public relation materials in seminars, workshops, events, etc.

to disseminate the project and let appealing project site be known

3. Presenting events (producing event goods)

3. Run a booth at events to report and disseminate the project

1. Provide information of the project to press release: Japanese magazine,

newspaper to introduce project activities, if requested
2. Approach and cooperate to mass media in Japan (ex. NHK nature program)

to introduce project activities and PNG, if requested.
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13. Monitoring and Evaluation 

Relevant CEPA-JICA Biodiversity Project Team members will track changes and improvements 

in the strategy. The outputs of the public relations and the related communications matters, 

such as the number of press releases issued, feature stories prepared and disseminated, press 

conferences, seminars or workshops held would be monitored ever three months. 

By the end of first 12 months (June 2016), monitoring indicators and monitoring schedule will 

be set for use. The Project will also discuss to set baseline levels in the first 12 months (mid 2015 

to mid 2016). A simple baseline assessment will be undertaken at the end of each year.  

The followings are examples of  monitoring indicators: 

 The number of visitors and “hits” of the website per year 

 The amount and variety of its contents of website 

 Greater web presence, more CEPA-JICA stories on the JICA.go.jp, CEPA webpage, 

and related homepages 

 At least  three postings to the project webpage in JICA homepage per year 

 At least six postings to the project homepage per year 

 At least one types of brochure, 1,000 copies, per year 

 Two types of poster per year 

 One type of banner per year 

 Publications to be in the 3 main languages (ie.. English, Tok pisin and Motu) 
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1. Introduction	
This Public Relations (PR) and Awareness Strategy is aimed at CEPA-JICA Biodiversity Project 

staff that play either a strategic, operational or influential role in communications, public relations 

and campaigning for the respective conservation activities affecting marine, forests, and 

freshwater ecosystems within the framework of CEPA-JICA Biodiversity Project (the Project) 

specifically focused on these thematic ecosystems - Varirata National Park in Koiari Local-level 

Government (LLG) and Motupore Island near Bootless Bay of Central Province. 

 

It is the responsibility of everyone within the Project to lead and raise awareness of the status of 

the project target area1 of PNG as the center of biodiversity including the network of Protected 

Areas (PA), and the need to conserve its biodiversity and promote sustainable livelihoods for the 

customary landowners. 

 

The major targets detailed in this document relies on the cooperation of all staff of Conservation 
and Environment Protection Authority (CEPA) and Japan International Cooperation 
Agency (JICA) Expert Team, particularly those working at the local grass roots level such as the 

Koiari Rural LLG and Hiri Rural LLG.  

 

This document shall be guided by the Environmental Communication Strategy of Department of 

Environment and Conservation (DEC) (Draft Version 1, 2013). In addition there is a strong 

emphasis on how to create effective public relations and awareness campaign and the steps 

involved in this process. 

 

 

  	

                                                            
1 Terrestrial target and  marine/coastal target (pls refer to Map 1: Locality of CEPA‐JICA Project) 
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2. Background	of	the	Project	
The PNG’s strong position on the environment is drawn from the Preamble of the National 

Constitution which declares our goal to be PNG’s natural resources and environment conserved 

and used for the benefit of us and our future generation. With that position, Government of Papua 

New Guinea (GoPNG) formulated the National Biodiversity Strategy and Action Plan (NBSAP) in 

2007. However, the implementation of NBSAP has been hindered, by lack of coordination and 

lack of proper funding and institutional capacity. The current protected area system is small, 

fragmented, and is highly unlikely to be adequate in providing protection to PNG’s high 

biodiversity. CEPA is in charge of monitoring and management of the protected areas however 

there is virtually no monitoring or management activity by CEPA. 

 

The PNG Policy on the Protected Areas (PPA) was developed and approved in 2014. PPA aims to 

enhance PNG’s governmental institutions at national, provincial and local levels to effectively 

manage PA network of PNG, and achieve operational function of the PPA.  

 

CEPA-JICA Biodiversity Project is a conservation initiative, which commenced its operation in 

June 2015.  The Project is a joint initiative between the GoPNG and Japan. The overall goal of the 

Project is “Protected Area Network is effectively managed by applying PA management (and 

establishment) model(s), which were developed by the Project” directly addresses the PPA 

implementation, to be achieved by accomplishing the project purpose by the end of the project 

period. 

 

3. Project	Target	Areas	
Project target area includes Central Province, National Capital District Commission (NCDC) and 

several target PAs. Output 2 targets Varirata National Park to be a model terrestrial PA, and Koiari 

Rural LLG to be a target LLG for livelihood development activities in the Project Design Matrix 

(PDM). Besides, Output 3 targets Motupore Island and Bootless Bay areas for developing a new 

marine PA model. Table 1 indicates basic information of the target areas, and Figure 1 shows the 

location of the target areas for the Project. 

 

Table 1 Basic Information of target areas of the Project 

WARD Househol
d No. 

Populati
on VILLAGES & HAMLETS 

No. Name Member 
Terrestrial targets - Output 2 

2 Mesime Hon. Auda Arua 552 3130 

Mesime,KOB,Iiimo Station,Pukpuk Banis,Bolo 
Estate, Farm, Reform Churches, Farm 
16,Boroma, 14 mile Piggery 
Farmers,Rabidudu,Gary's Farm, Laloki 
Secondary, Lobunakouba Primary 
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3 Madovate Hon. Manaka Bore 36 283 
Madovate, Vaiagai, Maradahana, Tabeani, 
Foxsy Block 

4 Furimuti Hon. Vakari Koua 364 1870 

Furimuti,CPA Compound, Koiari LLG 
Compound, Mekere Block, Kipalan Block, 
Radho, Hugo Canning, 15 Mile Station, Sidco, 
Riverside, Bluff Inn Motel, Hebou Compound, 
Franciscan Friary, Mt Koiari Block, Ted Diro, 
17 mile, Gagibevai, Scout Camp, Rauna 4, 
Rouna 1&3, Rouna Works 

5 Depo Hon. Billy Ivai 164 967 

Depo, Rouna 2, Varirata National Park, Sogeri 
Lodge, Kokoda Motel, Chamber, Anglician 
Church, Manurinumu, Magere, Bisiatabu SDA 
Mission, Gogosenumu, Bisianumu DPI, 
Ianabevai 

6 Vesulogo Hon. Helen Wiena 159 735 
Vesulogo, Iiolo, New Camp(Vataro), Moenaro, 
Salvation Army, Girinumu 1, Girinumu 2, 
Owens Corner Memorial Park 

7 Bereadabu Hon. Kidu Toina 70 349 
Bereadabu, Fakonama, Numuranumu, 
Wantomia, Pineapple Farm, Mababoto, 
Waharo,Boda. 

8 Kailaki Hon. Keroko 190 987 
Kailaki, Edobevai, Patiki, Ekoro, Itikinumu 
Primary School & Estate, Manubada, Aipiri, 
Subitana, Kailaki Community School 

10 Ogotana Hon. Baia Toina 61 377 Ogotana, Mororo, Katalina Estate, Eilogo 
Estate, Wararo, Ninoa Estate 

11 Kahaitana Hon. Avana Koroi 88 631 
Kahaitana, Bausaka, Nainumu 2, Forokorata, 
Boredabu 

12 Berebei Vacant 114 576 
Berebei, Manamiro, Sirinumu Dam, Nainumu 
1, Gurunumu, Koeaba, Sirinumu Primary 
School, Wahonadada, Kouaro, Lorikitana 

13 Wautanumu Hon. Kareki Karimu 29 149 Warutanumu, Ubatana 

20 Sogeri Urban Hon. Tau Wahona 98 554 
Sogeri Station, Botoguni, Sogeri Police Station, 
Sogeri Health Centre, Larowari Secondary 
School, Sogeri Primary, Moronumu. 

Total 1,925  10,608    
Source: Population Census 2010 

WARD Househol
d No. 

Populati
on VILLAGES & HAMLETS 

No. Name Member 
Marine/coastal targets - Output 3 
8 Barakau - 183 1,598 Barakau, Kerekadi, Rabuka 
9 Tubusereia - 402 3,673 Tubusereia 

10 Mt Diamond - 113 540 

Loloata Island,Gwarume-Mase, Mirigeda 
Settlement, Garameia Settlement, Sebore 
Settlement, Borabora Settlement, Motupore 
Island, Tahira Boat Centre, Mt Diamond High 
School, Jason Farm 

12 Dagoda - 114 718 Dabunari, Dagoda, Seme, Vaivai 

Total 812 6,529  

Source: Population Census 2000 
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Figure 1 Map showing the location of the target areas for the Project 

4. Public	Relations	and	Awareness	in	the	Project	Framework	

4.1 Project	framework	

Followings are key components in the project framework of CEPA-JICA Biodiversity Project. 

The PDM activities of Output 4 were developed specifically in order to share project related 

information and promote activities in respective project proponent. This will create an enabling 

environment for collaborative work and effective public relations/awareness towards achieving 

the common goals of the Project.  
 

	(1)	Project	Purpose:	

Institutional capacity of CEPA for protected area (PA) management is strengthened through 

enhancing national-level PA governance and sustainable use of natural resources with local 

communities in the model Protected Areas as per the provision of the Policy on Protected Areas 

(PPA). 

	

(2)	Overall	Goal	of	the	Project:	

Protected Area Network is effectively managed by applying PA management (and 

establishment) model(s), which were developed by the Project. 

	

(3)	Outputs	of	the	Project:	

There are four specific outputs for this Project as following: 

(1) National-level governance and management arrangement for Protected Area Network (i.e., 

PPA Action Plan, National Conservation Council (NCC)) is strengthened. 

(2) The Varirata National Park (VNP) is enhanced as a terrestrial PA management model in 

accordance with PPA. 

(3) A model of establishing a new marine PA is developed as per the provision of PPA and 

concerned laws. 

(4) Public relations/awareness for biodiversity conservation is improved by disseminating 

project related information. 

	

(4)	Activities	of	Output	4	

Activities related to public relations and awareness will be carried out under Output 4.   Specific 

activities under Output 4 are: 

(1) Develop strategy for public relations/awareness 
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(2) Collect and manage data/information for the management of model PA(s) 

(3) Elaborate data/information sharing materials and disseminate through appropriate media 

(4) Conduct workshop/seminar for better public relations/awareness.  

 

5. Necessity	of	Developing	PR	Strategy	for	the	Project	
CEPA (DEC) once has developed a draft Environmental Communication Strategy (Draft Version 

1) in February 2013. The Strategy tried to provide a broad overview of the guidelines for the 

development of effective public communication program, communicating sustainably within 

CEPA and the various tools, standards and training that can be utilized for the implementation of 

the education and awareness of different environmental issues. However, this draft strategy was 

neither finalized nor endorsed. At the moment, CEPA does not have policies, plans nor 

operational instructions for public relations and awareness, and environmental education. 

Therefore, it is believed that there is a greater need to develop a strategy for public relations and 

awareness for the Project, which can be utilized by all stakeholders and at the same time, provides 

guidance for the users including the PR/Communications Officers of CEPA or media officers. 

 

6. Key	Targets	for	the	Strategy	
The Strategy will play an integral role in the Project in order to assist in realizing various targets 

of the project activities by disseminating vital messages to the public and greater communities. 

The targets of the Strategy shall be relevant to the scope of the work for the Project. This section 

tries to clarify key targets of the Project to be assisted by the Strategy.  

 

Towards the end of the Project’s 5 year period by 2020, the Project would anticipate to realize 

following major targets: 

 

(1) Make VNP management fully functioning as a model PA of terrestrial 

ecosystem/biodiversity management in PNG,  

(2) Realize increasing number of visitors and tourists visiting the VNP on the monthly or 

annual basis because of improved facilities and management on the park, 

(3) Promote sustainable livelihood with cultural and traditional values together with the 

preservation of the biodiversity in the target LLGs, 

(4) Strengthen and maintain partnership with local communities including the Central 

Province administration, Kairiku-Hiri District administration, Koiari LLG, Hiri LLG and 

other key actors that the Project works with, 

(5) Strengthen partnership with utility providers such as PNG Power Limited and Eda Ranu, 

and 
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(6) Be recognized as the important project partner with the other government agencies, private 

sectors, NGO’s and civil societies. 

 

7. Basic	Strategy	
There is a need to increase awareness of the Project over the first year (mid 2015 to mid 2016) and 

over the five year period, to raise the recognition among all of the key target audiences, and to 

prepare them for more targeted public relations/awareness. For that, the Project states basic 

strategies as below: 

(1) To increase the number of regular PR/awareness outputs/activities. 

(2) To enhance Project Team members on how to work with the media, how to be interviewed 

well, identify possible problem areas in dealing with the media, and how to avoid them. 

(3) To increase collaboration between PR section2 of CEPA and the Project Team to identify 

good ideas for PR.  

(4) To maintain and expand relations with key journalists/reporters in order to generate 

frequent and supportive reporting on the organisation. Special publications, social events, 

and journalist workshops are possible components of this strategy. 

(5) Aside from the print media, the disseminating of information to the landowning 

communities have to be in a desired dialect (Tok Motu, or Tok Pisin) for easy 

communication. 

 

8. Principles	for	the	Strategy	
All the activities under the strategy need to comply with following principles: 

 

(1) More interaction, encouragement and dialogue among all team members of the Project and 

key partners in order to encourage and ensure all communication requirements are 

satisfied. 

(2) Various PR and communications tools are to be utilized effectively to assist in promoting 

the overall objectives of the Project through its activities, and that communities are made 

aware and educated on the importance of conservation and sustainable management of the 

natural resources. 

(3) Communication/PR Outputs (Output 4) from the implementation timeline will be 

reviewed and revised in consultation with respective Project Team members, during 

important and major events or occasions. 

                                                            
2 CEPA does not have the unit which specializes in PR/awareness. The Project collaborate with the sections related 

to PR, including Environmental Information and Science Division and Information and Communication Technology 

Branch. 
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(4) All CEPA internal communication protocols including issuance of public media statements 

will be fully observed.  

 

9. Target	Audience	and	Key	Message	
There are basically two types of audiences which the Project targets when carrying out its 

PR/communications activities: 

 

(1)	Primary	audience	

 Local communities or landowners including churches 

 Governments (including all levels of government) – decision-makers on natural resource 

management 

 Funders/donor agencies 

 Private sectors/corporations that are prepared to work in partnership and accept the 

environmental compliance standards as their corporate social responsibility (CSR). 

 

(2)	Secondary	audience	

 CEPA  

 Schools and academia 

 Key partners and stakeholders 
 

It is vital for this Project and CEPA to produce relevant and key messages which can reach the 

target audiences and at the same time these messages can be easily understood and interpreted 

by them. Key messages and target audience are indicated in the table 2. 

 

Table 2 Key messages and target audience 

Key Messages Target Audience 
Terrestrial Target – Output 2 
Forging partnership to promote 
livelihood development and conservation 
of the VNP 

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 
 Government line agencies (DAL, TPA) 

Managing species and their habitats for 
the future health and benefit of local 
communities in one of the intact forest 
and least polluted freshwater systems  

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 
 Government line agencies (DAL, TPA) 
 Schools/academia 
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Local communities and governments 
leading efforts to conserve the 
unpolluted headwaters of Siriminu Dam 
and surrounding savannah woodlands 

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 

Marine/Coastal Target – Output 3 
Protect ‘fringing of coastal barrier 
complex’ along coastlines of Central 
province/Port Moresby (including Hiri 
coastal shores and Bootless Bay) 
(source: Map 2 
Shallow_feat_data_2014_0426, 
University of Queensland) 

 Local communities 
 Hiri LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 UPNG 
 Private sector/corporate (Loloata Resort, TPA, etc) 
 Schools/academia(UPNG, PAU) 

Conserve priority WCMC offshore 
habitat within the Coral Triangle 
Scientific Boundary (source: Map 2 
Shallow_feat_data_2014_0426, 
University of Queensland) 

 Local communities 
 Hiri LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Loloata Resort, TPA, etc) 
 Schools/academia(UPNG, PAU) 

CEPA-JICA Biodiversity Project – cross-cutting 
Protection and sustainable management 
of natural resources that enhances 
biodiversity conservation and 
livelihoods of local communities 

All partners and stakeholders 

 

 

10. Tools	for	PR	
The Project employ specific tools and medium for effective public relations and awareness as 

enlisted below: 

 

(1)	Website/homepage	

The Project is intended to design and produce a website which will be the integral part of 

the public relations/awareness and communications leading to achieving its objectives. 

The site will be created in CEPA homepage (http://www.pngcepa.com/projects/) and as 

facebook page. The Project’s website, which was developed by JICA 

(www.jica.go.jp/png/english/activities/activity18.html), can also be linked to the CEPA 

homepage. Project staff will be trained to manage the web content. This will include 

identifying a designated project/CEPA staff who can be able to continue to upload material 

and update the web structure on a regular and timely basis. Responsibility for these 

activities lies with the PR/Communications Officer of CEPA with the direct supervision by 

the Project Manager.  
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(2)	Photo	library	

A user friendly ‘photo library’ will be set up at the project homepage so that photographs 

of the new priority landscapes, species, project’s achievements and other project related 

events can be accessed to illustrate the Project’s work. 

 

(3)	Print	media	

The PR and Awareness/Communications Officer of CEPA will monitor daily newspapers 

to keep track of the number of the project’s press releases and feature stories which are 

published or reported on those newspapers. Any stories or news of relevance to the 

project’s staff will be emailed on the day these stories were published to keep staff 

informed and enable them to prepare comments where necessary. 

 

(4)	Brochures/Publications	

Brochures are information sheets for the Project in relation to the activities undertaken as 

per the respective Outputs. Publications are project’s outputs, which are produced during 

the course of project activities, and also are appropriate to be distributed to stakeholders 

for enhancing effectiveness in the specific field of the project activities. The example of 

such brochures and publications may include the following:  

 Project brochure 

 VNP pamphlet 

 Marine PA pamphlet 

 A guide book for birds, insects, etc for VNP 

 Flora and fauna biodiversity reports for VNP and new marine PA 

 Monthly or annual technical reports by the Project 

 

(5)	Factsheets	

The simplified and inexpensive factsheets about the Project and relevant Outputs will be 

published regularly(tentatively planned to be once a year). These materials can be one or 

two page documents following a template of factsheet to be set by the Project. 

Factsheets will include: 

 Basic information of the project activities 

 Project achievements 

 Products and publications 

 Other relevant information of the VNP or new marine PA 

 

	(6)	Newsletter	

A newsletter (can be both hard and e-newsletter) with a given name (to be suggested by 

the Project, e.g. Park Toktok, Varirata Toksave) should be developed. This will be the 
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primary newsletter for conveying information on significant events, achievements, and 

project progress, which will be communicated to stakeholders, partners, donor and JICA 

network. This newsletter can be produced quarterly, bi-monthly or annually with 

contribution of stories, news from all Project staff. The PR/Communications Officer will 

work closely with the Project Team members, short-term consultants and graphic 

designers to develop and finalise the publication and circulate the newsletter on specific 

time frame. 

 

(7)	Maps	

The Geographical Information System (GIS) specialist of JICA Expert Team will work with 

consultation of CEPA GIS and Remote Sensing unit and if need arises work in 

collaboration with other institutions such as Papua New Guinea Forest Authority 

(PNGFA) (Forest Information Management System (FIMS) datasets), Department of 

Agriculture and Livestock (DAL) (PNG Resource Information System (PNGRIS) datasets), 

Department of Lands and Physical Planning, etc. to produce maps, which will be focusing 

on priority landscapes, species and other related information for the project 

documentation, presentations and external communications, public relations and 

awareness.  
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11. Key	Activities,	Target	Audience	and	Actions	
The Project will make necessary actions for PR and awareness as indicated below table: 

 

Table 3 Key activities, target audiences and actions 

 Key Activity Target Audience Action 
1 Offering information 

by project website/ 
homepage (English/ 
Japanese) 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Open project webpage in JICA homepage 
(English/Japanese) 
2. Open project homepage (facebook page) to 
introduce project related information 
3. Publish newsletters to introduce progress of 
project activities and report appeal of target site 

2 Producing materials 
for public relation/ 
environmental 
education using 
project outputs   

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration, UPNG, 
PAU and other 
schools/academia 

1. Produce atlas(es) using information collected, 
maps created and satellite imagery analyzed in the 
Project to report appeal of target site 

2. Produce environmental educational materials to 
let PNG’s natural environment be known  
3. Create brochures 
4. Create poster, banner, etc. to vitalize seminar and 
workshop 

3 Presenting events 
(producing event 
goods) 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Produce and distribute public relation materials in 
seminars, workshops, events, etc. to disseminate the 
Project and let appealing project site be known 
2. Present project outputs to report and disseminate 
the Project 
3. Run a booth at events to report and disseminate 
the Project 

4 Information 
supplement to JICA 
and mass media in 
Japan 

General nation, Japanese 
national 

1. Contribute articles to JICA public relations 
magazine to disseminate project related information 
if requested 

5 Offer/ cooperation on 
mass media in PNG 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Provide information of the Project to press 
release: TV, radio, newspaper, magazine, etc. in 
PNG 

6 Approach to Japanese 
private sector/ 
corporate  in PNG 

Japanese nationals and 
private sector/ corporate  in 
PNG, Japanese national  

1. Provide information of the Project to press 
release: Japanese magazine, newspaper to introduce 
project activities, if requested 
2. Approach and cooperate to mass media in Japan 
(ex. NHK nature program) to introduce project 
activities and PNG, if requested. 
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12. Implementation	Schedule	
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13. Monitoring	and	Evaluation	
Relevant CEPA-JICA Biodiversity Project Team members will track changes and improvements 

in the strategy. The outputs of the public relations and the related communications matters, such 

as the number of press releases issued, feature stories prepared and disseminated, press 

conferences, seminars or workshops held would be monitored ever three months. 

By the end of first 12 months (June 2016), monitoring indicators and monitoring schedule will be 

set for use. The Project will also discuss to set baseline levels in the first 12 months (mid 2015 to 

mid 2016). A simple baseline assessment will be undertaken at the end of each year.  

The followings are examples of  monitoring indicators: 

 The number of visitors and “hits” of the website per year 

 The amount and variety of its contents of website 

 Greater web presence, more CEPA-JICA stories on the JICA.go.jp, CEPA webpage, 

and related homepages 

 At least  three postings to the project webpage in JICA homepage per year 

 At least six postings to the project homepage per year 

 At least one types of brochure, 1,000 copies, per year 

 Two types of poster per year 

 One type of banner per year 

 Publications to be in the 3 main languages (ie.. English, Tok pisin and Motu) 

 

Midterm Monitoring and Evaluation in July 2019 

In July 2019, the project activities and achievements were monitored in the Table 4. The specified 

activities were basically implemented at a good rate, and the activities and the tools for PR well 

contributed to disseminate the project activities. 

In latter half of the Project, the Project Team will more focus on producing environmental 

educational materials to be displayed in Information Center Complex in VNP and mangrove 

information center of marine PA. Moreover, the Project Team will provide information of the 

project activities and achievements to press release such as TV, newspaper, magazine, etc. 
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Table 4 Activities and achievements as of July 2019 
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1. Introduction	
This Public Relations (PR) and Awareness Strategy was aimed at CEPA-JICA Biodiversity Project 

staff that play either a strategic, operational or influential role in communications, public relations 

and campaigning for the respective conservation activities affecting marine, forests, and 

freshwater ecosystems within the framework of CEPA-JICA Biodiversity Project (hereinafter 

called the Project) specifically focused on these thematic ecosystems - Varirata National Park 

(VNP) in Koiari Local-level Government (LLG) and Motupore Island near Bootless Bay of Central 

Province. 

 

It is the responsibility of everyone within the Project to lead and raise awareness of the status of 

the project target area1 of PNG as the center of biodiversity including the network of Protected 

Areas (PA), and the need to conserve its biodiversity and promote sustainable livelihoods for the 

customary landowners. 

 

The major targets detailed in this document relies on the cooperation of all staff of Conservation 

and Environment Protection Authority (CEPA) and Japan International Cooperation Agency 

(JICA) Expert Team, particularly those working at the local grass roots level such as the Koiari 

Rural LLG and Hiri Rural LLG.  

 

This document shall be guided by the Environmental Communication Strategy of Department of 

Environment and Conservation (DEC) (Draft Version 1, 2013). In addition there is a strong 

emphasis on how to create effective public relations and awareness campaign and the steps 

involved in this process. 

 

This final report also mentions the outputs and effects of the PR and awareness activities 

implemented in the Project by November 2020. The discussions and lessons learned in the 

activities of the Project will be an indication of future PR and awareness activities in CEPA. 

  	

                                                            
1 Terrestrial target and  marine/coastal target (pls refer to Map 1: Locality of CEPA‐JICA Project) 
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2. Background	of	the	Project	
The PNG’s strong position on the environment is drawn from the Preamble of the National 

Constitution which declares our goal to be PNG’s natural resources and environment conserved 

and used for the benefit of us and our future generation. With that position, Government of Papua 

New Guinea (GoPNG) formulated the National Biodiversity Strategy and Action Plan (NBSAP) in 

2007. However, the implementation of NBSAP has been hindered, by lack of coordination and 

lack of proper funding and institutional capacity. The current protected area system is small, 

fragmented, and is highly unlikely to be adequate in providing protection to PNG’s high 

biodiversity. CEPA is in charge of monitoring and management of the protected areas however 

there is virtually no monitoring or management activity by CEPA. 

 

The PNG Policy on the Protected Areas (PPA) was developed and approved in 2014. PPA aims to 

enhance PNG’s governmental institutions at national, provincial and local levels to effectively 

manage PA network of PNG, and achieve operational function of the PPA.  

 

CEPA-JICA Biodiversity Project is a conservation initiative, which commenced its operation in 

June 2015.  The Project is a joint initiative between the GoPNG and Government of Japan (GoJ). 

The overall goal of the Project, “Protected Area Network is effectively managed by applying PA 

management (and establishment) model(s), which were developed by the Project” directly 

addresses the PPA implementation, to be achieved by accomplishing the project purpose by the 

end of the project period. 

 

3. Project	Target	Areas	
Project target area includes Central Province, National Capital District Commission (NCDC) and 

several target PAs. Output 2 targets Varirata National Park (VNP) to be a model terrestrial PA, 

and Koiari Rural LLG to be a target LLG for livelihood development activities in the Project Design 

Matrix (PDM). Besides, Output 3 targets Motupore Island and Bootless Bay areas for developing 

a new marine PA model. Table 1 indicates basic information of the target areas, and Figure 1 shows 

the location of the target areas for the Project. 

 

Table 1 Basic Information of target areas of the Project 

WARD Househo
ld No. 

Popula
tion 

VILLAGES & HAMLETS 
No. Name Member 

Terrestrial targets - Output 2 

2 Mesime 
Hon. Auda 
Arua 

552 3130 

Mesime,KOB,Iiimo Station,Pukpuk Banis,Bolo 
Estate, Farm, Reform Churches, Farm 
16,Boroma, 14 mile Piggery 
Farmers,Rabidudu,Gary's Farm, Laloki 
Secondary, Lobunakouba Primary 
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3 Madovate 
Hon. Manaka 
Bore 

36 283 
Madovate, Vaiagai, Maradahana, Tabeani, 
Foxsy Block 

4 Furimuti 
Hon. Vakari 
Koua 

364 1870 

Furimuti,CPA Compound, Koiari LLG 
Compound, Mekere Block, Kipalan Block, 
Radho, Hugo Canning, 15 Mile Station, Sidco, 
Riverside, Bluff Inn Motel, Hebou Compound, 
Franciscan Friary, Mt Koiari Block, Ted Diro, 
17 mile, Gagibevai, Scout Camp, Rauna 4, 
Rouna 1&3, Rouna Works 

5 Depo 
Hon. Billy 
Ivai 

164 967 

Depo, Rouna 2, VNP, Sogeri Lodge, Kokoda 
Motel, Chamber, Anglician Church, 
Manurinumu, Magere, Bisiatabu SDA Mission, 
Gogosenumu, Bisianumu DPI, Ianabevai 

6 Vesulogo 
Hon. Helen 
Wiena 

159 735 
Vesulogo, Iiolo, New Camp(Vataro), Moenaro, 
Salvation Army, Girinumu 1, Girinumu 2, 
Owens Corner Memorial Park 

7 Bereadabu 
Hon. Kidu 
Toina 

70 349 
Bereadabu, Fakonama, Numuranumu, 
Wantomia, Pineapple Farm, Mababoto, 
Waharo,Boda. 

8 Kailaki Hon. Keroko 190 987 
Kailaki, Edobevai, Patiki, Ekoro, Itikinumu 
Primary School & Estate, Manubada, Aipiri, 
Subitana, Kailaki Community School 

10 Ogotana 
Hon. Baia 
Toina 

61 377 
Ogotana, Mororo, Katalina Estate, Eilogo 
Estate, Wararo, Ninoa Estate 

11 Kahaitana 
Hon. Avana 
Koroi 

88 631 
Kahaitana, Bausaka, Nainumu 2, Forokorata, 
Boredabu 

12 Berebei Vacant 114 576 
Berebei, Manamiro, Sirinumu Dam, Nainumu 
1, Gurunumu, Koeaba, Sirinumu Primary 
School, Wahonadada, Kouaro, Lorikitana 

13 Wautanumu 
Hon. Kareki 
Karimu 

29 149 Warutanumu, Ubatana 

20 
Sogeri 
Urban 

Hon. Tau 
Wahona 

98 554 
Sogeri Station, Botoguni, Sogeri Police Station, 
Sogeri Health Centre, Larowari Secondary 
School, Sogeri Primary, Moronumu. 

Total 1,925  10,608    
Source: Population Census 2010 

WARD Househo
ld No. 

Popula
tion 

VILLAGES & HAMLETS 
No. Name Member 

Marine/coastal targets - Output 3 
8 Barakau - 183 1,598 Barakau, Kerekadi, Rabuka 
9 Tubusereia - 402 3,673 Tubusereia 

10 
Mt 
Diamond 

- 
113 540 

Loloata Island,Gwarume-Mase, Mirigeda 
Settlement, Garameia Settlement, Sebore 
Settlement, Borabora Settlement, Motupore 
Island, Tahira Boat Centre, Mt Diamond High 
School, Jason Farm 

12 Dagoda - 114 718 Dabunari, Dagoda, Seme, Vaivai 
Total 812 6,529  

Source: Population Census 2000 
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Figure 1 Map showing the location of the target areas for the Project 
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4. Public	Relations	and	Awareness	in	the	Project	Framework	

Project	framework	

Followings are key components in the project framework of CEPA-JICA Biodiversity Project. 

The PDM activities of Output 4 were developed specifically in order to share project related 

information and promote activities in respective project proponent. This was expected to create 

an enabling environment for collaborative work and effective public relations/awareness 

towards achieving the common goals of the Project.  
 

(1)	Project	Purpose:	

Institutional capacity of CEPA for protected area (PA) management is strengthened through 

enhancing national-level PA governance and sustainable use of natural resources with local 

communities in the model Protected Areas as per the provision of the Policy on Protected Areas 

(PPA). 

 

(2)	Overall	Goal	of	the	Project:	

Protected Area Network is effectively managed by applying PA management (and 

establishment) model(s), which were developed by the Project. 

 

(3)	Outputs	of	the	Project:	

There are four specific outputs for this Project as following: 

(1) National-level governance and management arrangement for Protected Area Network (i.e., 

PPA Action Plan, National Conservation Council (NCC)) is strengthened. 

(2) The Varirata National Park (VNP) is enhanced as a terrestrial PA management model in 

accordance with PPA. 

(3) A model of establishing a new marine PA is developed as per the provision of PPA and 

concerned laws. 

(4) Public relations/awareness for biodiversity conservation is improved by disseminating 

project related information 

 

	(4)	Activities	of	Output	4	

Activities related to public relations and awareness are carried out under Output 4.   Specific 

activities under Output 4 are: 

(1) Develop strategy for public relations/awareness 

(2) Collect and manage data/information for the management of model PA(s) 

(3) Elaborate data/information sharing materials and disseminate through appropriate media 

(4) Conduct workshop/seminar for better public relations/awareness.  
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5. Necessity	of	Developing	PR	Strategy	for	the	Project	
CEPA (formerly DEC) once developed a draft Environmental Communication Strategy (Draft 

Version 1) in February 2013. The Strategy tried to provide a broad overview of the guidelines for 

the development of effective public communication program, communicating sustainably within 

CEPA and the various tools, standards and training that can be utilized for the implementation of 

the education and awareness of different environmental issues. However, this draft strategy was 

neither finalized nor endorsed. At the moment, CEPA does not have policies, plans nor 

operational instructions for public relations and awareness, and environmental education. 

Therefore, it is believed that there is a greater need to develop a strategy for public relations and 

awareness for the Project, which can be utilized by all stakeholders and at the same time, provides 

guidance for the users including the PR/Communications Officers of CEPA or media officers. 

 

6. Key	Targets	for	the	Strategy	
The Strategy plays an integral role in the Project in order to assist in realizing various targets of 

the project activities by disseminating vital messages to the public and greater communities. The 

targets of the Strategy shall be relevant to the scope of the work for the Project. This section tries 

to clarify key targets of the Project to be assisted by the Strategy.  

 

Towards the end of the Project’s 5 year period by 2020, the Project would anticipate to realize 

following major targets: 

 

(1) Make VNP management fully functioning as a model PA of terrestrial 

ecosystem/biodiversity management in PNG,  

(2) Realize increasing number of visitors and tourists visiting the VNP on the monthly or 

annual basis because of improved facilities and management on the park, 

(3) Promote sustainable livelihood with cultural and traditional values together with the 

preservation of the biodiversity in the target LLGs, 

(4) Strengthen and maintain partnership with local communities including the Central 

Province administration, Kairiku-Hiri District administration, Koiari LLG, Hiri LLG and 

other key actors that the Project works with, 

(5) Strengthen partnership with utility providers such as PNG Power Limited and Eda Ranu, 

and 

(6) Be recognized as the important project partner with the other government agencies, private 

sectors, NGO’s and civil societies. 
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7. Basic	Strategy	
There is a need to increase awareness of the Project over the first year (mid 2015 to mid 2016) and 

over the five year period, to raise the recognition among all of the key target audiences, and to 

prepare them for more targeted public relations/awareness. For that, the Project states basic 

strategies as below: 

 

(1) To increase the number of regular PR/awareness outputs/activities. 

(2) To enhance Project Team members on how to work with the media, how to be interviewed 

well, identify possible problem areas in dealing with the media, and how to avoid them. 

(3) To increase collaboration between PR section2 of CEPA and the Project Team to identify 

good ideas for PR.  

(4) To maintain and expand relations with key journalists/reporters in order to generate 

frequent and supportive reporting on the organisation. Special publications, social events, 

and journalist workshops are possible components of this strategy. 

(5) Aside from the print media, the disseminating of information to the landowning 

communities have to be in a desired dialect (Tok Motu, or Tok Pisin) for easy 

communication. 

 

8. Principles	for	the	Strategy	
All the activities under the strategy need to comply with following principles: 

 

(1) More interaction, encouragement and dialogue among all team members of the Project and 

key partners in order to encourage and ensure all communication requirements are 

satisfied. 

(2) Various PR and communications tools are to be utilized effectively to assist in promoting 

the overall objectives of the Project through its activities, and that communities are made 

aware and educated on the importance of conservation and sustainable management of the 

natural resources. 

(3) Communication/PR Outputs (Output 4) from the implementation timeline are reviewed 

and revised in consultation with respective Project Team members, during important and 

major events or occasions. 

(4) All CEPA internal communication protocols including issuance of public media statements 

are fully observed.  

 

                                                            
2 CEPA does not have the unit which specializes in PR/awareness. The Project collaborate with the sections related 
to PR, including Environmental Information and Science Division and Information and Communication Technology 
Branch. 
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9. Target	Audience	and	Key	Message	
There are basically two types of audiences which the Project targets when carrying out its 

PR/communications activities: 

 

(1)	Primary	audience	

 Local communities or landowners including churches 

 Governments (including all levels of government) – decision-makers on natural resource 

management 

 Funders/donor agencies 

 Private sectors/corporations that are prepared to work in partnership and accept the 

environmental compliance standards as their corporate social responsibility (CSR). 

 

(2)	Secondary	audience	

 CEPA  

 Schools and academia 

 Key partners and stakeholders 
 

It is vital for this Project and CEPA to produce relevant and key messages which can reach the 

target audiences and at the same time these messages can be easily understood and interpreted 

by them. Key messages and target audience were indicated in the table 2. 

 

Table 2 Key messages and target audience 

Key Messages Target Audience 
Terrestrial Target – Output 2 
Forging partnership to promote 
livelihood development and conservation 
of the VNP 

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 
 Government line agencies (DAL, TPA) 

Managing species and their habitats for 
the future health and benefit of local 
communities in one of the intact forest 
and least polluted freshwater systems  

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 
 Government line agencies (DAL, TPA) 
 Schools/academia 

Local communities and governments 
leading efforts to conserve the 
unpolluted headwaters of Siriminu Dam 
and surrounding savannah woodlands 

 Local communities 
 Koiari LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Eda Ranu, PNG Power Ltd) 
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Marine/Coastal Target – Output 3 
Protect ‘fringing of coastal barrier 
complex’ along coastlines of Central 
province/Port Moresby (including Hiri 
coastal shores and Bootless Bay) 
(source: Map 2 
Shallow_feat_data_2014_0426, 
University of Queensland) 

 Local communities 
 Hiri LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 UPNG 
 Private sector/corporate (Loloata Resort, TPA, etc) 
 Schools/academia (UPNG, PAU) 

Conserve priority WCMC offshore 
habitat within the Coral Triangle 
Scientific Boundary (source: Map 2 
Shallow_feat_data_2014_0426, 
University of Queensland) 

 Local communities 
 Hiri LLG (including Ward areas and councilors) 
 Kairiku-Hiri District (esp. Hiri) 
 Central Provincial administration 
 Private sector/corporate (Loloata Resort, TPA, etc) 
 Schools/academia (UPNG, PAU) 

CEPA-JICA Biodiversity Project – cross-cutting 
Protection and sustainable management 
of natural resources that enhances 
biodiversity conservation and 
livelihoods of local communities 

All partners and stakeholders 

 

 

10. Tools	for	PR	
The Project expected to employ specific tools and medium for effective public relations and 

awareness as enlisted below: 

 

(1)	Website/homepage	

The Project was intended to design and produce a website which would be the integral part 

of the public relations/awareness and communications leading to achieving its objectives. 

The site were expected to be created in CEPA homepage 

(http://www.pngcepa.com/projects/) and as facebook page. The Project’s website, which was 

developed by JICA (www.jica.go.jp/png/english/activities/activity18.html), can also be 

linked to the CEPA homepage. Project staff were intended to be trained to manage the web 

content. This includes identifying a designated project/CEPA staff who can be able to 

continue to upload material and update the web structure on a regular and timely basis. 

Responsibility for these activities lies with the PR/Communications Officer of CEPA with the 

direct supervision by the Project Manager.  

 

(2)	Photo	library	

A user friendly ‘photo library’ was intended to be set up at the project homepage so that 

photographs of the new priority landscapes, species, project’s achievements and other project 

related events can be accessed to illustrate the Project’s work. 
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(3)	Print	media	

The PR and Awareness/Communications Officer of CEPA intended to monitor daily 

newspapers to keep track of the number of the Project’s press releases and feature stories 

which are published or reported on those newspapers. Any stories or news of relevance to the 

Project’s staff were intended to be emailed on the day these stories were published to keep 

staff informed and enable them to prepare comments where necessary. 

 

(4)	Brochures/Publications	

Brochures are information sheets for the Project in relation to the activities undertaken as 

per the respective Outputs. Publications are project’s outputs, which are produced during the 

course of project activities, and also are appropriate to be distributed to stakeholders for 

enhancing effectiveness in the specific field of the project activities. The example of such 

brochures and publications might include the following:  

 Project brochure 

 VNP pamphlet 

 Marine PA pamphlet 

 A guide book for birds, insects, etc for VNP 

 Flora and fauna biodiversity reports for VNP and new marine PA 

 Monthly or annual technical reports by the Project 

 

(5)	Factsheets	

The simplified and inexpensive factsheets about the Project and relevant Outputs intended to 

be published regularly (tentatively planned to be once a year). These materials can be one or 

two page documents following a template of factsheet to be set by the Project. 

Factsheets were expected to include: 

 Basic information of the project activities 

 Project achievements 

 Products and publications 

 Other relevant information of the VNP or new marine PA 

 

(6)	Newsletter	

A newsletter (can be both hard and e-newsletter) with a given name (to be suggested by the 

Project, e.g. Park Toktok, Varirata Toksave) was intended to be developed. This expected to 

be the primary newsletter for conveying information on significant events, achievements, and 

project progress, which would be communicated to stakeholders, partners, donor and JICA 

network. This newsletter can be produced quarterly, bi-monthly or annually with 

contribution of stories, news from all Project staff. The PR/Communications Officer was 

intended to work closely with the Project Team members, short-term consultants and graphic 
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designers to develop and finalize the publication and circulate the newsletter on specific time 

frame. 

 

(7)	Maps	

The Geographical Information System (GIS) specialist of JICA Expert Team intended to work 

with consultation of CEPA GIS and Remote Sensing unit and if need arises work in 

collaboration with other institutions such as Papua New Guinea Forest Authority (PNGFA) 

(Forest Information Management System (FIMS) datasets), Department of Agriculture and 

Livestock (DAL) (PNG Resource Information System (PNGRIS) datasets), Department of 

Lands and Physical Planning, etc. to produce maps, which would be focusing on priority 

landscapes, species and other related information for the project documentation, 

presentations and external communications, public relations and awareness.  
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11. Key	Activities,	Target	Audience	and	Actions	
The Project made necessary actions for PR and awareness on the basis of the table indicated below. 
 

Table 3 Key activities, target audiences and actions 

 Key Activity Target Audience Action 

1 Offering information 
by project website/ 
homepage (English/ 
Japanese) 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Open project webpage in JICA homepage 
(English/Japanese) 
2. Open project homepage (facebook page) to 
introduce project related information 
3. Publish newsletters to introduce progress of 
project activities and report appeal of target site 

2 Producing materials 
for public relation/ 
environmental 
education using 
project outputs   

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration, UPNG, 
PAU and other 
schools/academia 

1. Produce atlas(es) using information collected, 
maps created and satellite imagery analyzed in 
the Project to report appeal of target site 

2. Produce environmental educational materials 
to let PNG’s natural environment be known  
3. Create brochures 
4. Create poster, banner, etc. to vitalize seminar 
and workshop 

3 Presenting events 
(producing event 
goods) 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Produce and distribute public relation 
materials in seminars, workshops, events, etc. to 
disseminate the Project and let appealing project 
site be known 
2. Present project outputs to report and 
disseminate the Project 
3. Run a booth at events to report and 
disseminate the Project 

4 Information 
supplement to JICA 
and mass media in 
Japan 

General nation, Japanese 
national 

1. Contribute articles to JICA public relations 
magazine to disseminate project related 
information if requested 

5 Offer/ cooperation on 
mass media in PNG 

Local communities, general 
nation, target LLGs, 
Kairiku-Hiri District, 
Central Provincial 
Administration 

1. Provide information of the Project to press 
release: TV, radio, newspaper, magazine, etc. in 
PNG 

6 Approach to Japanese 
private sector/ 
corporate in PNG 

Japanese nationals and 
private sector/ corporate  in 
PNG, Japanese national  

1. Provide information of the Project to press 
release: Japanese magazine, newspaper to 
introduce project activities, if requested 
2. Approach and cooperate to mass media in 
Japan (ex. NHK nature program) to introduce 
project activities and PNG, if requested. 
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12. Implementation	Schedule	and	Actual	Achievement	
Implementation schedule and actual achievement for each PR and awareness activity are shown 

in table 4. 

 

Table 4 Implementation schedule and actual achievement of PR and 
awareness activities 
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13. Monitoring	and	Evaluation	

Monitoring	and	indicators	

The Project Team members tracked changes and improvements in the strategy. The outputs of 

the public relations and the related communications matters, such as the number of press 

releases issued, feature stories prepared and disseminated, press conferences, seminars or 

workshops held were monitored every three months. 

By the end of first 12 months (June 2016), monitoring indicators and monitoring schedule were 

set for use. The Project also discussed to set baseline levels in the first 12 months (mid 2015 to 

mid 2016). A simple baseline assessment was undertaken at the end of each year.  

Monitoring indicators are shown in Table 5. 

 

Table 5 Monitoring indicators of PR and awareness activities 

Activities Tools Indicators 

1. Offering information by project website/ homepage (English/ Japanese) 
1.1 Open project webpage in JICA homepage 
(English/Japanese) to introduce the Project 
and main project activities 

Open project webpage 
in JICA homepage 
(English/Japanese) 

The number of posting on 
Project webpage in JICA 
homepage: more than 3 a year 

1.2 Open project homepage (facebook page) 
to introduce project related information, 
target site and project activities timely 

Open project homepage 
(facebook page) 

The number of posting on 
Project homepage (facebook 
page): more than 6 a year 
The number of visitors and 
"Likes" of the website per year 

1.3 Publish newsletters to introduce progress 
of project activities and report appeal of target 
site 

Publish newsletters Newsletters: more than twice a 
year 

2. Producing materials for public relation/ environmental education using project outputs   
2.1 Produce atlas(es) using information 
collected, maps created and satellite imagery 
analyzed in the Project to report appeal of 
target site 

Produce atlas(es) Atlas: 1-2 publication(s) 

2.2 Produce environmental educational 
materials to let PNG’s natural environment be 
known  

Produce environmental 
educational materials 

Environmental educational 
material: more than 4 

2.3 Create brochures to report project 
activities  

Create brochure Brochure: annual 

2.4 Create poster, banner, sign board, etc. to 
vitalize seminar and workshop 

Create poster, banner, 
sign board, etc. 

More than 4 types of PR tools 
other than the tools above 
(poster, banner, sign board, etc.) 
The amount and variety of tools 

3. Presenting events (producing event goods) 
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3.1 Produce and distribute public relation 
materials in seminars, workshops, events, etc. 
to disseminate the Project and let appealing 
project site and PNG’s natural environment 
be known 

Produce and distribute 
public relation materials 
in seminars, workshops, 
events, etc. 

Various PR materials in each 
event 

3.2 Present project outputs to report and 
disseminate the Project 

Present project outputs Seminar/workshop: more than 
once a year 

3.3 Run a booth at events to report and 
disseminate the Project 

Run a booth at events Booth at events 

4. Information supplement to JICA and mass media in Japan 
4.1 Contribute articles to JICA public 
relations magazine to disseminate project 
related information if requested 

Contribute articles to 
JICA public relations 
magazine 

Project news is picked up in 
JICA public relations magazine 

5. Offer/ cooperation on mass media in PNG 
5.1 Provide information of the Project to 
press release: TV, radio, newspaper, 
magazine, etc. in PNG to disseminate project 
activities information 

Provide information of 
the Project to press 
release in PNG 

Project news get into the media 
in PNG: more than once a year 

6. Approach to Japanese private sector/ corporate in PNG 
6.1 Provide information of the Project to 
press release: Japanese magazine, newspaper 
to introduce project activities, if requested 

Provide information of 
the Project to press 
release in Japan 

Project news get into the media 
in Japan 

6.2 Approach and cooperate to mass media in 
Japan (ex. NHK nature program) to introduce 
project activities and PNG, if requested 

Approach and 
cooperate to mass 
media in Japan 

Project news get into the media 
in Japan 

 

 

Outputs 

The project activities and achievements from the beginning of the Project to March 2020 were 

shown in the Table 6. 

 

Table 6 PR and awareness activities and achievements 

Activities Achievements 

1. Offering information by project website/ homepage (English/ Japanese) 
1.1 Open project webpage in JICA homepage 
(English/Japanese) to introduce the Project 
and main project activities 

Project webpage was opened in JICA homepage 
(English/Japanese) in June 2015 and CEPA homepage. 
12 postings as of February 2020. 

1.2 Open project homepage (facebook page) 
to introduce project related information, 
target site and project activities timely 

Facebook page of the Project was opened in October 2015. 
180 postings and 1,494 likes as of May 2018. 

Facebook page was renewed in October 2018. 
More than 212 postings and 1,109 likes as of November 
2020.  

1.3 Publish newsletters to introduce progress 
of project activities and report appeal of target 
site 

Newsletters were published twice a year (9 newsletters) 
and printed for 4,200 copies. 
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2. Producing materials for public relation/ environmental education using project outputs   
2.1 Produce atlas(es) using information 
collected, maps created and satellite imagery 
analyzed in the Project to report appeal of 
target site 

Atlas 2017 was created and printed for 100 copies. 

2.2 Produce environmental educational 
materials to let PNG’s natural environment be 
known  

Various environmental educational materials were created. 
 - Guide Map of Varirata National Park (1st edition and 
2nd edition) (5,500 copies) 
 - Field guide brochures for VNP (1,000 copies) 
 - Biodiversity report book (110 copies) 
 - Mangrove identification guide of Bootless Bay (500 
copies) 
 - Common birds field guide of Bootless Bay (500 
copies) 

2.3 Create brochures to report project 
activities  

Brochures were published (7 for the Project, 1 for Output 
3) and printed for 3,100 copies. 
2 factsheets were published and printed for 800 copies. 

2.4 Create poster, banner, sign board, etc. to 
vitalize seminar and workshop 

Various PR materials were created. 
 - Banner (19 types) 
 - Poster (more than 56 types) 
 - Sign board (24 types: the Project, VNP at main picnic 
area and main lookout, Bird Watching in VNP, Megapod 
explanation in VNP, Bird Watching at PAU, marine PA at 
Tahira UPNG land (2 sites), Motupore Island, Tahira farm, 
and mangrove protection, VNP new entrance fees, and 
Tahira marine station) 
 - Logo (2 types: VNP and BBMCI) 
 - Sticker (4 types: the Project, VNP, project boat and 
BBMCI) (3,062 copies) 
 - Polo shirt (69) 
 - Vest (60) 
 - Video (2 types: Promotional video of VNP, and Short 
highlight video of the Varirata Cultural Tour) 

3. Presenting events (producing event goods) 
3.1 Produce and distribute public relation 
materials in seminars, workshops, events, etc. 
to disseminate the Project and let appealing 
project site and PNG’s natural environment 
be known 

Various PR materials were produced and distributed in 
seminars, workshops, events, etc. 
 - 100 T-shirts for BBMCI (100) were distributed at the 
launching ceremony of the project boat (35 participants). 
 - 100 T-shirts for "Friends of Varirata" were distributed at 
the Inaugural Event for Renovated Facilities in VNP (more 
than 100 participants). 

3.2 Present project outputs to report and 
disseminate the Project 

The Project Team participated in Kokoda Initiative 
workshop and made presentation on the project. 
A presentation was made at the World Oceans Conference 
in UN HQ, New York City. 
25 seminars/workshops, ceremonies and events were held. 
 - Kick-off Seminar/Workshop for the Project (94 
participants) 
 - Inception and Follow-up Workshop for Koiari (73 and 27 
participants) 
 - Workshop on Livelihood Development & Bird Watching 
in Koiari (31 participants) 
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 - VNP Landowner Workshop on Livelihood devlopment 
(25 participants) 
 - Inception, the 2nd and 3rd Workshop for the creation of 
BBMCI (33, 55, and 26 participants) 
 - VNP Wrap-up Workshop on the Project Achievements 
2015-2016 (57 participants) 
- 9 times meeting for BBMCI and BBNMS working group 
(104, 17, 19, 23, 20, 24, 20, 20 and 34 participants) 
 - Seminar for explanation of the results of social mapping 
and socio-economic survey (21 participants) 
 - Biodiversity and Conservation seminar (346 participants) 
 - Launching ceremony of the project boat (25 participants) 
 - Inaugural Launch for the Renovated Facilities in VNP 
(128 participants) 
 - Inagural ceremony for the Information Center Complex 
in VNP (98 participants) 
 - The signing ceremony of MOU between Central 
Provincial Government and CEPA (47 participants) 
 - The event of community awareness on Bootless Bay 
MPA (about 500 participants) 
 - Study Tour to VNP and National Museum of PNG (77 
participants) 
 - Varirata National Park one day tour packages (40 + 131 
participants) 

- The Project accepted two students of Pacific Adventist 
University on internship for 6 weeks. 

3.3 Run a booth at events to report and 
disseminate the Project 

The Project was promoted in the World Wildlife Day event 
at Nature Park. 
Major sponsorship of the World Environment Day event at 
VNP (Over 400 participants), Mirigeta (more than 800 
participants) and at the Adventure Park. 
The Project Team ran a booth at the World Oceans 
Conference in UN HQ, New York City. 
The Project Team launched the CTI Day. 

4. Information supplement to JICA and mass media in Japan 
4.1 Contribute articles to JICA public 
relations magazine to disseminate project 
related information if requested 

Project news was picked up in JICA Natural Environment 
Conservation Knowledge Management Network 
Newsletter "Shizen Kankyo Dayori" vol. 17. 

5. Offer/ cooperation on mass media in PNG 
5.1 Provide information of the Project to 
press release: TV, radio, newspaper, 
magazine, etc. in PNG to disseminate project 
activities information 

Project news got into the newspaper in PNG more than 22 
times. 

6. Approach to Japanese private sector/ corporate in PNG 
6.1 Provide information of the Project to 
press release: Japanese magazine, newspaper 
to introduce project activities, if requested 

Not performed. 

6.2 Approach and cooperate to mass media in 
Japan (ex. NHK nature program) to introduce 
project activities and PNG, if requested 

Not performed. 
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Discussion	and	lessons	learned	

The Project team implemented various activities by using specific tools and medium for creating 

effective public relations and raising awareness. Discussion and lessons learned through the 

respective activities and tools were described in this section. 

 

(1)	Opening	project	website/	homepage	(English/	Japanese)	(Activity	1.1,	1.2)	

The Project utilized JICA homepage (English/ Japanese), CEPA homepage and facebook page 

to introduce the Project and project activities targeting at wide variety of audiences. 

The Project opened project webpage in JICA homepage, both of English and Japanese websites, 

and introduced brief overview of the Project and main project activities. 

As a result of the discussions with CEPA officers, project website was intended to be opened in 

CEPA homepage to introduce project related information, target site and more detailed project 

activities timely targeting at CEPA officers, bodies concerned and general nation. Additionally, 

it was intended for CEPA officers and general nation to download output documents and official 

documents. Project webpage was opened in CEPA homepage. A CEPA officer was appointed to 

be a person responsible for updating information periodically. 

In the beginning, the CEPA website was expected to be updated periodically by CEPA staff to 

introduce the progress of project activities. However, CEPA outsourced the design of their 

homepage at that timing, and they have lacked the authority to edit the site since then because 

the website dataset has not been delivered by the contractor due to CEPA’s payment delay. 

Therefore, the Project team decided to open project facebook page and public project 

information on it, because periodic update of the website in CEPA homepage was impossible. 

A link to project facebook page was provided on the project website at CEPA homepage. On the 

other hand, download site of official documents shall be at CEPA homepage. At present, since 

it is not able to upload the documents at CEPA homepage, the Project team decided to use 

former CEPA homepage, which is still usable, for uploading. 

Project facebook page was opened to periodically introduce the project activities. Not only JICA 

experts but also CEPA officers and local staff were assigned as person in charge of updating 

project facebook page, because JICA short-term experts are not fully presented at PNG. Lots of 

articles with photos were posted on the page to introduce project activities, announce and 

report project related events and deliver documents such as project brochures. 

From the characteristics of facebook, there were the following advantages: 

(i) information can be sent frequently and timely and 

(ii) lots of people access the page friendly and frequently. 

Since many people and bodies are involved in the Project, the page also helped them understand 

the Project, share information, and enhance the motivation of the people involved. In addition, 

the Project was able to grasp the reaction of users through their comments posted on the 
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facebook page. Operation of the page was monitored through a monitoring report created in 

every six months. 

As an issue, the page was created using the account of a CEPA officer at that time, but the page 

could not be updated and continued due to resignation of the officer. Therefore, it was necessary 

to migrate the page. If you use an individual account to create facebook page, problems related 

to update and maintenance of the page may be occurred when involved staff is transferred or 

retired. It is better to request the C/P to offer the account for creating facebook page. 

 

(2)	Publishing	newsletters/	factsheets	(Activity	1.3)	

Project newsletter was published every six months (total of 9 volumes) to post information on 

significant events, progress and achievements of project activities and report appeal of target 

site. It was proper frequency in terms of fulfillment of contents of articles. Basically 500 copies 

were printed for each volume. The articles were compiled using the posts on project facebook 

page for efficient work. The newsletters helped to communicate to stakeholders, partners, 

donors and JICA network. They were also delivered at the events and information center in 

VNP. 

Project factsheet was published annually in the first 2 years to sum up the project activities of 

the year. It is useful to report the project activities only before specific outputs come out. 

Therefore, the use scene was limited, since it may not be so interesting for general public. 

During the last three years of the Project, the contents of the factsheet were included in project 

brochure. 

Newsletter and factsheet were used the same design code, such as colour and font, and template 

set by the Project. 

 

(3)	Creating	brochures	(Activity	2.3)	

Project brochures are information sheets for the Project in relation to the activities undertaken 

as per the respective Outputs. They were created annually (total of 6 versions) to convey 

information of progress, achievements and plan for each Output that summarizes the activities 

from the beginning of the Project to that year. Basically 500 copies were printed for each. These 

were useful tools for getting to know the Project comprehensively. They were distributed not 

only at the events but also when introducing the Project to the visiting missions. 

 

(4)	Producing	atlas	(Activity	2.1)	

Spatial information was developed in GIS database and various GIS maps were created for the 

target sites. In the middle term of the Project, a project atlas was produced by summarizing the 

maps created, satellite imagery analyzed and information collected in the project activities to 

introduce and appeal the environment of the target sites. The atlas includes not only the maps 
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but also explanatory text and photos focusing on priority landscapes, species, environment, 

VNP, Bootless Bay Marine Conservation Initiative (BBMCI), etc. Design work for its cover, 

header and footer was outsourced in order to make the atlas attractive. 100 copies were printed 

to deliver to the bodies concerned. In the future, it is assumed to be used in the VNP information 

center. C/P officers also recognized that the atlas was useful to easily learn what data and maps 

the Project had been created and to be used to introduce the CEPA’s activities. 

The design and layout of the atlas was intended to be reused, so delivery in illustrator format 

was desired, but it was only delivered in PDF format due to budget limitations. If you have a 

budget, it is desirable to create it in illustrator format so that it can be reused in the future. 

 

(5)	Producing	environmental	educational	materials	(Activity	2.2)	

The Project produced environmental educational materials such as field guides and biodiversity 

reports using the results of field surveys conducted in the Project. These were distributed at the 

events such as workshops and seminars or distributed to the visiting missions. These products 

will be sold by CEPA after the end of the Project and will be one of the revenue sources for the 

park management. 

These types of products have high needs from the general public as well as those involved in the 

Project, but there were few things that could be referenced. Disseminating the park’s natural 

environment and attraction promotes people’s interest and knowledge, thereby raising 

awareness of biodiversity conservation. 

In addition, as part of each Output activity, the Project has produced various materials for 

public relations and environmental education, such as signboards that introduce VNP, species, 

conservation efforts, enlightenment, and caution, logo design of VNP and BBMCI, VNP stamps, 

VNP guide map, promotion video for VNP. These designs were basically done by the Project, 

but some designs such as logos were done by external designers. Since PNG Tourism Promotion 

Authority (TPA) had a similar concept, the promotion video for VNP was created in 

collaboration with them. 

In the future, CEPA may collaborate with Department of Education and PNG TPA to create and 

use environmental educational materials. 

 

(6)	Creating	various	tools	for	awareness	(Activity	2.4)	

The Project created banners, flag banner, sign board, map posters to vitalize seminars and 

workshops. These tools can be used many times, so you have more opportunities to use them if 

you create them early in the Project. Map posters were very useful as a tool for raising interest 

and discussion among participants. These tools are essential because they enliven the meeting 

atmosphere. 
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(7)	Producing	various	PR	materials/	goods	(Activity	3.1)	

The Project produced various PR materials and goods such as T-shirt, polo shirt, vest and 

stickers for distribution at seminars, workshops and events. The tools above (2) to (6) were also 

used in the events. These tools raise awareness of the people involved and let appealing project 

site and PNG’s natural environment be known. Good items are used (and worn) even after the 

event, which is effective in implementation of raising awareness activity of the Project. 

 

(8)	Presenting	project	outputs	(Activity	3.2)	

The Project team members presented at the workshop and conference organized by other 

organizations to disseminate the Project and report project outputs. It was helpful to make 

progress of the project activities clear to stakeholders and encourage their involvement in the 

implementation.  

 

(9)	Run	a	booth	(Activity	3.3)	

The Project runs a booth at the events using the tools above (2) to (6) to report and disseminate 

the Project’s achievements. It was helpful to draw attention of local community and general 

nation to the Project implementation, particularly in activities for natural environmental 

conservation. 

 

(10)	Holding	seminars/	workshops	

Project seminars/ workshops, Kick off Seminar, Mid-term Review Seminar, and Closing/Wrap-

up Seminar, were conducted for better public relations/ awareness. These were planed and 

implemented in response to comments of stakeholders. Workshops and meetings were also 

held on specific themes such as Koiari, livelihood development, VNP facility, BBMCI. 

Process of being prepared for the events and coordination with the concerned parties was 

carried out carefully and took time. As a result, effective discussion with those people involved 

in the Project was obtained, pressing forward and promoting the project implementation. 

 

(11)	Information	supplement	to	JICA	and	mass	media	in	Japan	(Activity	4)	

The Project team member contributed articles to JICA public relations magazine, “JICA Natural 

Environment Conservation Knowledge Management Network News”, to disseminate the 

Project’s activities and outputs to Japanese national. 

 

(12)	Offer/	cooperation	on	mass	media	in	PNG	(Activity	5)	

Information collected from the events conducted by the Project was used for making press 

release in PNG to disseminate project activities. The events were often featured in newspaper 
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and TV. It was useful not only for raising awareness of the general public but also for drawing 

attention of and increasing motivation of stakeholders. 

 

(13)	Approach	to	Japanese	private	sector/	corporate	in	PNG	(Activity	6)	

Initially, approaching to Japanese private sector/ corporate in PNG was also considered in 

dealing with the possibility of cooperation with corporate CSR activities. If requested, it was 

also in mind to introduce PNG and project activities to Japanese magazines and mass media. 

However, there was actually no such opportunity, so this activity was not implemented. 
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